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2 Chapter 1 – Welcome

Welcome to the Spire CX260 User Guide
Welcome to your Creo® Color Server (Spire CX260) for the Xerox® DocuColor 242/
252/260 printer-copier User Guide.

The Spire CX260 is a powerful, comprehensive color server that provides high 
throughput and print predictability to digital workflows. In combination with the 
Xerox DocuColor 242/252/260 printer/copier, the Spire CX260 effectively 
addresses the growth of on-demand printing needs and delivers the best output 
quality available.

Throughout this guide, we look forward to supporting you all the way from prepress 
to print.

This user guide will help you operate the Spire CX260. It can also be used as a 
reference guide for questions or procedures. Study this user guide to take full 
advantage of the many unique and advanced features of the Spire CX260.

This user guide is for Spire CX260 operators and system administrators. This guide 
explains how you can quickly and easily print from the Spire CX260 or from a client 
workstation. Step-by-step procedures are included for new and occasional Spire 
CX260 users. Detailed information is provided for users who require in-depth 
knowledge of the Spire CX260.

Terminology
The Spire CX260 is available in four configurations:

Table 1: Terminology

Configuration Description

Spire CX260 (“Basic 
configuration”)

Spire CX260 mounted on the Xerox DocuColor 242/252/260 printer/
copier

Spire CX260 with Control 
Station Upgrade Kit (“Control 
Station configuration”)

Upgrade kit that includes the Spire CX260 mounted on a stand, 
monitor, keyboard, mouse, and DVD-ROM. A dongle is required for this 
configuration.

Note: The Spire CX260 is a prerequisite for this configuration.

Spire CX260 with Professional 
Upgrade Kit (“Pro Basic 
configuration”)

Upgrade kit that includes the GretagMacbeth® Eye-One® 
spectrophotometer and advanced software features. A dongle is 
required for this configuration.

Note: The Spire CX260 is a prerequisite for this configuration.

Spire CX260 with Professional 
Control Station Upgrade Kit 
(“Pro Control Station 
configuration”)

Upgrade kit that includes the Spire CX260 mounted on a stand, 
monitor, keyboard, mouse, DVD-ROM, Eye-One spectrophotometer 
and advanced software features. A dongle is required for this 
configuration.

Note: The Spire CX260 and Control Station upgrade kit are prerequisites 
for this configuration.
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Overview of Guide
Table 2: Guide Overview

Chapter Contents Description

Chapter 1 Welcome This chapter introduces the guide and the Spire 
CX260 features and workflows.

Chapter 2 Getting Started This chapter introduces the basic workflows for users 
of all Spire CX260 configurations, including defining 
the Xerox DocuColor 242/252/260 printer/copier on 
a client workstation, working remotely using the EZ 
Connect, Remote Workspace and Spire Web Services 
tools, off-the-glass calibration, and scanning.

Chapter 3 Overview of Spire CX260 This chapter provides explanations about the Spire 
CX260 workspace and main windows.

Chapter 4 Tools and Utilities This chapter explains how to preview jobs, perform 
preflight checks, manage fonts and virtual printers, 
and use the Tray Alignment and Spire Tabs Plug-in for 
Acrobat tools.

Chapter 5 Generating Reports This chapter explains how to generate reports from 
the Spire CX260 and the Xerox DocuColor 242/252/
260 printer/copier.

Chapter 6 Color Workflow This chapter explains how to work with color in the 
Spire CX260, and includes calibration and RGB and 
CMYK workflows. It also explains how to adjust 
colors, and to use color tools and post-RIP controls.

Chapter 7 System Administration This chapter explains how to administrate your 
system using the Administration window utilities.

Chapter 8 Setting Parameters This chapter describes how to set basic parameters in 
the Job Parameters window. It also describes the PPD 
file parameters.

Chapter 9 Reinstalling the Spire 
CX260

This chapter describes the software backup and 
restore, reinstalling the system, installing and 
configuring Novell Client™, and formatting the image 
disk.
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Introduction to the Spire CX260
The Spire CX260 is an on-demand prepress system that uses advanced Creo color 
server prepress technologies to drive a Xerox DocuColor 242/252/260 printer/
copier. 

As an optimal digital color solution for printers, the Spire CX260 enables you to 
print from Windows, Macintosh, and UNIX® client workstations. The Spire CX260 
processes image files in page-description language (PDL) formats—for example, 
PostScript, PDF, and Variable Information—using RIP (Raster Image Processor) 
technology. The system converts image files into a suitable RTP (ready-to-print) 
format for direct, high-quality digital printing. The Spire CX260 also streamlines the 
printing process by allowing printing with preset workflows.

In combination with the Xerox DocuColor 242/252/260 printer/copier, the Spire 
CX260 enables you to efficiently print flyers, brochures, pamphlets, dummy 
catalogs, short-run trials, and print-on-demand publications. When installed as a 
fast, network printer with the Spire CX260, the Xerox DocuColor 242/252/260 
printer/copier prints up to 50 color or monochrome pages per minute.

The Spire CX260 combines RIP functionalities, automation, control tools and 
special hardware development capabilities with PC architecture.

Figure 1: Spire CX260 for the Xerox DocuColor 242/252/260 printer/copier—Spire 
CX260 with Pro Control Station configuration

Note:  The image above shows the Pro Control Station configuration. In the 
Control Station and Pro Control Station configurations, the Spire CX260 is 
mounted on the back of the stand.
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Hardware and Software Components
The Spire CX260 is a dedicated Creo platform running in a Windows environment. 

The Spire CX260 includes:

• Creo hardware, including the interface board

• Software, including:

Spire CX260 application software

Windows XP Professional

Adobe® Acrobat® version 7.0

Supported Formats
The Spire CX260 supports the following file formats:

• PostScript® (composite or pre-separated files)

• PDF

• EPS

• Creo VPS (Variable Print Specification)

• VIPP (Variable Data Intelligent PostScript Params)

• PPML (Personalized Print Markup Language)

• Creo CT & LW (these file formats are only supported if you have the Pro 
configuration)

• JPG, TIFF

• GAP (Graphic Art Port) files (file formats from various prepress systems, for 
example Brisque job and TIFF / IT) (this file format is only supported if you have 
the Pro configuration)

• Pre-separated formats (this file format is only supported if you have the Pro 
configuration)

Workflow
The Spire CX260 receives and processes files from the following client 
workstations: 

• Macintosh – running Mac® OS 9.x or later and Mac OS X (10.4 and later)

• Windows – running 2000, 2000 Pro, XP and 2003

• UNIX workstations and servers
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The basic workflow for the Spire CX260 is as follows:

Spire CX260 Network Printers
For Macintosh and Windows networks, the Spire CX260 provides three default 
network printers, also known as virtual printers.

Virtual printers are used for automating workflows, which then define job streaming. 
They contain preset workflows that are automatically applied to all print jobs 
processed with that virtual printer. There is no need to reset job settings for each job, 
thus increasing printing efficiency.

Note:  The job (print) parameters set in the job (from the client) override the 
parameters set in the virtual printer. 
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The three default virtual printers are:

• SpoolStore
Files are spooled directly to the Storage window and await operator processing. 
You can only import PDL files (such as: PS, PDF, VIPP, VPS) to the spool store, 
not RIPped - RTP files. 

• ProcessPrint
Files are processed and printed directly to the Xerox DocuColor 242/252/260 
printer/copier via the Spire CX260.

• ProcessStore
Files are automatically processed and stored in RTP format. After processing, 
the files are stored in the Storage window of the Spire CX260 until the operator 
re-submits them for printing.

With printing workflows tailored to your job requirements, the Spire CX260 enables 
you to: 

• Define new virtual printers

• Choose from which virtual printer to print

For information on defining and editing virtual printers, see Managing Virtual Printers 
on page 93.
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Overview
This chapter describes the main production workflows and procedures for the Spire 
CX260.

Turning the Spire CX260 On and Off

Basic and Basic Pro Configurations

To turn on the Spire CX260:

Do one of the following actions:

Turn on the Xerox DocuColor 242/252/260 printer/copier.

The Spire CX260 turns on automatically when the Xerox DocuColor 242/
252/260 printer/copier is turned on.

Push the green On/Off button on the front of the Spire CX260.

To turn off the Spire CX260:

1. Close the Spire CX260 software. From the Job menu, select Exit.

The Spire CX260 software closes, and you return to the Windows desktop.

2. Verify that the Spire icon has disappeared from the taskbar.

3. Do one of the following actions:

Turn off the Xerox DocuColor 242/252/260 printer/copier.

The Spire CX260 automatically turns off when the Xerox DocuColor 242/
252/260 printer/copier is turned off.

Push the green On/Off button on the front of the Spire CX260.

Note:  The Spire CX260 can be turned on when the Xerox DocuColor 242/
252/260 printer/copier is turned off. In this state, the server runs until 
turned off manually by the user. If the server is running and the printer is 
then turned on, the server continues running and is not affected by this 
action.

Note:  If there are jobs that are being processed or printed, a message is 
displayed.

Taskbar with Spire icon Taskbar without Spire icon
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Control Station and Pro Control Station Configurations

To turn on the Spire CX260:

1. Turn on the monitor.

2. Push the green On/Off button on the back of the Spire CX260.

The power indicator on the front panel lights up. The Windows operating 
system starts, and the Spire CX260 splash screen appears.  

If you are turning on the Spire CX260 after a reboot, a test page is automatically 
printed. By default, this test page is printed each time the Spire CX260 is restarted. 

For more information about changing settings for the test page, see General Defaults 
on page 169.

The test page displays details about the Spire CX260, the Xerox DocuColor 242/
252/260 printer/copier, and the network setup.

To turn off the Spire CX260:

1. Close the Spire CX260 software. From the Job menu, select Exit.

The Spire CX260 software closes, and you return to the Windows desktop.

2. Verify that the Spire icon has disappeared from the taskbar.

3. Select Start > Shut Down > Shut down.

Note:  The Spire CX260 can be turned on when the Xerox DocuColor 242/
252/260 printer/copier is turned off. In this state, the server runs until 
turned off manually by the user. If the server is running and the printer is 
then turned on, the server continues running and is not affected by this 
action.

Notes:

• If the Spire CX260 is already turned on, open the workspace from the 
Start menu.

• By default, the Auto Log On check box is selected in the Settings 
window. This option enables you to open the workspace without 
having to go through the logon process each time. If you want to 
designate different access levels for each user, you need to set 
security settings in the Settings window. For more information about 
designating access levels, see Security on page 161.

Note:  If there are jobs that are being processed or printed, a message is 
displayed.

Taskbar with Spire icon Taskbar without Spire icon

Note:  The Spire CX260 can be turned on when the Xerox DocuColor 242/
252/260 printer/copier is turned off. In this state, the server runs until 
turned off manually by the user. If the server is running and the printer is 
then turned on, the server continues running and is not affected by this 
action.
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Working from a PC Client Workstation

Defining the Printer on the Client Workstation

To define a network printer in Windows XP:

1. From the Start menu, select Run.

2. In the Open box, type \\, followed by the host name or IP Address of the color 
server, and click OK.

The server window opens.

3. Double-click the desired network printer icon.

The network printer is defined on your Windows client workstation.

Printing from the Client Workstation
To print a job from a client workstation, print the job to one of the Spire CX260 
network published printers—for example, ProcessPrint.

The job is spooled and then processed and printed (according to the selected job 
flow of the published printer). If you use this method, you can print from any 
application —for example, Microsoft Word— and use any file format from any client 
workstation (Windows, Macintosh, or UNIX).

Note:  Jobs that are spooled to the Spire CX260 must have the appropriate file 
name extensions—for example, *.ps or *.pdf.
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The Spire CX260 can receive print jobs from client workstations with one of the 
following Windows operating systems:

• Windows 2000

• Windows XP

• Windows 2003

To print a file:

1. Open the file you would like to print in the corresponding application—for 
example, open a PDF file in Adobe Acrobat.

2. From the File menu, select Print. 

The Print dialog box appears.

3. From the Name list, select the desired Spire CX260 network printer—for 
example, <servername>_ProcessPrint.

4. If desired, click Properties and modify the job parameters using the Spire Print 
Driver software.

For more information about the Spire Print Driver software, see Spire Print Driver 
Software on page 13.

5. Click OK.

6. Click OK in the Print dialog box.

The file is sent to the Spire CX260. 

Spire Print Driver Software

About the Print Driver Software
The Spire CX260 Print Driver software enables you to set job parameters for jobs 
that you send to the Xerox DocuColor 242/252/260 printer/copier from any 
application on your PC client workstation. 

Note:  Printer's Default indicates that the value is taken from the settings 
of the selected published printer on the Spire CX260.
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The Print Driver software also enables you to see the Xerox DocuColor 
242/252/260 printer/copier configuration, monitor’s the printer status, 
and save a set of print parameters for reuse.

Using the Print Driver Software
1. Open the file that you want to print—for example, a PDF file.

2. From the File menu, select Print.

3. In the Print dialog box, click Properties.

If this is the first time that you are using the Print Driver software, a 
message tells you that the software is loading. Then a dialog box 
appears with the print parameters.

Note:  The job parameters available in the Print Driver software are the same 
as the job parameters on your Spire CX260.

Note:  The loading process might take a few minutes. Afterwards, 
accessing the Print Driver software takes less time.
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In the Print Driver software window, you can perform the following actions:

• Define job parameters

• Change parameters

• Lock a job

• Save a set of parameters

• Load a saved set of parameters

• Check the status of the Xerox DocuColor 242/252/260 printer/copier

• Define PostScript parameters for the job

Setting Job Parameters in the Print Driver
1. Under Spire Settings, click the tab on which you want to change parameters:

• Print Settings

• Paper Stock

• Print Quality

• Color

• Services

• Finishing

For more information on setting the job parameters, see Setting Parameters in the 
Job Parameters Window on page 182.

2. Click OK.

Locking a Job

The Print Driver software enables you to lock a job. When the locked job is sent to 
one of the queues, a Locked indicator  appears next to the job. If you want to 
access the job parameters or send the job to print, you will be prompted to enter the 
password for the job. For more information about unlocking a job in a queue, see 
Unlocking a Job on page 59.

Notes:

• Some of the job parameters in the Print Driver software appear in a 
different place from the Spire CX260.

• The Copies parameter value (located at the top of the Print Driver 
software window) reflects the number of copies that you selected in the 
Print dialog box of the software that you are currently working in.

Note:  This feature is only available for the Pro Basic and Pro Control Station 
configurations.
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To lock a job:

1. In the Print Driver software window, click the Lock  button.

The Secure Printing dialog box appears.

2. In the Password box, type a password consisting of four digits.

3. Click OK.

The job is locked.
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Using Parameter Sets
Once you have chosen the parameters for a job, you can save this set of parameters 
for future use. Sets are useful when you want to print different jobs with the same 
parameters, or if you want to reprint a job.

To create a set:

1. Select all of the desired parameters for the job, and click Save Set.

2. Locate the folder in which you want to save the set.

3. In the File name box, type the desired file name for the set.

4. Click Save.

The parameters are saved as a set.

To retrieve a set:

1. Under Spire Settings, click Load Set.

2. Locate and select the desired set, and click Open.

The set of parameters are applied to the job. 

Tip:  You can modify any of the parameters as desired.
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To view the printer’s status:

1. Click the Printer tab.

2. Click the Paper Stock tab to view information on the paper stock in the trays.
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3. Click the Finisher tab to view information on the finishing options.

 

4. Click the Consumables tab to view information on consumables such as bottles 
and fuser oil.
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5. Click Update if you want the software to dynamically update the information 
that it displays.

To select PostScript settings:

1. Click the PostScript tab and adjust the settings as desired.

2. Click OK to save the settings.

Working Offline
The printer is offline under the following circumstances:

• Your workstation is not connected to the Spire CX260.

• The Xerox DocuColor 242/252/260 printer/copier and the Spire CX260 are not 
communicating.

• You are working in a non-TCP/IP environment such as a Novell environment.

• The selected virtual printer is not currently published on the Spire CX260.

When the Xerox DocuColor 242/252/260 printer/copier is offline, you can select 
and save parameters in the Print Driver software for the selected virtual printer. 
However, you cannot update the display of information about the printer 
resources—for example, paper or toner.

Notes:

• When you access the Print Driver software, the resource 
information is only refreshed after you click Update.

• Clicking Update updates the gradation tables.



Working from a Macintosh Client Workstation 21

Deactivating the Print Driver Software

To deactivate the Print Driver software:

1. On the desktop, select Start > Settings > Printers and Faxes.

2. Right-click the printer icon, and select Properties.

3. Click the Print Driver tab.

4. In the Enable enhanced user interface list, select off.

5. Click Apply.

6. Click OK to close the dialog box.

Uninstalling the Print Driver Software
1. On the desktop, select Start > Settings > Printers and Faxes.

2. Right-click the Spire CX260 network printer, and select Delete.

The printer is deleted from your client workstation.

Working from a Macintosh Client Workstation

Defining a Printer on Macintosh Client Workstations
You can submit jobs using the Spire CX260 published printers over a TCP/IP 
protocol. This connection enables a significantly higher spooling speed.

The Spire CX260 can receive print jobs from client workstations running Mac OS 9 
and Mac OS X. As an example, the following section describes how to define a Spire 
CX260 network printer for a client workstation with a Mac OS X operating system.
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Copying the Spire CX260 PPD File for Mac OS X
To print from your Macintosh computer to the Xerox DocuColor 242/252/260 
printer/copier, you first need to manually copy the Spire CX260 PPD file to the 
Macintosh. 

To copy the PPD file:

1. From the Go menu, select Connect to Server.

The Connect to Server dialog box appears.

2. Locate the desired Spire CX260 in the network and then double-click it.

3. In the Connect to Server dialog box, select Guest. 

4. Click Connect.

5. Select the Utilities volume, and click OK.

6. On the desktop, double-click the Utilities volume icon.

7. Double-click the PPD folder. 

8. Double-click the desired language folder.

9. Double-click the desired computer type folder:

• If you are using Mac OS 9, select MAC

• If you are using Mac OS X 10.4 or later, select MacOSX

10. Double-click the desired location folder—for example, US-Letter.

11. Locate the CX260_V2.PPD file. It is recommended that you copy the PPD file 
by dragging it to the specified folder in your local disk. To do this, open another 
Finder window.

12. From the Go menu, select Computer.

13. Click your disk icon, and locate the required folder—for example, 
Library\Printers\PPDs\Contents\Resources.

14. Select the desired language folder—for example, en.lproj for English.

15. Drag the CX260_V2.PPD file to the language folder.

Setting the Network Printer for Mac OS X (10.4 or Later)—IP, SMB, 
or Appletalk

1. Make sure that the Spire CX260 PPD file has been copied to the correct folder 
on your client workstation.

For more information about copying the PPD file, see Copying the Spire CX260 
PPD File for Mac OS X on page 22.

2. From the Go menu, select Applications.

3. Open the Utilities folder and then double-click Printer Setup Utility.

4. Click Add Printer button.

5. Select either Default Browser or IP Printer.

Note:  Some of the steps in this procedure may be different if you are using a 
version older than Mac OS X 10.4.
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6. Browse to the Spire CX260 network printer (if you are defining an IP printer, 
enter the Spire CX260 IP address or host name, and the exact name of the 
printer to which you want to print—for example, CX260_ProcessPrint.

7. In the Printer Using list, select Other.

8. Browse to the folder to which you copied the CX260_V2.PPD file and select it.

9. Click Open to assign the CX260_V2.PPD file to the selected network printer.

10. Click Add to add the new printer to the printer list.

You have successfully installed a network printer for the Spire CX260 and are 
ready to start printing.

Printing from a Macintosh Client Workstation
1. Open the file you would like to print in the corresponding application—for 

example, open a Quark file.

2. From the File menu, select Print.

3. From the Printer list, select the desired printer.

4. In the Copies & Pages list, select Printer Features.
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5. Adjust the printer options as desired.

6. After modifying the job settings, click Print.

The file is sent to the Spire CX260. 

Working Remotely

EZ Connect
The EZ Connect application enables you to view information about any Spire color 
server on your network.

You can:

• View the printer status—for example, the status of the connection, tray, cable, 
and power

• Refresh the printer status

• Search for jobs

• Access the Remote Workspace or Web Center

For more information about accessing the Remote Workspace, see Remote 
Workspace on page 29. For more information about the Web Center, see Web 
Center on page 91.

Notes:

• The PPD parameters are divided into Sets in the Feature Sets list.

• The Printer's Default option indicates that the value is taken from the 
published printer that is currently selected.

Note:  You can only access the Remote Workspace or search for jobs on a Spire 
color server that supports these features.
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Installing EZ Connect

To install EZ Connect on your client workstation:

1. In the D:Utilites/PC Utilities folder on the Spire CX260, locate the 
EZConnect_v1_0_Setup.exe file and copy it to your client workstation.

2. On your client workstation, double-click the EZConnect_v1_0_Setup.exe file.

After installation is complete, the EZ Connect application appears under Start > 
Programs > EZConnect > EZConnect Runner.

Using EZ Connect

To launch EZ Connect:

1. Go to Start > Programs > EZConnect.

2. Select EZConnect Runner.

The EZ Connect icon appears on the taskbar.

3. Double-click the EZ Connect icon on the taskbar.

The EZ Connect window appears.

Tip:  The EZ Connect window can remain on your desktop while you are 
working in other software applications. If you close the EZ Connect 
window, the EZ Connect icon will remain on the taskbar.
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To add a new server to the EZ Connect window:

1. In the EZ Connect window, click the Settings button , and select Setup from 
the list.

The EZ Connect Setup window appears.

2. Click New.

The Add New Server window appears.

3. In the Hostname/IP box, type the server’s name or IP address.

4. In the Display Name box, type the server name that you want to appear in the 
EZ Connect window.

5. In the Type list, select the Spire color server type.

6. Click Connect.

The new server is displayed in the EZ Connect window.
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7. Select the new server that you just added.

8. Click the Move Up or Move Down buttons to change the position of the server 
in the list, if desired.

9. From the Default Launch Application list, select the desired application 
(Remote Workspace or Web Viewer) that you will use to access the server.

10. From the Language list, select the desired language.

11. Select the Error Status Notification Sign check box to display a sign for errors.

12. Click Save.

The server appears in the EZ Connect window.

To change a server’s display name:

1. In the EZ Connect window, click the Settings button , and select Setup from 
the list.

2. In the list of servers, select the desired server.

3. Click Edit.

The Edit Server window appears.

Note:  The Remote Workspace application is only available for Spire color 
servers that support this feature.
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4. In the Display Name box, type the new display name for the server.

5. Click Save.

The new name appears in the EZ Connect Setup window.

To delete a server:

1. In the EZ Connect window, click the Settings button , and select Setup from 
the list.

2. In the list of servers, select the desired server.

3. Click Delete.

The server is removed from the list.

To refresh the status of the EZ Connect window:

In the EZ Connect window, click the Refresh button .

To search for a job on a server:

1. In the EZ Connect window, click the Search button .

The Search Job window appears.

2. From the server list, select one of the following to search for the job:

• All Servers

• A specific server

3. In the blank white box, type the exact name of the job and then click Search.

The job appears in the Search Job window.
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4. Select the job to display information about the job.

The job information appears.

Remote Workspace

Using the Remote Workspace
The Remote Workspace application enables you to access any Spire color server 
from a client workstation over the network. Multiple client workstations can access 
a Spire color server at the same time using the Remote Workspace.

In the Remote Workspace window, you can:

• Import jobs

• View and manage job queues 

• View printer information

• Set job parameters

• Perform tray alignment

• Perform Off-the-glass calibration

• Perform calibration using the Eye-One spectrophotometer connected to your 
client workstation

Notes:

• To use the Remote Workspace application, you must first install the EZ 
Connect tool. For more information, see EZ Connect on page 24.

• The Remote Workspace application is only available for Spire color servers 
that support this feature.

Note:  Calibration using the Eye-One spectrophotometer is only available 
for the Pro Basic and Pro Control Station configurations.



30 Chapter 2 – Getting Started

To launch the Remote Workspace:

1. Launch the EZ Connect window.

For more information, see Using EZ Connect on page 25.

2. Click the desired server.

The first time that you access the Remote Workspace application, the 
Downloading RWS dialog box appears.

3. Click OK.

The following window appears.

The Logon dialog box appears.

Note:  If you have already downloaded the Remote Workspace 
application, proceed to step 4.
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4. Click Logon.

The Remote Workspace window appears.

Spire Web Services
From the Xerox DocuColor 242/252/260 printer/copier’s touch screen, you can use 
Spire Web Services to view jobs in the Spire CX260 Print and Process queues, view 
the calibration status of the printer, and perform Off-the-glass calibration.

Note:  You can also calibrate the Xerox DocuColor 242/252/260 printer/
copier using your client workstation via the Remote Desktop Connection or 
directly on the Spire CX260.

The type of calibration you can perform depends on the Spire CX260 
configuration that you have.

For more information about calibration, see Calibration on page 122.
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To access Spire Web Services:

1. On the printer’s touch screen, touch All Services.

2. Touch Web Applications.
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The Spire Web Services window appears.

To view jobs in the Print and Process queues:

1. From the Spire Web Services window, touch Job List.

The Job List window appears.

2. Do one of the following:

• Touch Process Queue to view jobs in the Spire CX260 Process queue.

• Touch Print Queue to view jobs in the Spire CX260 Print queue.

3. Touch Home to return to the Spire Web Services window.
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To view the calibration status of the printer:

1. From the Spire Web Services window, touch Calibration Status.

The Calibration Status window appears and displays the following information:

• Date and time of the last calibration

• If the calibration was completed successfully or failed

2. Do one of the following:

• Touch Home to return to the Spire Web Services window

• Touch New Calibration to perform a new calibration
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Performing a New Calibration

To print the Off-the-glass calibration chart:

1. Do one of the following:

• From the Spire Web Services window, touch New Calibration.

• From the Calibration Status window, touch New Calibration.

The Print Calibration Chart window appears.

2. Touch the button next to the desired tray and then touch Continue.
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The following window appears.

3. In the Screening Method list, touch the arrow and select the screening method.

4. In the Gloss Enhanced list, touch the arrow and select Yes or No.

5. In the No. of copies list, touch the arrow and select the number of copies that 
you want to print.

6. Touch Print.

The Prepare for Scan window appears.

7. Touch Home to return to the Spire Web Services window.
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To calibrate the scanner and printer:

1. On the platen glass of the printer, place the KODAK Gray Scale calibration chart 
and the Off-the-glass calibration chart next to each other, facing down.

2. On the printer’s touch screen, touch All Services.

3. Touch Network Scanning.

4. On the General Settings tab, touch the 001 Calibration scan box.

5. Touch the Image Quality tab.

6. Touch the Standard Color Space button to select the specific color space of the 
Xerox DocuColor 242/252/260 printer/copier.

7. Touch the Device Color Space button.

8. Touch Save.

9. On the control panel, push Start to start scanning the charts.

The charts are scanned and measured and a calibration table is created.

If the calibration process is successful, two calibration tables are generated: 

• Normal—maintains the gray balance throughout the range of colors in the print 
job file

• Saturated—is the same as the normal table for 80% of the color range; but from 
that point on, each color has a greater density

Remote Scan Application
Before you begin using the remote scan application, make sure that remote scanning 
is enabled in the Spire CX260 Settings window. For more information, see Scan on 
page 175.

Notes:

• The KODAK Gray Scale calibration chart is in the Calibration Chart Kit 
envelope (part #518-00961A). Use only the KODAK Gray Scale 
calibration chart when calibrating the scanner and printer—do not use 
the Scanner Calibration chart, which is also in this envelope.

• If you place only the Gray Scale calibration chart on the platen glass, 
the printer is calibrated. If you place only the Off-the-glass chart on 
the platen glass, the scanner is calibrated. It is recommended that you 
place both the Off-the-glass and Gray Scale calibration charts on the 
platen glass at the same time so that you calibrate both the printer 
and scanner.

• If you need to calibrate a large paper size—for example, A3 or larger—
cut the paper in order to fit the Off-the-glass and Gray Scale 
calibration charts on the platen glass.
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Installing the Remote Scan Application on Your Client 
Workstation.

To install on a PC client workstation:

1. From the Start menu, select Run.

2. In the Open box, type \\, followed by the host name or IP Address of the color 
server, and click OK.

3. On the Spire CX260, locate the D:\Utilities\PC Utilities folder.

4. Select and copy the RemoteScan.exe file to your desktop.

5. Double-click the RemoteScan.exe file to install the Remote Scan application.

To install on a Mac client workstation:

1. From the Go menu, select Connect to Server.

The Connect to Server dialog box appears.

2. Locate the desired Spire CX260 in the network and then double-click it.

3. In the Connect to Server dialog box, select Guest. 

4. Click Connect.

5. Select the Utilities volume, and click OK.

6. On the desktop, double-click the Utilities volume icon.

7. Open the Mac Utilities folder, and copy the RemoteScanInstaller.pkg.zip to 
your desktop.

8. Double-click the RemoteScanInstaller.pkg.zip file to extract the package

9. Double-click the RemoteScanInstaller.pkg file to install the Remote Scan 
application.
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Using the Remote Scan Application

To open the remote scan application and connect to the Spire CX260:

1. On your client workstation, select Start > Programs > Creo > Remote Scan 
Application > Remote Scan.

The Remote Scan Application window appears.

2. When you connect the first time, or to connect to a different Spire CX260, 
enter the server hostname or IP address in the Server Name or IP list, and click 
Connect.

The remote scan application is connected to the Spire CX260 and you are ready 
to begin working. By default, the last scan box you used is displayed.

The remote scan application enables you to:

• Create scan boxes either locally or from your client workstation, and then set 
parameters that specify the location of your scanned data, the format in which it 
is saved, and security settings

• Manage scanned images

The Spire CX260 has three default scan boxes:

• SpireBW200_1S—Jobs scanned to this box have the following settings: 
OutputColor=Black and white, ScanResolution=200dpi, 2SidedOriginal=1 side

• SpireGrayScale200_1S—Jobs scanned to this box have the following settings: 
OutputColor=Greyscale, ScanResolution=200dpi, 2SidedOriginal=1 side

• SpireColor200_1S—Jobs scanned to this box have the following settings: 
OutputColor=Color, ScanResolution=200dpi, 2SidedOriginal=1 side

If you scan a job using one of the default scan boxes, the job is saved to the scan box, 
and to D:\PublicScans on the Spire CX260.

Creating Scan Boxes
1. In the remote scan application, click ScanBox Manager.

Note:  By default, the Remote Scan application remembers your last 
connection.

Note:  There is a fourth default scan box for calibration.

Note:  The remote scan application must be connected to the server.
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The ScanBox Manager lists all the scan boxes that have been created. 

2. Click Add to add a new ScanBox.

3. In the Scan Box Name box, type a name for the scan box.

4. Select the Automatic Copy check box to automatically save a copy of the 
scanned job on your client PC.
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5. Do one of the following actions:

• In the Network Path box, enter the location to which you want to save the 
extra copy.

• Click Browse.

• Select the desired folder.

• Click Select.

6. In the File Type box, enter the format in which you want to save the data that is 
saved to the scan box. The available options are JPEG, TIFF and PDF.

7. Select Security.

8. Select the Secure Scan Box check box to secure the scan box, and specify a 
password.

9. Click Apply.

10. Select Send to EMail.

Note:  The network browser that opens is local to the Spire CX260.
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11. Click the Send to EMail check box to forward scanned jobs to an e-mail 
address.

12. In the From box, type the e-mail address for the sender of the scanned image.

13. In the To box, type the e-mail addresses to which the scanned e-mail 
attachment should be sent.

14. In the Subject box, type the text for the subject line of the e-mail.

15. In the Text box, type any desired message text.

16. Select one of the following:

• Send scan as link to send an e-mail message containing a link to the 
scanned image. The e-mail message contains text instructing the recipient 
how to access the scanned image, and the date in which the link expires.

• Send scan as attachment to attach the scanned image to the e-mail 
message.

17. Select Scan Parameters.

Note:  The expiration date of the link is set in Settings > Preferences 
> Scan Delete Scan jobs after.
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18. Select the desired output color from the OutputColor list.

19. Select the desired scan resolution from the ScanResolution list.

20. Select the desired print method in the 2SidedOriginal list.

21. Click Save.

The scan box is saved and appears in the ScanBox Manager.

Scanning Workflow
1. Position the original to be scanned on the Xerox DocuColor 242/252/260 

printer/copier.

2. On the Xerox DocuColor 242/252/260 printer/copier touch screen, touch the 
All Services button.

3. Touch Network Scanning.

Note:  The output color cannot be changed during scanning.
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The Network Scanning window appears.

4. Touch Refresh to display all current scan boxes.

5. On the General Settings tab, touch the name of the scan box that you want to 
save the scan to.

6. The Scanning Color and 2 Sided Originals settings are selected according to 
the scan box settings. 

7. In the General Settings, Image Quality, Layout Adjustment and Output Format 
tabs, change the settings as desired.

Note:  The Scanning Color settings cannot be changed.
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8. Press the Start button.

The original is scanned. A beep is heard when the scan is complete. The scan is 
saved in the selected scan box with the name <scan box name>001 and with 
the relevant file extension.

Managing Scanned Images
Once a scan is performed, you can view the job using the remote scan application, 
or browse to D:\PublicScans on the Spire CX260.

To view the scanned job from the scan box:

1. Open the Remote Scan application and ensure it is connected.

2. In the ScanBox list, select the scan box where the scanned job is saved.

All jobs scanned to the selected scan box are displayed.

To save the scanned job on your client workstation:

1. Open the remote scan application and ensure it is connected.

2. In the ScanBox list, select the scan box where the scanned job is saved.
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3. Select the desired job, and click Save as.

The Save dialog box opens.

4. Select a destination and click Save.

You can now open the scanned job on your client workstation, and work with 
your scanned data.

To delete a scanned job from a scan box:

1. Open the remote scan application and ensure it is connected.

2. In the ScanBox list, select the scan box where the scanned job is saved.

3. Select the desired job, and click Delete.

The scanned job is deleted.

Preparing PostScript Files Offline for the Spire CX260
Perform this procedure if your client workstation is not on the same network as the 
Xerox DocuColor 242/252/260 printer/copier, and you or your customer want to 
create PostScript files using the Adobe PostScript Driver with the Spire CX260 PPD 
file.

To copy the Adobe PostScript Driver:

1. Insert CD #3 into the CD-ROM drive and locate and select the Utilities\PC 
Utilities folder.

2. In the PC Utilities folder, select and copy the AdobePS Driver.exe file to the 
desktop.

Note:  If you have server access, on the Spire CX260, locate the printer driver 
folder under D:Utilities\PC Utilities.
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To copy the Spire CX260 PPD file:

1. Insert CD #3 into the CD-ROM drive and locate and select the Utilities\PC 
utilities\Printer Driver\Printer driver application\Win2000_XP_2003 folder.

2. Select either the Europe-A4 or US-Letter folder.

3. Select the desired language folder.

4. Select and copy the CX260_V2.PPD file to the desktop.

To install the Adobe PostScript Driver:

1. Deliver the AdobePS Driver.exe and CX260_V2.PPD files to the desired client 
workstation or customer PC.

2. On the client workstation or customer PC, copy the AdobePS Driver.exe and 
CX260_V2.PPD files to the desktop.

3. Double-click the AdobePS Driver.exe file to install the Adobe PostScript Driver.

4. Follow the instructions in the Adobe PostScript Driver Installer wizard. When 
the wizard requests the location of the PPD file, browse to the desktop and 
locate the CX260_V2.PPD file.

Note:  If you have server access, on the Spire CX260, locate the 
D:\Utilities\PC Utilities\Printer Driver\Printer driver 
application\Win2000_XP_2003 folder.
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The Workspace

Opening the Spire CX260 Workspace from the Start Menu
If the workspace has been closed, open it as follows:

Select Start>CX260>CX260.

The splash screen appears followed by the Spire CX260 workspace.

Table 3 describes the Spire CX260 workspace.

1

2

3

4

5

6

7

8

Table 3: Spire CX260 workspace

Item Name Description

1 Menu Bar Consists of the Job, Selection, Tools, Control, View, and Help menus. 
Click a menu name to open the corresponding menu.

2 Status Panel Contains the logo, Processing status area, Printing status area, server 
icon, printer icon, and current time.

For more information on the server and printer icons, see The Server and 
Printer Monitors on page 52.

3 Toolbar Consists of shortcut buttons for the Import window, Resource Center, 
Message Viewer, and Calibration window
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Customizing the Workspace View

The View menu enables you to customize the workspace. From this menu, you can 
open and close the Queues window. The menu also provides the following view 
options:

• Spire classic view: Displays the status panel, toolbar, Storage window, Queues 
window, Thumbnail window, and Alerts window

• Spire classic plus view: Displays the status panel, toolbar, Paper Stocks window, 
Storage window, Queues window, Thumbnail window, and Alerts window

• Queues view: Displays only the Print Queue and Process Queue

4 Queues Consists of the Process Queue, which lists the files to be processed. 
After a file has been processed successfully, it moves to either the Print 
Queue (the upper area) or the Storage window.

For more information on Queues, see Managing the Job Queues on 
page 52.

5 Alerts Lists the alert messages that are generated during the workflow.

For more information on the Alerts window, see The Alerts Window on 
page 177.

6 Thumbnail Displays a thumbnail view of a specific page in an RTP job that has 
finished processing

7 Storage The Storage window contains files that:

• were successfully printed

• were held, were aborted, or failed during processing or printing

• were sent directly from the client workstation to the Storage window 
or were imported to the Storage window

For more information on the Storage window, see Managing the Storage 
Window on page 61.

8 Paper Stocks Displays information about the paper in each tray and also shows 
whether the trays are ready for printing.

NOTE: This window is only included in Classic Plus view. For more 
information, see Customizing the Workspace View on page 51.

Table 3: Spire CX260 workspace

Item Name Description
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• Refresh view: Reverts to the factory default view for the view that is currently 
displayed

The Server and Printer Monitors

The server and printer icons are on the right end of the status panel and indicate 
(through animation) whether processing and printing are taking place. If a finishing 
device is connected to the printer, the finishing device also appears in the printer 
icon. You can click the printer or server icon to display status information. You also 
view messages regarding the printer operation mode and status next to the printer 
icon. 

Managing the Job Queues
After entering the Spire CX260, a job resides either in the Queues window or in the 
Storage window, depending on the job flow. 

To display the Queues window:

From the View menu, select Queues.

The Queues window consists of two areas, the Process Queue and Print Queue.

• The Process Queue lists the job that is currently being processed and the jobs 
that are waiting to be processed. 

• The Print Queue lists the currently printing job and the jobs that were processed 
successfully and are waiting to be printed. The Print Queue also lists frozen jobs 
(jobs for which the specified paper stock is not available).

Each queue holds jobs in the order in which they enter it. At any time, you can view 
information regarding the number and status of the jobs in the queues. You can also 
change the order of the jobs and suspend or resume the queue.

Note:  The Spire CX260 always displays the workspace in the most recently 
selected view.

Tip:  By default, the windows in the workspace are all docked-that is, attached 
to the workspace. You can detach, or undock, a window from the workspace 
by right-clicking the window’s title bar and selecting Undock Window.

Server icon Printer icon
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After you start the Spire CX260, the Queues window is displayed. The Queues 
window consists of the Print Queue and the Process Queue.

Each queue holds jobs in the order in which they enter it. The top job in the queue is 
currently running, while all others are waiting to run. 

If necessary, you can change the order the jobs that are waiting in the queues. You 
can also view and edit the jobs’ parameters.

The Queues Window
After you submit PDL jobs (or resubmit PDL jobs), the Process Queue lists the files 
to be processed. 

Once a file has been processed successfully, it moves to the Print Queue and waits 
to be printed or to the Storage window (depending on the current job flow or virtual 
printer).

For more information about operations on the jobs residing in the Queue Manager, 
see Aborting a Running Job on page 57.

Note:  If there are very short jobs in the Print Queue, several jobs may be 
running at the same time. The jobs marked as running are listed first and 
printed in the order they are listed.
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The Queues window lists informations about the jobs that are being 
processed. Status indicators indicate the status of each job. Table 4 
describes the status indicators used in both the Process Queue and Print 
Queue.

Right-click the column heading row to select the columns that you want to 
view.

Table 4: Process Queue and Print Queue status indicators

This Status 
Indicator

Indicates This:

The job is running.

The job is frozen and held in the Print Queue. If a job 
is frozen, it indicates that the selected paper stock is 
not available.

The job is waiting.

The job is locked. You need to enter the job’s password 
before you can print or change job parameters.

Table 5: Process Queue and Print Queue column descriptions

This Column Indicates This Information:

Job Type File format of the PDL job—for example, PS 
(.ps), PDF(.pdf), VPS(.vps)

Sender User name of the system from which this file 
originated

Submitted Date and time this job was first submitted to 
the Spire CX260

Pages Number of pages to be processed in a PDF job. 
If the DTP application supported it, the 
number of pages is indicated for other PDL 
jobs

Sets Number of copies to be printed

Page Size Page size
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Status Information

The Processing and Printing status areas contains the following:

• The suspend and resume buttons (for more information see Suspending and 
Resuming Queues on page 57)

• The queue name.

• If a job is currently being processed or printed, the name of the job and a process 
indicator are displayed.

• The number of jobs in the queue—for example, 2.

Batching Jobs
The job-batching workflow combines jobs with similar attributes into a single batch 
to enable the printer to print the jobs continuously without pausing. This feature 
saves printing time, especially for a large number of small jobs. Jobs that use paper 
of the same size and weight are suitable for batching. 

Media Type Media type

Image Quality Image quality

File Size File size of the job

Account Account name taken from the Job info 
parameter

Job Info Job info type taken from the Job info 
parameter

Imposition Type of imposition used

Page Exception Whether or not the job has page exceptions

Server Name of the server being used

Virtual Printer 
Names

Name of virtual printer being used

Table 5: Process Queue and Print Queue column descriptions

This Column Indicates This Information:

The Processing status area indicated the total number of pages for PDF 
jobs. The number of pages is indicated for other PDL jobs only if the 
desktop publishing application in which they were created supports this 
feature.
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When a job enters the Print Queue, the Spire CX260 checks whether the 
job is suitable for batching with the previous one. 

• A job that can be batched appears with the running status indicator . 
The printer prints both jobs without pausing between them. 

• A job that cannot be batched with the previous one waits in the queue 
and appears with the waiting status indicator . It is printed only when 
the printer finishes the previous job and comes to a stop. 

The Spire CX260 batches suitable jobs only if they are consecutive in the 
queue. Two jobs are not batched if a job that is not suitable comes between 
them in the queue.

The following types of jobs cannot be combined into one batch:

• Collated jobs and uncollated jobs

• Jobs that use different output trays

• Jobs with different staple positions

The job batching option is active by default. 

To deactivate job batching:

In the Settings window (Tools > Settings), select Preferences > Print 
Queue Manager > Disable Job Batching.

For more information about job batching, see Print Queue Manager on 
page 170.

Changing the Order of Jobs in the Queues 
You can rearrange the jobs in a queue to change the order in which they will 
be processed or printed. This feature is useful when you have an urgent job 
that takes priority, for example.

To move a job up in the queue:

Right-click the job and select one of the following options:

Promote: to move the job up one step

Promote to top: to move the job to the top of the queue

Note:  You can only move one job at a time.

Note:  The job is placed below the Running job.
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To move a job down in the queue:

Right-click the job and select one of the following options:

Demote: to move the job down one step

Demote to bottom: to move the job to the bottom of the queue.

Suspending and Resuming Queues
If necessary, you can stop a queue temporarily and then later continue its operation 
afterwards. To do this, use the suspend and resume buttons:

To suspend a queue:

Click the suspend button .

The button turns red (suspend mode), and the processing/printing stops after 
the current job has finished running.

To resume a queue:

Click the resume button .

The button turns green (resume mode), and the top job in the queue starts 
processing/printing.

Aborting a Running Job

To stop processing or printing a running job:

Right-click the running job in the Queues window, and from the menu, select 
Abort.

The job moves from the queue to the Storage window, and the Alerts window is 
updated.

The Aborted status  is assigned to the job, and the next job in the queue starts 
running.
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To return a job to the Process Queue or Print Queue:

Right-click the job in the Storage window and from the Job menu select Submit.

Moving a Waiting Job to the Storage Window
To postpone processing or printing of one or more waiting jobs, use the Move to 
storage option.

To move a waiting job to storage:

1. Select the job in the Queues window.

2. Right-click the job(s), and select Move to storage.

The job(s) move(s) from the queue to the Storage window and appears with the 
held job indicator . 

Note:  To return a job to the proper queue, right-click the job(s) in the Storage 
window and from the Job menu select Submit.

Note:  You can only perform this action if the job is waiting in the queue. If the 
job is active, this option is not available.
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To return a held job from the Storage window to its original queue:

Right-click the job, and from menu select Submit.

The job moves from the Storage window to the queue and appears with the 
waiting job indicator.

Unlocking a Job

A job that was locked in the Spire Print Driver software must be unlocked before you 
can change job parameters or send the job to print.

A locked job appears with the Locked indicator .

For more information about locking a job, see Locking a Job on page 15.

To unlock a job:

1. Depending on the which queue the job is in, do one of the following:

• In the Print and Process queues, right-click the job that you want to unlock 
and select either Job Parameters or Run immediately.

• In the Storage queue, right-click the job that you want to unlock and select 
Job Parameters.

The Secure Printing dialog box appears.

Note:  This feature is only available for the Pro Basic and Pro Control Station 
configurations.
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2. In the Password box, type the password and click OK.

Viewing and Editing Job Parameters
In the Queues or Storage window, double-click the job whose parameters you 
want to view.

The Job Parameters window appears.

Deleting a Job
Once you delete a job from the Process Queue, Print Queue, or Storage window, you 
need to resubmit it for processing and printing. To temporarily remove a job from a 
queue, use the Move to storage option (see Moving a Waiting Job to the Storage 
Window on page 58).

To delete a job:

1. Right-click the desired job in the queue or Storage window, and select Delete.

The following message appears.

2. Click Yes.

The selected job is deleted.

Note:  In the Queues window, you can edit the parameters of jobs that have 
not begun to run. If you want to edit the parameters of a running job, you 
must first suspend the queue (click the suspend button).

Note:  If you edit the parameters in of a job in the Print Queue and the 
changes require re-RIPing of the job, it automatically moves to the Process 
Queue.

Note:  You can only perform this action if the job is waiting in the queue. If the 
job is active, this option is not available.

Note:  You can delete more than one job at a time: Select the jobs, and 
from the Job menu, select Delete.
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Managing the Storage Window
The Storage window is displayed by default. If you close the Storage window, you 
can reopen it by selecting Storage from the View menu.

The Storage window contains jobs of various types:

• Printed Jobs

• Jobs that you moved to the Storage window or aborted during processing or 
printing

• Jobs that failed during processing or printing

• Retrieved jobs

• Jobs that were imported directly to the Storage window from the client 
workstation (by selecting the Spool & Store option for the job flow)

In the Storage window, you can see the number of jobs that are in storage and their 
status.

Each job in the Storage window is assigned a status as shown in Table 6:

By default, the Storage window shows all the jobs, whatever their status. All the 
status buttons are selected—that is, they appear pushed in. If you click a status 
button—for example, the Completed Jobs button—the button is released and the 
list hides all the completed jobs:

Table 6: Storage window status buttons

Icon Status Indicates This

Completed The job has finished printing.

Held You moved the job from the Queues window to the 
Storage window; or the current job flow or virtual 
printer moved the job to the Storage window 
automatically.

Failed The job failed during processing or printing.

Aborted You aborted the job in the Queues window while 
the job was running.

Locked You locked the job in the Spire Print Driver 
software.
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If you click the Completed Jobs button again, the button is pushed in and the list 
shows the completed jobs.

Discarding RTP Information
The RTP information can be discarded if desired. Under some circumstances, it is 
necessary to discard RTP data—for example when you want to re-RIP a file, archive 
a job without the RTP information, or edit tabs.

To discard RTP information from a job:

In the Storage window, right-click the relevant job and select Revert to source.

The RTP data is discarded and the file returns to its original format—for example, 
PostScript.

Handling Jobs in the Storage Window
In the Storage window you can perform the following actions:

• Submit a job. See Submitting Jobs on page 63.

• Preview and edit a job, using the Job Editor. See Job Editor on page 78.

• View and edit the parameters of a job. See Viewing and Editing Job Parameters on 
page 60.

• Unlock a job. See Unlocking a Job on page 59.

• Archive a job. See Archiving and Retrieving Jobs on page 64.

• Duplicate a job. See Duplicating Jobs on page 63.

• Delete a job. See Deleting a Job on page 60.

• View a job’s history (in the Job History window). See Viewing a Job’s History on 
page 66.

• Export a job as a PDF file.

Note:  When all the status buttons are in the released (unselected) position, 
The Storage window shows no jobs.
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• Export a job as a Kodak® InSite™ remote proofing job. See Export as InSite Job on 
page 66.

• View the job ticket report for a job. See Job Ticket Report on page 118.

• View the preflight report for a job. See Preflight Report on page 110.

• Use the PDF analyzer to detect problems in imported PDF files that may affect 
processing. See Analyzing a PDF Job on page 107.

• Forward a job. See Forwarding Jobs on page 63.

Submitting Jobs
In the Storage window, right-click the job, and select Submit.

RTP jobs are submitted to the Print Queue; all other jobs are submitted to the 
Process Queue.

Duplicating Jobs
In the Storage window, right-click the job and select Duplicate. 

The selected file is duplicated and is given the name of the original job followed 
by the suffix _dup.

Forwarding Jobs

1. In the Storage window, right-click the job and select Forward to > Other.

The Forward to dialog box appears.

Note:  This feature is only available for the Pro Basic and Pro Control Station 
configurations.

Notes:

• Duplicating an RTP job creates a PDL version of the job.

• Once you duplicate a job, you can only edit parameters in the Job Editor 
that do not require re-RIP. 

Note:  This feature is only available for the Pro Basic and Pro Control Station 
configurations.

Note:  If you select to forward a merged job, and you make changes to the 
job, you will not be able to reRIP the job on the server to which you 
forwarded the job.
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2. In the Host name / IP Address box, type the name or IP address of the desired 
server that you want to forward the job to.

3. Click Find.

4. Select one of the following:

• Send to Storage to send the job to the selected server’s Storage queue.

• Send to print to send the job to the selected server’s Print queue.

5. Click Send.

Archiving and Retrieving Jobs
To keep enough disk space free, we recommend that you back up jobs and their 
related files to an external server and then delete them from the Storage window.

This backup process is called archiving. You can retrieve archived jobs and related 
files later for further use.

You can set a default archiving path that will automatically be displayed in the Open 
dialog box when you select Archive from the Job menu. Set this path in the Settings 
window under Preferences > General Defaults.

If a job includes VI elements, they are included when you archive or retrieve the job.

To archive a job on an external server:

1. In the Storage window, right-click the job that you want to archive and select 
Archive.

The Archive dialog box appears.

Note:  The server name or server IP address that you enter will appear in 
the list the next you forward a job. Instead of typing the name, you can 
select it from the list.

Note:  If you send a PDF or PostScript job to the Print queue, it will be 
sent to the Process queue first and then the Print queue.
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2. Locate the desired folder, and then click Archive.

A cabinet file (a compressed file) that contains all the files related to the archived 
job is created at the selected location. 

3. In the Alerts window, verify that archiving has been completed.

4. Delete the job from the Storage window.

To retrieve an archived job:

1. From the Job menu, select Retrieve from Archive.

The Retrieve dialog box appears.

2. Locate the archived job under its archive name, select the related cabinet file, 
and click Retrieve. 

The selected job appears at the top of the list in the Storage window. It is assigned 
the status indicator (completed, held, failed, or aborted) that it had before 
archival. 

3. In the Alerts window, verify that the file has been successfully retrieved.

Notes:

• The archived job retains its current status (that is, completed, failed, 
held, or aborted) and is archived with the information in its Job 
Parameters and Job History windows. 

• When retrieved, the archived job retains the original job name, not the 
name assigned when archived.

Notes:

• You can retrieve more than one job at a time.

• The files related to the job (for example, PDL) are also retrieved.

• The job is retrieved with the information in its Job Parameters and Job 
History windows.

• The cabinet file is not deleted.
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Viewing a Job’s History
In the Queues or Storage window, right-click the job and select Job History.

The Job History window appears.

For more information about the Job History window, see Job History on page 178.

Export as InSite Job

InSite remote proofing provides an Internet-based communication between you and 
your customers and enables you to proof jobs and receive approvals remotely. 

If your site includes an InSite server, exporting your job as an InSite job from the 
Spire CX260 allows you and your customers to proof online with geographically 
dispersed users simultaneously, append annotations or comments, and approve or 
reject pages over the World Wide Web using a standard browser.

After the RTP job is created on the Spire CX260, it can be exported as an InSite job 
from the Storage window. When the customer logs on (using their unique user 
name and password), they see the status of their jobs, view a thumbnail of all pages 
in each job, and quickly identify which pages require further corrections. The 
customer can measure color density, make annotated comments, and approve 
pages. The online proofing cycle is shortened and accurate, and consequently, the 
need for reprints is reduced.

To export as InSite:

1. Select the desired job in the Spire CX260 Storage window.

2. Right-click the job, and from the menu select Export as InSite Job.

The Export window appears.

3. Locate the file in which you want to export the job, and then click Export.

A Kodak Brisque® Job is created in the selected location. You can now register the 
files on the InSite server and start the approval cycle.

Note:  This feature is available only for the Pro Basic and Pro Control Station 
configurations.
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Importing and Printing Files

To import files to the Spire CX260:

1. From the Job menu select Import Job.

The Import window appears. 

2. To access the desired files, click the up one level button , or double-click on 
the file folders to go down the file tree.

3. In the upper list in the Import window, select the desired files and click the add 

button .  

The file(s) appears in the lower list.

4. Select a printer from the Virtual Printer list. 

5. Click Import.

All files currently listed on the lower list are sent to the Spire CX260 to be 
processed and printed as defined in the selected virtual printer.

To check the status of imported jobs:

1. Click the Server icon arrow.

Note:  Use SHIFT or CTRL to select several files or CTRL+A to select all the 
files. If required, add the same file more than once. 

Notes:

• To remove a file, select the desired file in the lower list in the Import Job 
window and click the remove button.

• Use SHIFT or CTRL to select several files at once.
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The Importing/Retrieving window appears.

The Importing/Retrieving window indicates the name of the file being imported, 
its location and the job size. It also indicates the percentage of the job already 
transferred, both numerically and graphically.

2. Select one of the following options:

• Click Skip This Job to stop importing the current file and import the next job 
in the import queue.

• Click Abort All Jobs to stop importing all the files.

• Click Close to close the Importing/Retrieving window.

Reprinting Jobs

Submitting an RTP Job Requiring no Changes
Select the job in the Storage window and from the Job menu select Submit.

The job(s) are placed in the Print Queue.

Submitting a Job that Requires Re-RIPing
1. Double-click the job to open the Job Parameters window. 

2. Change the desired parameter and click Submit.

The Spire CX260 automatically determines if your job needs to be re-RIPed and 
places it in the appropriate queue.

Note:  Use SHIFT or CTRL to select several jobs.
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The Settings Window

You can set all system preferences in the Settings window. 

To open the Settings window:

From the Tools menu, select Settings. 

The window is divided into two areas: 

• Administration: All users can view these settings, but only an administrator can 
configure the settings. 

• Preferences: All users can view these settings, but only an administrator or 
operator can configure the settings.  

For more information on the Settings window, see System Administration on 
page 153.

Note:  If you log on to the Spire CX260 as a guest, the Settings window is 
unavailable.
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The Resource Center

The Resource Center enables you to add, remove, and manage external resources 
for the Spire CX260.

To open the Resource Center:

On the toolbar, click the Resource Center button . 

The Resource Center provides access to the following resources:

• Profile Manager, see Profile Manager on page 138

• Fonts, see Managing Fonts on page 93

• Virtual Printers, see Managing Virtual Printers on page 93

The Job Parameters Window
The Spire CX260 enables you to edit imported PDL files and change the job 
settings—for example, paper size, imposition, and color settings—in the Job 
Parameters window.
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To open the Job Parameters window:

Double-click a job in the Storage or Queues window.

The Job Parameters window title bar displays the following information:

• The name of the job

• The time of submission

• The name of the virtual printer

Table 7: Description of tabs in the Jobs Parameters window

This tab Enables you to

Print Settings Set print related job parameters—for example, 
Print range and Print method. See The Print 
Settings Tab on page 182.

Paper Stock Set job parameters related to Paper size and 
Media Type. See The Paper Stock Tab on page 186.

Print Quality Set job parameters related to print quality—for 
example, Trapping and Image quality—and 
improve the quality of printed jobs. See The Print 
Quality Tab on page 187.

Color Apply last minute color corrections, or set the 
output job to match other output devices. See 
Color Workflow on page 121 and The Color Tab on 
page 189.

Imposition Set job parameters related to positioning, folding, 
trimming, and binding of pages—for example, 
Margins and Template. See The Imposition Tab on 
page 194.
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The Help Menu
The Help menu enables you to access the online help, which is based on this user 
guide, and provides information about the current version of the Spire CX260 
installed on your computer.

To open the About window:

From the Help menu, select About.

The About window displays the following information:

• Spire CX260 version number

• Date the version was installed

• Any updates that were installed on top of the version

To open the online help:

From the Help menu, select Topics.

The DFE Monitor
To open the DFE Monitor window, click the server icon.

The DFE Monitor window displays information about disk space, network details, 
and the virtual printers you have defined. 

The Disk Usage tab shows how much space is available on the user disk and printer 
disk.

Services Set job parameters that will assist your job 
workflow—for example, APR path and Preflight. 
See The Services Tab on page 200.

Finishing Select from various options to finalize your printed 
document—for example, define settings for the 
front and back cover. See The Finishing Tab on 
page 204.

Exceptions Define paper sets to include special exceptions in 
a job, and add inserts or interleaves. See The 
Exceptions Tab on page 206.

Table 7: Description of tabs in the Jobs Parameters window

This tab Enables you to
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The Network tab provides information about the network.

The Virtual Printers tab lists the virtual printers that you have defined.

The Printer Monitor
To open the Printer Monitor window, click the printer icon.

The Printer Monitor window displays information about the size and type of paper in 
each tray, the connected devices, and other aspects of the consumables.

The Paper Stock tab displays information about the paper in each tray and also 
shows whether the trays are ready for printing.
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The Finisher tab displays information about finishing devices that are connected to 
the Xerox DocuColor 242/252/260 printer/copier.

The Consumables tab displays the status of other refillables.
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Remote Desktop Application
The Remote Desktop Connection (RDC) application enables you to connect, view, 
operate, and perform administrative procedures on the Spire CX260 from a client 
workstation. While the remote connection and operation takes place, the regular 
operation of the Spire CX260 is not affected 

For more information about the Remote Desktop application, see Working from the 
Remote Desktop Application on page 86.

Note:  This tool is designed exclusively for the system administrator. Users that 
want to connect to the Spire CX260 from a client workstation can use the 
Remote Workspace. For more information about viewing jobs from a client 
workstation, see Remote Workspace on page 29.
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Overview
You import jobs for printing in the following situations:

• When a page-description language (PDL) file is created on a client workstation 
that is not connected to the Spire CX260

• When a PDL file is located on an external medium, such as a CD-ROM

• When the desired file resides locally on the Spire CX260

Job Editor
The Job Editor tool enables you to preview a job before printing, delete, move or 
insert pages. While you navigate to the various pages of a job, you can view 
thumbnails of the job. For an imposed job, you can view the imposed sheets, 
including the layout of the pages on each sheet. You can also view the pages’ 
orientation, crop marks, and fold marks.

To open the job editor:

In the Storage window, right-click an RTP job that you want to preview, and 
select Job Preview&Editor.

The Job Editor window appears, displaying the first page of the selected job. 

Navigation Buttons

The navigation buttons enable you to select a specific booklet or page to view, and 
to browse the pages of the current job.  

Note:  When the first page of a booklet is in view, the Previous Page navigation 
button takes you to the previous booklet. When the last page of a booklet is in 
view, the Next Page button takes you to the next booklet.
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Previewing the Job
The preview buttons enable you to switch the display mode of the page.

Table 8: Preview Buttons

Viewing Pages in the Job Editor
The Job Editor window has three tabs—Booklets, Thumbnails and Imposed 
Sheets—which enable you to switch between views.

This button: Enables you to:

Pan

View a different area of the image.

Eye Dropper

Find out the CMYK values of a specific area on 
the page. To find the values, first click the Eye 
dropper button. Then move the pointer to the 
point on the page where you want to measure 
the color values, and click. The CMYK values 
appear as a tool tip.

Zoom In

Magnify the selected area of the page.

Zoom Out

Reduce the size of the selected area by 50%.

One to One Zoom

View the actual size of the page one to one 
(1:1).

Fit to Screen

Scale the page to fit the available screen space.

View the image at different preset levels of 
magnification by selecting a percentage in the 
list.

Rotate View

Rotate the page by 90°, 180° and 270°.

Show/Hide 
Separation

Turn on or off one or more separations.
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The Booklets tab
The Booklets tab displays the booklets included in the selected job and the names 
and numbers of the pages in each booklet. The Booklets tab opens by default when 
you are previewing a nonimposed RTP job.

To view a page on the booklets tab: 

In the left pane of the Booklets tab, double-click the name of the page that you 
want to view.

The page is displayed in the right pane.

 

The Thumbnails Tab 
The Thumbnails tab displays miniature views (“thumbnails”) of each page in the 
selected booklet. These thumbnails enable you to find a specific page more easily.

To view a page on the Thumbnails tab:

1. Click the Thumbnails tab.

Miniature versions of the pages appear on the left side of the tab, in the 
thumbnail pane.

2. Use the scroll bar, as desired, to view all of the pages.
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3. To view the thumbnails side by side, resize the thumbnail pane by dragging the 
bar that divides the panes in the tab.

4. Double-click the thumbnail of the page that you want to view. 

The page is displayed in the right pane.

The Imposed Sheets Tab

The Imposed Sheets tab is available only for imposed RTP jobs. This tab enables you 
to view the imposed sheets and check your imposition parameters. You cannot edit 
the job on this tab.

To display a page of an Imposed job:

1. Click the Thumbnails or Booklets tab.

2. Select the desired thumbnail or page.

3. Click the Imposed sheets tab.

The selected page of the imposed job appears.

Note:  The Imposed Sheets tab is available only if you have the Pro 
configuration.

Notes:

• In VI jobs, the booklet number appears in instead of the sheet number—for 
example, Booklet 1, Page 15.

• In duplex jobs, each sheet is displayed twice, once for side A, and once for 
side B. For example, Sheet 1, Side A.
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4. To edit the job, click the Booklets or Thumbnails tab. 

Editing an RTP Job
You can edit an RTP job in the following ways:

• Move pages within the job 

• Delete pages from the job 

• Merge pages from another job

To move a page in a job:

1. Click the Thumbnails tab.

2. In the thumbnail pane, click the page that you want to move.

3. Drag the page to the target location.

Note:  If you edit an imposed RTP job and then return to the Imposed sheet 
view, the view will be updated according to the applied changes.

Note:  Jobs that you can edit in the Job Editor cannot be re-RIPed. Once a job 
has been saved in the Job Editor, it is a new RTP file without an associated PDL 
file. You cannot apply parameters that require re-RIPing to such jobs.

Note:  The red marker indicates where the page will be inserted.
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The page moves to the selected location, and the page numbers are updated 
accordingly.

4. Click Save As to save the changes in the job.

To delete a page from a job

1. In the Job Editor window, click the page that you want to delete, and click 
Remove.

The page is deleted and the page numbers are updated accordingly.

2. Click Save As to save the changes.

Merging Pages Into a Job
You can merge one page, multiple pages, or all pages from one job into another.

To merge one or more pages into a job:

1. In the Job Editor window, click the Thumbnails tab.

2. In the left pane of the Thumbnails tab, determine a location for the merged 
page. Click the page preceding this location.

A blue outline appears around the selected page.
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3. Click Merge Jobs.

The RTP Jobs window appears.

Note:  The Spire CX260 displays only those RTP jobs that have the same 
page size and orientation as the job that you are editing.
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4. Select the job with the page that you want to merge and click OK.

The job opens in a separate window.

5. Do one of the following:

• To merge one page, select the page that you want to merge and click Merge.

• To merge all pages, click Merge All to merge all pages into the job.

The merged pages are inserted into the desired location, and the page numbers 
are updated accordingly.

Tip:  You can also drag the page from the job window to the desired 
location in the left pane of the Thumbnails tab.

Tip:  If you want to merge more than one page, repeat this step until all 
desired pages are merged. You can also select different locations for the 
merged pages in the Job Editor window.
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6. Click Close to close the job window.

7. Click Save As to save the changes.

Remote Tools

Working from the Remote Desktop Application
The Remote Desktop Connection (RDC) application enables you to connect, view, 
operate, and perform administrative procedures on the Spire CX260 from a client 
workstation. While the remote connection and operation takes place, the regular 
operation of the Spire CX260 is not affected 

The Remote Desktop utility is integrated into the Windows XP Professional 
operating system, while for Windows 9x 98/ME, 2000, and Mac OS, the remote 
desktop must be set up. 

Connecting from Windows

To connect to the Spire CX260 from your client PC:

1. From your desktop select Start > Programs > Accessories > Communications > 
Remote Desktop Connection.

By default, the Remote Desktop Connection dialog box opens on the General 
tab.

Note:  This tool is designed exclusively for the system administrator. Users that 
want to connect to the Spire CX260 from a client workstation can use the 
Remote Workspace. For more information about viewing jobs from a client 
workstation, see Remote Workspace on page 29.

For more information on installing the Remote Desktop utility on Windows 
2000 and earlier, see the Creo Color Server for the Xerox DocuColor 242/
252/260 Printer-Copier Technical Manual (part number 731-01024A-EN).

Tip:  If the tabs are not visible, click Options.
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2. On the General tab, type the following information:

a. The name of the Spire CX260 to which you want to connect

b. The Spire local user name; the default is operator

c. The Spire local password; the default is spire

3. Select the Local Resources tab.

4. If you intend to install software via the remote desktop connection, in the Local 
devices area select the Disk drives check box.

Tip:  To shorten the connection process when a session to the selected remote 
computer disconnects, select the Save my password check box.
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5. Click Connect.

The Log On to Windows dialog box appears on the Spire CX260.

6. Enter the User Name and Password, and click Connect.

You are now connected to the desired Spire CX260. The shared drives on your 
client PC are published and appear locally on the desktop of the Spire CX260.

If the workspace is not open on the Spire CX260, see The Workspace on page 50.

Connecting from Macintosh

To connect to the Spire CX260 from your Mac client:

1. Double-click the Remote Desktop Connection application. By default, the 
General tab appears.

a. In the Computer box, type the name of the Spire CX260 to which you want 
to connect.

Note:  If the General tab does not appear, click the Options arrow to 
display the entire window.
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b. Type the Spire local user name and password.

User name—operator

Password—spire

c. Select the Add to Keychain check box. 

2. Select the Display tab and verify that your settings are the same as the settings 
in the following window.

3. Select the Local Resources tab.

Note:  Selecting the Add to Keychain check box automatically saves 
your current connection settings, enabling a quick reconnection to the 
Spire CX260. 
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4. If you intend to install software via the remote desktop connection, in the Local 
Resources tab select the Disk Drives check box.

5. Select the Performance tab.

6. If you are connected via LAN, select the LAN (10Mbps or higher) setting.

7. Click Connect.

8. A security message appears, click OK.

The shared drives on your Mac client are published and appear locally on the 
desktop of the Spire CX260.
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If the workspace is not open on the Spire CX260, follow the procedure for opening 
it. See The Workspace on page 50.

Web Center
The Web Center is an Internet site that provides online information and can be 
accessed from client workstations.

The Web Center enables you to view the status of jobs in the queues, the Messages 
window in its current state, and the printer system information.

To connect to the Web Center from a client workstation:

1. On your desktop, click the Internet Explorer icon.

2. When the Internet Explorer starts, in the address field type: 
http://<host name>—for example, if the CX260 station name is CX260_12, 
type http://CX260_12.

The Spire CX260 Web Center window appears. 

The Web Viewer

The Web Viewer page consists of four tabs and enables you to view the jobs that 
currently reside in the Spire CX260 Queues window and Storage window, and also 
view messages that currently appear in the Messages window. This information is 
important when you print from a client workstation because it enables you to 
monitor your jobs in the queues and then make any necessary changes. 

In addition, if you have a system that uses XML protocol, you can retrieve 
information about the job list and printer status.

Important:  To connect to the Web Center from a client workstation, you 
must first enable the web connect service on the Spire CX260, see Remote 
Tools Setup on page 159.

Note:  You can also use the Spire CX260 IP address—for example,
http://192.168.92.10.

Important:  If you would like to connect to the Spire CX260 from a 
Macintosh client workstation, contact your system administrator to add 
the Spire CX260 name to the DNS. This is required since Windows name 
resolution protocols are not supported in Macintosh. The DNS addition 
is required when clients go through a main server on the network.

Tip:  You can also access the Web Viewer using the EZ Connect application. 
For more information, see EZ Connect on page 24.

Table 9: Description of Web Viewer tabs

This tab Enables you to view

Queues Jobs that are currently running in the Spire CX260 Print 
queue and Process queue. 

Storage The Spire CX260 Storage window and the jobs that reside in 
this window.
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Web Viewer API
If you have a system that uses XML protocol, the JobList.xml file and the Printer 
Status.xml file enable you to retrieve information about the job list and the printer 
status.

The JobList.xml file contains information about files in the Print Queue, Process 
Queue, and the Storage window.

To see the Job List view, type the following path: 
http://<ComputerName>/WebViewer/GetView.asp?View=JobList_xml.

The Printer Status.xml file contains information about the various printer states. 
To see the Printer State view, type the following path: 
http://<ComputerName>/WebViewer/GetView.asp?View=PrinterStatus_xml.

Downloads
The Downloads page enables you to access the Spire CX260 Utilities folder and 
download available tools and files for Windows and Macintosh client 
workstations—for example, the Spire CX260 PPD file.

Alerts The Spire CX260 Messages window. For example, if a job 
that you sent to print from your client workstation has 
failed—you can view the message in the Message window, 
edit the job parameters (PPD file), and then resend it for 
processing and printing on the Spire CX260.

Printer Shows the Spire CX260 system information.

Table 9: Description of Web Viewer tabs
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Managing Fonts
This section explains how to work in the Fonts area of the Resource Center.

1. On the toolbar, click the Resource Center button . 

2. In the Resource list, select Fonts.

3. Choose a Font Library option. The default option is Latin.

4. To set the default font, select a font from the list, and click Set as Default.

5. To delete a font, select the font, and click Delete font.

Managing Virtual Printers
A virtual printer is a printer published on the network with specific parameters set 
for processing and printing on the Spire CX260. The Spire CX260 contains a 
mechanism that automatically installs the published virtual printers on your client 
workstation with the PPD and suitable printer driver. 

The Spire CX260 is predefined with three virtual printers:

• ProcessPrint 
Files sent to this printer are automatically processed and printed to the printer 
through the Spire CX260.

• ProcessStore 
Files sent to this printer are automatically processed and stored in the Storage 
window of the Spire CX260. You can later submit the jobs to be printed, or 
change the parameters of a job and resubmit it for processing.

• SpoolStore
Files sent to this printer are automatically stored in the Spire CX260's Storage 
window until the print operator submits them for processing and printing.

Note:  To add new fonts to the Spire CX260, copy the new fonts to the 
C:\CX260\General\RIP\fonts folder.
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If a job that is sent from the client, or downloaded to a particular virtual printer, 
contains preset parameters from the PPD, these options overwrite the parameters 
set in the virtual printer for that job. The Printer Default options defined in the PPD 
use the default parameters set for that particular virtual printer.

Adding a New Printer
When adding a new virtual printer you can specify if it is published on the network 
and if the virtual printer parameters will override the PPD parameters.

To add a new printer:

1. On the toolbar, click the Resource Center button . 

The Resource Center window opens.

2. From the Resource list, select Virtual Printers.

3. Click the New button .

The Add Virtual Printer dialog box appears.

4. In the Name box, type a name for the new printer you want to add.

5. From the Based on list, select an existing printer with similar settings.
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6. In the Comments box, type any comment regarding the virtual printer 
parameters (optional).

7. The Publish the printer on the network check box is selected by default. Clear 
the check box if you do not want to publish the printer on the network.

8. Select the Override PPD parameters check box if you would like the virtual 
printer settings to override the PPD parameter selection.

9. Edit the job parameters of your new virtual printer. 

10. Click OK in the Add New Virtual Printer dialog box. 

The new printer appears in the Printer list.

Editing an Existing Printer

To edit an existing printer:

1. In the Virtual Printers area, select a printer from the list and click the Edit button 

.

2. Click Edit.

The Job Parameters window appears.

3. Select the desired parameters and change their settings according to your 
requirements.

4. Click OK to return to the Edit Virtual Printer dialog box.

5. Click Save to save the new settings.

Note:  If you don't edit the job parameters, the settings of the new virtual 
printer are taken from the printer on which it was based.
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Deleting an Existing Printer
1. In the Virtual Printers window, select a printer from the list and click the Remove 

button .

2. In the message that appears, click Yes to delete the designated printer.

Tray Alignment
The Spire CX260 Tray Alignment option enables you to fix tray alignment problems. 
Using the Tray Alignment tool, you can change the default position and rotation 
settings of a page printed from a specific tray. By tweaking the position and rotation 
values, you can overcome tray skewing and side-to-side alignment problems.

Notes:

• Tray alignment is set for a specific tray. Each tray may have its own specific 
settings.

• For optimal results, it is recommended to perform tray alignment using the 
exact paper stock attributes (size and weight) that are used in the actual 
printed jobs.

• Tray alignment is not supported for Tray 5 (Bypass).

• When using the Tray Alignment wizard with languages other than English, 
you may need to manually resize the wizard window to view the entire 
textual content.
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To open the Tray Alignment wizard:

From the Tools menu, select Tray alignment.

The Tray Alignment wizard contains detailed step-by-step instructions that 
guide the user through the tray alignment process.

Using the Tray Alignment Wizard
1. Select your settings (Tray, Page Orientation, and Print Method) and click Print.

2. Click Next.

The Image Position window appears.
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3. Perform image position (rear and lead) tweaking by using the Tray Alignment 
wizard’s custom units. Each custom unit, or point (2mm), is one line as viewed 
in the center grid of the tray alignment test page.

• For Simplex—using the Face Down settings, visually determine where to 
position the image.

• For Duplex—using both the Face Up and the Face Down settings, follow the 
instructions in the Image Position window of the Tray Alignment wizard.
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Table 10: Tray alignment image positioning

4. Click Next.

The Rotate Image window appears.

LEF SEF

Portrait Landscape Portrait Landscape

Face 
Up

Up (Rear) 
Negative 
numbers

(Lead) 
Negative 
numbers

(Lead) 
Negative 
numbers

(Rear) 
Negative 
numbers

Down (Rear) 
Positive 
numbers

(Lead) 
Positive 
numbers

(Lead) 
Positive 
numbers

(Rear) Positive 
numbers

Right (Lead) 
Positive 
numbers

(Rear) 
Negative 
numbers

(Rear) 
Negative 
numbers

(Lead) Positive 
numbers

Left (Lead) 
Negative 
numbers

(Rear) Positive 
numbers

(Rear) 
Positive 
numbers

(Lead) 
Negative 
numbers

Clockwise Positive Numbers

Counterclock
wise

Negative Numbers

Face 
Down

Up (Rear) 
Negative 
numbers

(Lead) 
Positive 
numbers

(Lead) 
Positive 
numbers

(Rear) 
Negative 
numbers

Down (Rear) 
Positive 
numbers

(Lead) 
Negative 
numbers

(Lead) 
Negative 
numbers

(Rear) Positive 
numbers

Right (Lead) 
Positive 
numbers

(Rear) Positive 
numbers

(Rear) 
Positive 
numbers

(Lead) Positive 
numbers

Left (Lead) 
Negative 
numbers

(Rear) 
Negative 
numbers

(Rear) 
Negative 
numbers

(Lead) 
Negative 
numbers

Clockwise Positive Numbers

Counterclock
wise

Negative Numbers
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5. To save the selected tray alignment settings, click Finish.

Enabling Tray Alignment for a Job
1. Under the Paper Stock tab, select Tray.

2. Select the relevant tray

3. Select the Use Tray Alignment settings check box

4. Re-RIP the job in order for the settings to take effect.

Printing on Tabs Using the Spire Tabs Plug-In for Acrobat

Creating Tabs With the Tabs Plug-in
The Spire Tabs plug-in for Acrobat (version 7.0 or later) enables you to create and 
place tabs in your unprocessed (PDF or PostScript) jobs, manage the tab and text 
attributes, and save a set of attributes for future use.

When using the Spire Tabs plug-in to create tabs, it is not necessary to define 
exceptions on the Exceptions tab.

To create tabs:

1. In the Storage window, right-click your unprocessed job and select 
Job Preview&Editor.

Note:  This feature is only available for the Pro Basic and Pro Control Station 
configurations.

Important:  If you add tabs to your job, you need to select the Mixed paper 
size document check box (in the Job Parameters window, on the Paper Stock 
tab, under Mixed paper size).

Note:  The job must be a PDF or PostScript file.
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The job opens in Acrobat software.

2. From the Plug-Ins menu, select Spire Tabs Printing.

The Tabs Printing window opens, displaying the Text Attributes tab.

3. In the Tabs area, set the tab attributes:

a. By default, the tab size for letter jobs is set at 9x11, and for A4 jobs, A4+. To 
change the tab size, select a tab size from the Size list.

b. In the Type list, select the number and type of tabs.

c. Select the appropriate orientation of the tab.

d. In the Top Offset box, type a value for the distance between the upper edge 
of the paper and the upper edge of the uppermost tab.

e. In the Bottom Offset box, type a value for the distance between the lower 
edge of the paper and the lower edge of the lowest tab.

f. In the Length box, type the length of the tab.

g. In the Width box, type the width of the tab.

Tip:  If you want your tabs to be reversed—that is, for the lowest tab to 
be the first one—select one of the reverse tab options.

Note:  The units in the Tabs plug-in are set in the Acrobat Preferences 
dialog box.
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4. In the Text area, set the attributes of the text on the tabs:

a. (Optional) In the Font list, select a font for the text on the tab.

b. (Optional) In the Size list, select a font size for the text on the tab.

c. (Optional) Click the Color button  to change the font color for the text on 
the tab.

d. (Optional) Click Bold  to make the text on the tab bold.

e. (Optional) Click Italic  to make the text on the tab italic.

f. (Optional) Click Underline  to underline the text on the tab.

g. Click the appropriate alignment button as shown in Table 11.

Table 11: Tab alignment buttons

h. (Optional) Under Offset, type offset values in the x and y boxes to adjust 
the offset of text on the tab. The x value moves the text horizontally 
according to the alignment; the y value moves the text vertically.

i. (Optional) Select Wrap text to automatically run the text onto the following 
line when the entire text does not fit on one line.

j. (Optional) Select Text on both sides to have the same text appear on both 
sides of the tab.

k. In the Direction area, select the appropriate direction for the text:

5. Click the Content tab.

Portrait Landscape

Align Left

Align Center

Align Right

Note:  The Direction options are available only for portrait jobs.
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6. In the Before Page column, click the first cell and type the number of the page 
that you want the tab to precede.

7. In the Text column, type the text for the tab.

The tab appears in the thumbnail area.
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8. To add more tabs, repeat steps 6 and 7.

9. Click Apply to apply the tab settings to your document.

The Tabs Printing window closes, and the tabs that you added become part of 
the document.

10. From the Acrobat File menu, select Save.

11. In the Spire CX260, select the Mixed paper size document check box on the 
Paper Stock tab, under Mixed paper size parameters.

12. Process and print the job.

Managing Tabs in the Tab Printing Window

To change the location of a tab:

In the thumbnail area, click the tab that you want to move, and drag it to the 
desired location.

The tab moves to the selected location, and the tab numbers are updated 
accordingly.

To replace a page with a tab:

1. In the thumbnail area, right-click the page and select Replace with tab page.

The page is deleted from the document and replaced by a new tab.

2. In the table, type the tab text.
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To insert a tab before or after a specific page:

In the thumbnail area, right-click the page and select Insert tab before page or 
Insert tab after page.

To remove a page or tab from the document:

In the thumbnail area, right-click the page or tab and select Remove.

Once you have set the tab parameters for a job, you can save the settings. Saved 
settings are useful when you want to print different jobs with the same tab settings.

To save tab settings:

1. In the upper part of the Tabs Printing window, click Save.

2. Type a name for the tab settings.

3. To save the locations and text of the tabs that you created, select the Include 
Tab location and Caption check box.

4. Click Save.

To apply saved settings to a job:

In the Tabs Printing window, select the settings from the Saved Settings list.

The saved settings are applied to the job.

To delete saved settings:

1. In the Tabs Printing window, select the saved settings from the Saved Settings 
list.

2. Click Delete.

The saved settings are deleted.

Printing the Job

Loading the Paper Stock
The Xerox DocuColor 242/252/260 printer/copier supports simplex tabs printing 
from the bypass tray.

Note:  If you do not select this check box, only the text attribute settings 
are saved.

Tip:  You can modify any of the settings as desired.

Note:  If you want to print on both sides of the tab, you need to perform a 
manual duplex sequence.
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To load the paper stock:

1. Load the tabs the Xerox DocuColor 242/252/260 printer/copier in LEF 
orientation, in tray 5 or 6, with the first tab on top (tabs pointing away from the 
printer).

2. On the Xerox DocuColor 242/252/260 printer/copier touch screen, select the 
desired Paper Size.

3. Set the Paper Type to Tab Stock 1 (105-176 g/m2) or Tab Stock 2 (177-280 g/
m2).

4. Touch Save.

Setting Job Parameters
1. In the Job Parameters window, click the Print Settings tab and set the following 

parameters:

• Print Method—Simplex

• Delivery—Face Up

• Rotate 180—Yes

Tabs in 
Tray 6

Tabs in 
Tray 5
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2. On the Paper Stock tab, set the following parameters:

• Paper Size—select the desired size

• Tray—Tray 5 or 6

• Media Type—Use Printer Settings

3. On the Paper Stock tab, under Mixed paper size parameters, select the Mixed 
paper size document check box.

4. Process and print the job.

Preflight
The following preflight features are available:

• PDF analyzer

• Preflight check

• Preflight report

Analyzing a PDF Job

You can use the PDF analyzer to check imported PDF files for problems that may 
affect processing. The PDF analyzer checks the following elements:

• Document: identifies incompatibilities of Acrobat software with compression, 
encryption, security, and other properties

• Pages: detects empty pages and identifies the page size, annotations, and other 
properties

• Fonts: determines whether specific fonts are in the PDF file and whether they 
are embedded

• Colors: detects color space information, spot colors, rendering information, and 
color management settings

• Images: identifies image resolution, whether images are skewed or flipped, and 
whether images are compressed

• OPI: detects whether OPI is used. If so, the PDF analyzer detects the OPI version 
and determines whether any high-resolution images in the OPI path are missing

• Text and line art: identifies the size of text, the width of the lines, white text, and 
objects and flatness tolerance

• PDF/X: determines whether the file conforms to PDF/X-1a or to 
PDF/X-3 and whether the file contains PostScript fragments

Note:  You cannot use the PDF analyzer or perform a Preflight check on PDF 
files that are locked or protected. If you do, a message will appear stating that 
the file is encrypted.

Note:  This feature is only available for the Pro Basic and Pro Control Station 
configurations.
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To run the PDF analyzer:

1. In the Storage folder, right-click the PDF file, and select PDF analyzer.

2. In the PDF PreFlight Settings area, do one of the following actions:

• To check the entire PDF file, select Complete Document.

• To check specific pages, select Pages and enter the desired page range.

3. If you do not want the report to automatically open when it is generated, clear 
Display report automatically.

4. If desired, change the report file name. By default, the report file name consists 
of the original file name and the suffix _rep—for example, if the file to be 
checked is sample.pdf, the report file is named sample_rep.pdf.

5. If you want to save the report to a specific location, click Browse and navigate 
to the desired location.

6. Click Run.

The PDF report is generated and opens automatically.
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Preflight Check

The Preflight parameter enables you to check the status of key job components 
before the job is sent for printing. 

During the preflight check, your job is RIPed and the missing components are 
identified. The preflight check detects the status of the following key job 
components:

• High-resolution images or the wrong links to the high-resolution images folder

• Missing fonts

• Spot colors that are not defined in the Spire CX260 spot color dictionary

The results of the preflight check are displayed in a Preflight Report. By default, a 
preflight report is not issued for each job. To issue this report, you must run a 
preflight check for the job using the Preflight job parameter.

To run a preflight check:

In the Preflight options area, select Run Preflight check.

All three check boxes of the key job components are active, but you can clear any 
check box that you don’t want to include in the preflight check. 

Note:  You must select the preflight options before the job is processed, but 
you can only view the preflight report after the job is processed.

Note:   If a job component is missing, the job fails before it is RIPed (an alert 
message appears) and information about missing components appears in the 
Job History window.

Note:  If one of the selected elements in the list is missing, the job status at 
the end of the preflight check is failed and the job is transferred to the 
Storage window.
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Preflight Report
The preflight report is a job-related report that provides information about the 
status (missing or found) of key job components prior to printing and enables you to 
correct your files accordingly.

It is especially useful to run the preflight check before you print a complex job with 
a large quantity of pages or copies. The preflight check detects the missing job 
components and displays them all at once in the Preflight Report dialog box. You can 
review the report and handle the missing components and thus save printing time.

If you run a preflight check, and all key components are found, the job is processed 
and printed according to the job flow you have selected. If the test fails (missing key 
elements are detected), the job is returned to the Storage window with the preflight 
report available for inspection.

The preflight report always reflects the last preflight run, if more than one preflight 
check is run on a job, the latest preflight report overrides the previous. When a 
preflight report is produced, the date and time of the preflight check are indicated in 
the Job History window.

To view the preflight report:

1. Right-click the job in the Storage window, and from the menu select Preflight 
Report.

The Preflight Report dialog box appears. If you selected the HiRes files option in 
the Preflight Options area, the HiRes Report appears first.

If there are key components in the job not found, this will be indicated by the 

missing indicator  next to the HiRes, Spot Colors, and Fonts report options.

If you did not select a preflight option for the preflight check, the not preflighted 

indicator  appears next to the report option. 

If all of the files are found for a preflight option, the found indicator  appears 
next to the report option.

Note:  Since the Preflight Report dialog box lists all key job components 
(missing and found), you can choose to use this report to view the existing 
(found) key job components, for example the list of the existing fonts in a job, 
and their corresponding paths.
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2. From the Show list select one of the following options:

• To display all files, select All.

• To display only files that were found, select Found Only.

• To display only the missing files, select All Missing.

3. Select the Spot Colors report option.

The Spot Colors Report area displays the missing spot color names (spot colors 
which were not found in the spot color dictionary) and the found spot color 
names (spot colors which were found in the spot color dictionary). The C,M,Y,K 
columns display the spot color CMYK equivalences:

If the status is missing the Spire CX260 uses the original CMYK values that 
are embedded in the PS file to emulate the desired spot color.

If the status is found the Spire CX260 uses the CMYK values that are in the 
spot color dictionary.
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4. Click the Fonts report option.

The Font Report area displays the name of the missing fonts that are not 
embedded in the file and do not exist in the Font Library and also the found 
fonts.

The Source column indicates whether the font is embedded in the file or was 
found in the Font Library.

5. To save the preflight report, click Save and browse to the desired location.

6. To print the report, click Print Report.

Tip:  If more than one preflight check is run on a job, the latest preflight 
report overrides the previous. If desired you may save the report for 
future use.
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Printing Reports 
The following reports can be printed directly from the Xerox DocuColor 242/252/
260 printer/copier:

• Configuration—this report details the current Spire configuration. For more 
information, see View Configuration on page 173.

• Accounting—this report provides information about all the jobs that were 
printed successfully via the Spire CX260. For more information, see Job 
Accounting on page 114.

• Font List—this report lists the fonts that are available in the Spire CX260. The 
font list is available on the Spire CX260 in the View Configuration utility. For 
more information, see View Configuration on page 173.

To print a report from the Xerox DocuColor 242/252/260 printer/copier:

1. On the Xerox DocuColor 242/252/260 printer/copier control panel, press the 
Machine Status button.

2. On the touch screen, touch Billing Meter/Print Report.

3. Touch Print Report/List.

4. Touch Extended Controller Jobs Report.

5. Touch the relevant report name:

• System Settings List to print the Spire Configuration

• Job History Report to print the Spire Accounting

• Font List to print the font list

6. Press the Start button.

The report is printed.

Job Accounting
The Accounting feature provides information about all the jobs that were 
successfully printed via the Spire CX260. The report is in the form of a tab-delimited 
file. You can filter, sort, and print the jobs in the report. You can also export the report 
to a spreadsheet application—for example, Microsoft Excel—where you can 
manipulate the data.

Setting the Accounting/Message Viewer
By default, all jobs that were handled during the past 90 days are listed in the Spire 
CX260 Accounting window. Also, all jobs that were handled during the past 56 days 
are listed in the Spire CX260 Message Viewer. You can specify how long information 
remains before being overwritten.

To change the Accounting/Message Viewer log setup, see Messages on page 172.

Note:  The Error History report is not supported in this version.
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Viewing the Accounting Information
At any stage of work, from the Tools menu select Accounting.

The Accounting Viewer window appears, listing information related to all the 
jobs that printed successfully via the Spire CX260. 

Each row in the Accounting report contains information related to a specific job.

The columns indicate the following information:

Notes:

• To see additional columns, use the horizontal scroll bar.

• You can remove all the information from the window whenever desired.

Table 12: Description of columns in the Accounting Viewer

Column name Indicates the

Title Original name of the file related to this job (that 
is, without the file extension)

Type Job type

Job Size Job size in MB

Sender User name of the system from which this job 
originated

Started Process Date and time the job first started processing

Processing Time Total amount of time taken processing the job

Started Printing Date and time the job first started printing

Printing Time Total amount of time taken printing the job

Paper Size Size of the media set for the job—for example, 
Letter, A3, A4

Media Type Media type
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Exporting the Accounting Log 
You can save the Accounting information to an ASCII Tab delimited file.

To export the accounting information:

1. In the Accounting Viewer window, click Export.

The Export Accounting window appears.

2. Locate the folder in which to save the report.

3. In the File name box, type a name for the file.

B/W Pages Number of black-and-white pages in the original 
PDL file 

Color Pages Number of color pages in the original PDL file

Blank Pages Number of blank pages in the original PDL file

Purged B/W Pages Number of B/W pages that were already in the 
paper path, and were cleared due to job abort or 
paper jam

Purged Color Pages Number of color pages that were already in the 
paper path, and were cleared due to job abort or 
paper jam

Total Pages Number of pages that were printed

Account string of text that was entered in the Job 
Parameters [optional]

Recipient string of text that was entered in the Job 
Parameters [optional]

Job Comments string of text that was entered in the Job 
Parameters [optional]

Table 12: Description of columns in the Accounting Viewer

Column name Indicates the
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4. Click Export.

The log is saved as a Tab delimited text file in the specified location. 

5. If desired, open the *.txt file in a text editor or in a spreadsheet application—for 
example, Microsoft Excel—and manipulate the data.

You can print the Accounting information (filtered and sorted) to any connected 
printer.

Printing the Accounting Log 
The Accounting log can be printed via the Spire CX260 or directly from the Xerox 
DocuColor 242/252/260 printer/copier.

For the procedure for printing the Accounting log from the Xerox DocuColor 242/
252/260 printer/copier, see Printing Reports on page 114.

To print the accounting log from the Spire CX260:

1. Filter and sort the report as desired.

2. Click Print List.

The Page Setup window appears.

Notes:

• The log includes all the columns (even those that were hidden), listed in 
the original order and sorting.

• To export specific rows, select them before clicking Export. The 
exported log will include only these rows.

• The exported data is not deleted from the Accounting report on the 
Spire CX260 (that is, it will still be displayed in the Job Accounting 
window).

Note:  To print specific rows, use SHIFT or CTRL to select the desired rows. 
The printed report will include only these rows.
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3. Set the printing options as desired and click OK.

The data is printed according to the current filtering and sorting.

Job Ticket Report
The Job Ticket report contains all information from the Job Parameters window 
(including Job Parameters window title bar data). The Job Ticket report presents the 
job parameters on a single sheet and may be exported or printed as a hard copy.

This feature is useful for:

• Updating the Hot-Line service on Job Ticket Report data when a question arises.

• Retaining job parameters when the same job is planned to be re-printed in the 
future.

• Providing the client/customer a follow-up tool regarding printed Job Parameter 
information.

To display the job ticket report:

1. Right-click a job in the Storage window, and from the menu select Job Ticket 
Report.

The Job Ticket Report window appears.

Notes:

• To fit the maximum amount of columns on the page, print using 
Landscape orientation (if your printer supports it).

• The report includes all the columns (including those that were hidden), 
listed in the original order.
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2. You can export or print the report by clicking Print or Export.

The Job Ticket Report is exported as a text file.
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Calibration

Overview
One of the most important issues in obtaining satisfactory print quality is steady 
toner density. Toner density is affected by many factors such as heat, humidity, and 
service settings. You should perform a daily calibration to compensate for these 
factors. 

The calibration process corrects the printer colors by measuring their density and 
creating calibration look-up tables. The Spire CX260 uses the data in these tables to 
compensate for the differences between the actual, measured density level and the 
target level, the target density.

You should perform calibration in the following instances:

• When you use a new paper stock

• At least once during every eight-hour shift for every combination of paper stock 
and screening method used

• When prints show color casts

• After machine maintenance or hardware changes—for example, replacing a 
photoreceptor

• When drastic ambient changes (temperature and humidity) occur 

There are two types of calibration:

• Off-the-glass calibration—this option is available for all Spire CX260 
configurations. For more information, see Off-the-glass Calibration on page 122.

• Calibration using the Eye-One spectrophotometer—this option is available only 
if you have the Pro Basic or Pro Control Station configuration. For more 
information, see Eye-One Spectrophotometer Calibration on page 125.

Off-the-glass Calibration
You can perform Off-the-glass calibration from the Spire CX260 or from the Xerox 
DocuColor 242/252/260 printer/copier’s touch screen using Spire Web Services. 
The section describes the procedures for performing Off-the-glass calibration from 
the Spire CX260. For more information about Spire Web Services, see Spire Web 
Services on page 31.

Important:  Perform a different calibration for every combination of media and 
screen type that you are going to use for printing. When calibrating, always 
use the same media that you intend to use for printing.

Tip:  You can set a reminder to remind you to calibrate the Xerox DocuColor 
242/252/260 printer/copier. For more information, see Calibration Reminder 
on page 172
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It is recommended to perform the following before you start the calibration process. 
Performing these steps will ensure a successful calibration.

• Auto Gradation Adjustment procedure

• Print the auto gradation chart and copy it using the Xerox DocuColor 242/252/
260 printer/copier. Compare the results.

If the results are not similar and there are major differences between the copies, 
perform the printer calibration process. Start the Spire CX260 calibration 
process only when you receive similar printed results.

For more information about the printer calibration process, see the printer user 
documentation.

• Print at least 50 copies of any file to warm up the printer.

To print the Off-the-glass calibration chart:

1. On the Spire CX260, from the Tools menu, select Calibration.

2. In the Calibration window, click Calibrate.

The Calibration Wizard window appears.

3. In the Tray list, select the desired tray. The default is Auto.

It is recommended that you select a specific tray that includes the appropriate 
media type. You can print the calibration chart on any paper size that is equal to 
or larger than A4 or Letter.

4. In the Screening Method list, select the screening method.

5. In the Media Type list, select the media type that you are using for the print job. 
The default setting is Use Printer Settings. When this option is selected, your 
job is printed on the media type that is defined on the Xerox DocuColor 242/
252/260 printer/copier.

6. In the Image Quality list, select the image quality type.

Note:  If you select a media type, the Image Quality parameter settings are 
updated according to the selected media type parameter.
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7. In the Gloss Enhanced list, select Yes only if you want to calibrate for glossy 
printing.

8. In the Number of copies box, enter the number of copies you want to print.

9. Click Print. 

The calibration chart prints.

To calibrate the scanner and printer:

1. On the platen glass of the printer, place the KODAK Gray Scale calibration chart 
and the Off-the-glass calibration chart next to each other, facing down.

2. On the printer’s touch screen, touch All Services.

3. Touch Network Scanning.

4. On the General Settings tab, touch the 001 Calibration scan box.

5. Touch the Image Quality tab.

Tip:  It is recommended that you print at least 25 copies of the calibration 
chart, and then use one of the last copies printed.

Notes:

• The KODAK Gray Scale calibration chart is in the Calibration Chart Kit 
envelope (part #518-00961A). Use only the KODAK Gray Scale 
calibration chart when calibrating the scanner and printer—do not use 
the Scanner Calibration chart, which is also in this envelope.

• If you place only the Gray Scale calibration chart on the platen glass, 
the printer is calibrated. If you place only the Off-the-glass chart on 
the platen glass, the scanner is calibrated. It is recommended that you 
place both the Off-the-glass and Gray Scale calibration charts on the 
platen glass at the same time so that you calibrate both the printer 
and scanner.

• If you need to calibrate a large paper size—for example, A3 or larger—
cut the paper in order to fit the Off-the-glass and Gray Scale 
calibration charts on the platen glass.
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6. Touch the Standard Color Space button to select the specific color space of the 
Xerox DocuColor 242/252/260 printer/copier.

7. Touch the Device Color Space button.

8. Touch Save.

9. On the control panel, push Start to start scanning the charts.

The charts are scanned and measured and a calibration table is created. In the 
Spire CX260 Calibration Wizard, the software informs you whether or not the 
calibration was successful.

10. In the Calibration Wizard, click Finish.

If the calibration process is successful, two calibration tables are generated: 

• Normal: Maintains the gray balance throughout the range of colors in the 
print job file

• Saturated: Is the same as the normal table for 80% of the color range; but 
from that point on, each color has a greater density

To print a job with a calibration table, see Printing a Job with a Calibration Table on 
page 137.

Eye-One Spectrophotometer Calibration

Guidelines for Successful Calibration
To ensure your calibration is as accurate as possible, check the following guidelines 
before you calibrate:

• Ensure that your Eye-One spectrophotometer is connected properly.

• Ensure that your Eye-One spectrophotometer is calibrated.

Note:  This option is only available for the Pro Basic or Pro Control Station 
configurations.
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• To warm up the printer, use any media to print at least 25 duplex sheets of any 
four-color test job.

• Print a reference job and use the same media and screen type on which you will 
print the final job. 

• Prepare the calibration pad to measure the calibration charts. If a calibration pad 
is not available, set a white media, at least 200 gsm, or two sheets of lighter 
paper, on the surface. Read the calibration chart on this surface.

• Set the Spire CX260 emulation method to the method that you will use to print 
the customer job (DeviceLink).

The Calibration Process
The calibration process consists of the following steps (explained in detail in the 
next few sections):

1. Calibrate the Eye-One spectrophotometer, see Eye-One Spectrophotometer 
Calibration on page 125.

2. Load the paper you are going to use for printing in the Xerox DocuColor 242/
252/260 printer/copier.

3. In the Spire CX260 software, from the Tools menu, select Calibration.

4. Click Calibrate to run the Color Calibration Wizard, and to create a calibration 
table.

5. Follow the Color Calibration Wizard steps.

6. Measure the calibration chart.

7. When the calibration is complete, print the job using the calibration table, see 
Printing a Job with a Calibration Table on page 137.

Preparing the Eye-One Spectrophotometer
The Eye-One spectrophotometer is a high-speed color measurement instrument 
that reports dot data.

Perform the following steps before first time use of the Eye-One spectrophotometer:

• Familiarize yourself with the Eye-One Spectrophotometer Operator’s Manual. 

• Connect the Eye-One Spectrophotometer.

• Calibrate the Eye-One Spectrophotometer.

Note:  Make sure that you set the screen type to the one that you are going 
to use to print the job—for example, 200C.

Tip:  Including the specific paper name and screen method in the calibration 
table file name helps you identify the appropriate calibration table in the job 
setup.

You can also use the Eye-One Spectrophotometer Tutorial to learn how to 
use the Eye-One spectrophotometer correctly. To access the tutorial, 
select Tools > Calibration, and then click Calibrate. In Step 1 of the Color 
Calibration wizard, click Device Tutorial - Click & Learn.
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To connect the Eye-One spectrophotometer to the Spire CX260

Connect one end of the Eye-One Spectrophotometer cable to the Spire CX260 
USB port, and connect the other end to the Eye-One Spectrophotometer.

To calibrate the Eye-One Spectrophotometer

Place the spectrophotometer on its plate. It is automatically calibrated.

Setting the Calibration Method on the Spire CX260
By default, the calibration method is set to Off-the-glass calibration. To calibrate 
using the Eye-One spectrophotometer, set the calibration method to use an external 
device.

To set the calibration method:

1. In the Settings window, under Calibration Device, select the Use external 
calibration device check box.

2. Click Save.
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Creating a Calibration Table
1. From the Tools menu, select Calibration.

2. In the Calibration window, click Calibrate.

The Calibration Wizard window appears.

 

The first step in the wizard is Print Calibration Chart. This step enables you to 
detect the point where you start to see toner on the paper. 

3. In the Tray list, select the required input tray.

The default tray setting is Auto. When this option is selected, the wizard looks 
for a tray that contains Letter LEF or A4 LEF paper. If the wizard does not find a 
tray with either of these sizes, an alert appears.

You can print calibration charts on any size paper. Ensure that the required 
paper is in one of the trays, and then select that tray in the wizard.

4. In the Screening Method list, select the desired screening method.

5. In the Media Type list, select the desired paper stock type. The default setting 
is Use Printer Settings, which means that your job is printed on the media type 
that is defined on the Xerox DocuColor 242/252/260 printer/copier.

6. In the Image Quality list, select the desired image quality. The default setting is 
Use Printer Settings.

7. In the Gloss Enhanced list, select Yes to create a glossy finish on the chart.

Tip:  Click the Device Tutorial - Click & Learn icon to display an 
animation of the measurement process and to learn how to use the Eye-
One Spectrophotometer correctly.

Note:  Make sure you set the screening method to the one you are going to 
use to print the job.
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8. Set the number of copies you need by typing the number or using the arrows 
next to the box to select the number.

9. Click Print.

The Start Point Density calibration chart is printed.  

10. Collect the chart(s) from the printer.

Step 2 of the Color Calibration Wizard appears. In this step you scan the start 
point chart so that the wizard can measure each separation and find the point at 
which the toner appears on the paper.

Note:  Since the performance of the Xerox DocuColor 242/252/260 
printer/copier is best after several pages have been printed, it is 
recommended that you print at least 10 copies of the first calibration chart 
and use one of the last copies printed.

Note:  If you selected Automatic as the Screening Method in Step 1 of the 
wizard, the Xerox DocuColor 242/252/260 printer/copier prints two 
charts, an Image Density Calibration chart and a Text/Line Art chart.
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If you selected Automatic as the Screening Method in Step 1 of the wizard, you 
need to calibrate the Spire CX260 using two charts. Step 2 of the Calibration 
Wizard appears as follows:

11. Press and hold the button on the side, and align the head with the cyan arrow’s 
tip. The arrow is to the left of the cyan column on the Image Density Calibration 
chart. Its tip intersects the semi-dotted line.

12. Sweep the Eye-One spectrophotometer across the cyan column.

A check mark appears over the cyan icon and instructions appear for the next 
sweep, this time for the magenta column.

13. After each color sweep, wait for the check mark to appear next to the 
appropriate icon and follow the instructions as listed.

When all of the separation columns have been successfully scanned, a check 
mark appears next to all icons.

Note:  Ensure that the separation columns on the chart are scanned in the 
order they appear in the icons: Cyan > Magenta > Yellow > Black.

Notes:

• If at any stage the scanning has not been completed properly, click 
Reset and scan again.

• If an error occurs while you are scanning the chart, an alert message 
appears. Click OK and re-scan the charts.

• If you selected Automatic as the Screening Method in Step 1 of the 
wizard, repeat steps 11-13 for the Text/Line Art chart.
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Step 3 of the Color Calibration Wizard appears.

14. Select Save as and select the required name for the calibration table. Do one of 
the following:

• Type your own or select one from the list.

• Select As default table (Normal) to save the calibration table as Normal. 

15. Click Finish. 

One calibration table is saved:

• Normal—A table that maintains the gray balance throughout the range of 
colors in the print job file

The Calibration Window
The Calibration window enables you to create and edit calibration tables. You can 
use the Color Calibration Wizard to create a calibration table, or edit an existing 
calibration table. 

The Color Calibration Wizard analyzes the measurements and creates calibration 
tables. Using these tables, the Spire CX260 compensates for the difference between 
the printer’s performance and the required values.

The following calibration look-up tables are provided: 

• None: Applies no calibration table to the job.

Note:  Each time you save a calibration table as default, it is saved twice, 
once as Normal look up table, and once as the Saturated look up table. The 
Spire CX260 automatically overwrites the existing Normal and Saturated 
calibration tables.

Tip:  It is strongly recommended that you include the specific paper name 
and screen method in the calibration table file name. This helps you select 
the correct calibration table in the job setup.
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• SpireNormal: Applies the factory default calibration table. Since this is a default 
look-up table, it cannot be overwritten. 

• SpireSaturated: Applies the factory default saturated calibration table. This 
look-up table applies a darker calibration table in comparison to the 
SpireNormal look-up table. Since this look-up table is a default table, it cannot 
be overwritten. 

• Normal: Initially the Normal look-up table is identical to the SpireNormal look-
up table. This resemblance changes as soon as you calibrate your Spire CX260 
and, at the end of the calibration process, save your calibration table as default. 
Your calibration table is saved as the Normal look-up table. 

• Saturated: Initially the Saturated look-up table is identical to the SpireSaturated 
look-up table. This resemblance changes as soon as you calibrate your Spire 
CX260 and, at the end of the calibration process, save your calibration table as 
default. Your calibration table is saved as the Saturated look-up table. 

To open the Calibration window:

1. From the Tools menu, select Calibration.

The Edit Calibration window appears.

The following options are available:

• Click Calibrate to run the Color Calibration Wizard. This wizard guides you in 
the use of the calibration device to create calibration tables.

• Select a calibration table from the Calibration Name list and select one of the 
following options: 

Note:  Each time you save a calibration table as default, it is saved twice, 
once as Normal look-up table, and once as the Saturated look-up table.

Note:  You can only edit and delete calibration tables if you have the Pro 
Basic or Pro Control Station configuration.
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Click Edit  to edit the calibration table. See Editing Calibration Tables on 
page 133.

Click Delete  to delete the calibration table.

Click Info  for the Density Graph. See Reading Color Density Data on 
page 136.

Click Close to end a test job and close the Calibration window.

Editing Calibration Tables
You can review a calibration table to make sure that the curves are relatively smooth 
and continuous. If you are not satisfied with the results, the Edit option enables you 
to adjust the values of the image in the value table.

To edit a calibration table:

1. From the Tools menu, select Calibration.

2. In the Calibration Name box, select a calibration table, and then click Edit .

The Edit Calibration dialog box appears.

The Edit Calibration dialog box includes the following:

• Screen—If you selected Automatic as the screening method, you can view two 
calibration tables, CT or LW. In the Screen list, select the table you want to view.

• Separation—The graph displays cyan, magenta, yellow, and black separations. 
You can see information about each separation by selecting it from the list. 

• Calibration Graph—The graph shows the values from your calibration table.

The horizontal axis represents the dot percentage values of the RTP file. The 
vertical axis represents the dot percentage values of the final output data (after 
applying the calibration table) that is sent to the printer. 

During printing, the Spire CX260 automatically replaces the CMYK values in the 
RTP file with new values that compensate for the printer’s current performance 
level.
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The graph displays cyan, magenta, yellow, and black separations. You can view 
detailed information about each separation by clicking its button. To view the 
information for all the separations together, click the button that shows all four 

colors .

• Value Table

You can change the separation values by adjusting the File Value and Printer 
Value settings. The table displays some of the dot percentage values shown in 
the graph. You can add, edit, or delete entries in the table. Your changes will be 
displayed immediately in the calibration graph.

To add an entry to the value table:

1. Highlight a row in the value table. The new entry row will appear below this row.

2. Click Add Entry . 

The Add Entry dialog box appears.

3. From the File Value and Printer Value lists, select the desired values.

4. Click OK. 

The value table is updated, and the calibration graph is adjusted.

To delete an entry from the value table:

1. In the value table, highlight the entry to be deleted.

2. Click Delete Entry .

The entry is removed. 

Organizing Calibration Tables
You can use the Save and Save As functions to organize your calibration tables.

To save an existing calibration table:

1. In the Edit Calibration dialog box, adjust calibration table values and parameters 
as desired.

2. Click Save.

The edited calibration table is saved with its original name.

Note:  When you click Save, new calibration settings override previous 
calibration table settings.
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To save a new calibration table:

1. In the Edit Calibration dialog box, adjust calibration table values and parameters 
as desired.

2. Click Save As. 

The Save As dialog box appears.

3. In the File Name box, type the new calibration table name.

4. Click OK. 

The calibration table is saved with the new name. 

5. Click Close to exit the Edit Calibration dialog box.

Backing Up Calibration Tables
1. Locate the ColorCalibrationDB folder. Go to 

C:\CX260\General\ColorCalibration\ColorCalibrationDB.

2. Open the ColorCalibrationDB folder.

3. Copy the desired calibration table files to your back up location. 

Note:  You can’t overwrite the default calibration tables, Spire Normal and 
Spire Saturated.

Note:  To edit a calibration table, select Tools > Calibration > Edit. To view 
information about a calibration table, select Tools > Calibration > Info.
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Reading Color Density Data

To view the Density Graph:

1. In the Calibration window, from the Calibration Name list, select the table for 
which you want to receive detailed color information.

2. Click Info .

The Density Graph window appears. The Density Graph gives you detailed 
information about the saved calibration tables.
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The Density Graph contains the following data:

• Calibration name

• Measured D-Max values for each separation

• Target D-Max values for each separation 

• Minimum accepted density values for each separation (Xerox values) 

• View options: filtering by color - select which colors are shown/hidden

• Calibration curves (target and measured) for each separation

Target is displayed as bold lines

Measured is displayed as thin lines

• Index - emphasizes the difference between target lines and measured lines

• Properties: paperweight, screening, paper coating 

Printing a Job with a Calibration Table
Now that you have calibrated the paper you are going to use for printing, you can 
select the calibration table to print any job on the same paper stock using the same 
screen type. 

You can print the reference job you printed before with the new calibration table to 
evaluate the calibration results.

To print the reference job:

1. In the Spire CX260 workspace, suspend the Process Queue.

2. Import the job.

3. Double-click the job to open the Job Parameters window.

For more information about tabs in the Job Parameters window, see Setting 
Parameters in the Job Parameters Window on page 182.

4. On the Paper Stock tab, select the desired paper stock.

5. On the Color tab, select the calibration you created for the particular stock from 
which you printed. 

6. On the Color tab, select the screening method you used for the selected 
calibration.

7. Set all other desired parameters, and then click Save to close the Job 
Parameters window.

8. Activate the Process Queue and Print Queue, and inspect the printed job.

If you see that the print out has any color imperfection, review the job parameter 
settings and make changes if necessary. If there are still color imperfections, 
perform machine maintenance and repeat the calibration process.

Note:  When the density of the Xerox DocuColor 8000 digital press is 
lower than 80% of the target density, the following message appears: 
“Attention: Below standard D-Max value(s) measured for 
<cyan, magenta, yellow, black>. Standard (Minimum): <C 
- 1.5>, <M - 1.4>, <Y - 0.9>, <K - 1.5>
Measured: <C - >, <M - >, <Y - >, <K - >”.
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Color Tools

Profile Manager

The Profile Manager enables you to import and delete source and destination ICC 
profiles, and map destination profiles to specific paper colors.

Source profiles are used to emulate other devices, or color spaces. You can import 
source CMYK or RGB profiles. To use a profile in a job, in the Job Parameters 
window, select Color > RGB workflow or Color > CMYK workflow > CMYK Profile, 
depending on the profile you imported.

For more information about selecting a source profile in a job, see RGB Workflow on 
page 190 and CMYK Workflow on page 190.

Destination profiles define the color space of your printer and are based on the 
combinations of paper and toner that you are using. For different paper stocks, you 
need different destination profiles. Each custom destination profile will be used with 
coated and uncoated paper. To use a different destination profile in a job, in the Job 
Parameters window, select Color > Destination profile.

For more information about selecting a destination profile in a job, see Destination 
Profile on page 192.

Managing Device Link Profiles

To import a source ICC profile:

1. On the toolbar, click the Resource Center button . 

The Resource Center window opens.

2. In the Resource list, select Profile Manager.

Note:  The Profile Manager is available only if you have one of the Pro 
configurations.
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The Source Profile tab appears, and the predefined source ICC profiles are 
displayed.

3. Click the Import button .

The Import Source ICC Profile dialog box appears.

4. In the Source Profile area, click the browse button . Locate and select the 
required source profile, and then click Open.

The new emulation name is displayed in the Emulation Name box; if you would 
like to change the name you may do so.

5. Click Import.

The new source ICC profile is added to the Emulation (Device Link) list in the 
Job Parameters window, in the CMYK Workflow parameter or to the RGB 
workflow parameter. 

To import a destination ICC profile:

1. In the Resource Center>Profile Manager, click the Destination Profile tab.

The predefined ICC profiles are displayed.
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2. Click the Import button .

The Import Destination ICC Profile dialog box appears.

3. In the Destination profile area, click the browse button . Locate and select 
the required source profile, and then click Select.

The new emulation name is displayed in the Destination Name box; if you 
would like to change the name you may do so.

4. Click Import.

To delete an ICC Profile:

1. In the Resource Center>Profile Manager, select the profile you would like to 
delete.

2. Click the delete button .

The profile is deleted from the profile list.

Spot Color Editor and Workflow
You can use the Spot Color Editor to edit colors in the spot color dictionary and to 
define specific RGB or CYMK colors that you want to protect.

Note:  You cannot delete predefined ICC profiles.
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Editing the Spot Color Dictionary
Individual job pages can contain RGB, CMYK, and spot color elements. The Spire 
CX260 Spot Color Editor enables you to edit the CMYK values of every spot color in 
the Spot dictionary. You can edit these values without affecting the CT or LW page 
elements. The Spot Color Editor also enables you to create custom spot colors and 
to define fixed CMYK values for those spot colors. The Spire CX260 supports HKS 
and PANTONE 2000 spot colors.

To edit an existing PANTONE color:

1. From the Tools menu, select Spot Color Editor.

The Spot Color Editor window appears with the Spire CX260's entire collection 
of colors listed.

2. To find the color that you want to edit, do one of the following:

• Under Color, search for a particular color.

• Alternatively, from the Spot dictionary list, select the color dictionary that 
contains the color that you want to edit.

3. Select the desired spot color. 

The CMYK values for that spot color and a color preview appear in the right-
hand side of the Spot Color Editor window.

Note:  Spot colors—for example PANTONE—are not effected by CMYK 
emulation. A spot color has the same appearance with any selected CMYK 
emulation.

Note:  When you are searching for a color, you can type the first letter of 
the first word in the search box. For example, if you are searching for “Cool 
Gray 4” and type c, the mouse pointer locates the first color in the list that 
begins with the letter c.

Note:  Use the PANTONE CV dictionary if you are working in QuarkXPress 
software.
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4. Change the CMYK values as desired.

5. Click Apply. 

The new spot color is added to the custom color dictionary.

To create a new spot color:

1. In the Spot Color Editor window, click add .

The Spot Editor dialog box appears.

2. Type the new color name as it exists in the PostScript file. 

3. Adjust the CMYK values as required.

4. Click OK. 

The new color is added to the custom dictionary.

To delete a spot color (from the custom dictionary only):

1. From the Spot dictionary list, select Custom Dictionary. 

2. From the list of custom colors, select the color that you want to delete.

3. Click Delete.

The following message appears.

4. Click Yes to delete the spot color.

Protecting Specific Colors

Note:  Spot color names are case-sensitive. Ensure that the new name is 
identical to the name that appears in the DTP software.

Note:  This feature is only available for the Pro Basic and Pro Control Station 
configurations.
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Using the Spot Color Editor, you can protect specific colors—for example, official 
logos or company colors—to help produce color fidelity and color consistency 
between devices. When you define a specific color as an RGB or CMYK spot color 
and enter a fixed CMYK target for it, the Spire CX260 treats it as a spot color, 
protecting it accordingly.

To define an RGB color as a spot color:

1. In the Spot Color Editor window, click the Protect RGB tab.

2. Click add .

3. In the Color name box, type a name for your color.

4. Type the RGB source values and the CMYK target values, or select a spot color 
from the Predefined Spot list.

5. Click Save.

6. On the Protect RGB tab, select the color.

The color information appears.

Note:  The RGB spot workflow applies only to LW elements.
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7. If necessary, in the Corrected column, adjust the CMYK values.

8. Click Apply.

To define a grayscale color as a spot color:

1. In the Spot Color Editor window, click the Protect Gray tab.

2. Click add .

3. In the Protect Gray dialog box, in the Color name box, type a name for your 
color.

4. Enter the Gray source value or select a spot color from the Predefined Spot list.

5. Click Save.

6. On the Protect Gray tab, select the color.

7. If necessary, in the Corrected column, adjust the CMYK values.

8. Click Apply.
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To define a CMYK color as a spot color:

1. In the Spot Color Editor window, click the Protect CMYK tab.

2. Click add .

3. In the Protect CMYK dialog box, in the Color name box, type a name for your 
color.

4. Enter the CMYK source values or select a spot color from the Predefined Spot 
list.

5. Click Save.

6. On the Protect CMYK tab, select the color.

7. If necessary, in the Corrected column, adjust the CMYK values.

8. Click Apply.

Gradation Tool
Sometimes you need to perform tone corrections when printing a job. These 
changes in gradation can include brightness, contrast, and color balance 
adjustments throughout the tone range of an entire image, or in specific tone ranges. 

Gradation tables you create using the Gradation tool are added to the gradations list 
in the Color tab, and may be applied to print jobs. The Spire CX260 also enables you 
to visually check the effect of different gradation adjustments on RTP jobs prior to 
printing.

With the Spire CX260 Gradation tool, you can apply the default gradation table or 
another pre-configured gradation table to a job. You can also edit an existing table 
and save your changes. Gradation is an interactive function and changes are 
automatically applied to the displayed image.

The Gradation tool is used to create and edit gradation tables and to check the effect 
of different gradation adjustments on specific RTP jobs. These tables can then be 
applied to your jobs during job processing for tailored gradations.

Note:  You can edit an existing gradation table, but you can not overwrite the 
default gradation table, DefaultGradTable.
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To open the Gradation tool:

From the Tools menu, select Gradation.

The Gradation Tool dialog box appears.

Preview 

To preview a job:

1. Click Browse to select a job for display in the Preview window. 

The Processed Jobs window appears. The jobs that are displayed are the RTP 
jobs listed in the Storage window.

2. Select the job you wish to preview, and then click Open.

The job appears in the Gradation dialog box.

Notes:

• Gradation is an interactive function. Gradation changes are automatically 
applied to the displayed image.

• The gradation table created is not automatically applied to the previewed 
job. You must use job parameters to assign a gradation table to a job.
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Editing Gradation Tables
When you open the Gradation Tool window, the default gradation table, 
DefaultTable, is selected in the Gradation Table list, and is displayed in the graph. 
This table serves as a baseline and consists of a 45° gradation curve, with Brightness 
and Contrast set to 0, and Contrast Center set to 50. All of the color separations are 
selected.

Gradation tables that you create also appear in the Gradation Table list. When you 
select a gradation table, the predefined settings are immediately applied to the 
processed job that you are working with.

The separations buttons enable you to select one, all, or any combination of 
separations to edit for a specific gradation table. Selecting a specific separation 
enables you to change the color balance for a specific tonal range.

When you open the Gradations Tool window, all of the separations are selected.

1. Click the All Colors button  to edit all the separations simultaneously.

2. Click the individual separations you wish to edit—for example, select the cyan 
separation only.

3. Click the curve in the graph to add a point, and then drag the point to modify 
the separation. When you select a point, its value appears in the Input or 
Output boxes.

The Input axis represents the tone values of the image before gradation 
changes. The Output axis represents the tone values of the image after 
gradation changes.

4. To view gradation changes in your job, click Refresh. Changes are automatically 
applied to the displayed image in the After view.

5. To remove a point on the curve, select the point and then click Remove.

6. To reset the gradation curve to a 45° curve, click the Reset button .

7. To revert to the original gradation settings, click Revert.

8. To remove the last change you made to the gradation graph, click Undo.

Creating a New Gradation Table
1. In the Gradation Tool window, modify your gradation table as required.

2. Click the Save button . 
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3. In the Table name box, type the required name for the new gradation table, and 
click OK. 

The gradation table is saved and added to the Gradation Table list and to the 
Color tab in the job parameters window.

Deleting a Gradation Table
Select the gradation table in the Gradation Table list, and then click the Remove 

button .

Navigation Buttons

The navigation buttons enable you to select a specific booklet or page to view, and 
to browse the pages of the current job. 

Note:  You cannot delete the predefined gradation table.
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Using the Preview Tools
The preview buttons enable you to switch the display mode in the original and 
edited views.

Table 13: Preview Buttons

This button: Enables you to:

Pan

View a different area of the image

Eye Dropper

Find out the CMYK values of a specific area on 
the page. To find the values, first click the Eye 
dropper button. Then move the pointer to the 
point on the page where you want to measure 
the color values and click. The CMYK values 
appear as a tool tip.

Zoom In

Magnify the selected area of the page

Zoom Out

Reduce the size of the selected area by 50%

One to One Zoom

View the actual size of the page one to one 
(1:1)

Fit to Screen

Scale the page to fit the available screen space

View the image at different preset levels of 
magnification by selecting a percentage in the 
list

Rotate View

Rotate the page by 90°, 180° and 270°

Show/Hide 
Separation

Turn on or off one or more separations

Before/After view

Toggle between the Before and After views
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Brightness and Contrast Slider Controls
The Brightness and Contrast slider controls are active only when all of the 
separations are selected.

Brightness

Brightness increases or decreases the luminance of the image. Increasing brightness 
brightens the image and results in a concave curve. Decreasing brightness darkens 
the image and results in a convex curve. 

Move the Brightness slider to the right to increase brightness or to the left to 
decrease brightness.

Contrast

Contrast increases the image contrast by making the highlights lighter and the 
shadows darker. It can also be used to decrease the contrast.

Move the Contrast slider to the right to increase contrast (S shaped curve), or to 
the left to decrease contrast (inverted S shaped curve).

Contrast Center

Contrast increases the image contrast mainly in the midtones. Using Contrast 
Center, you can adjust where the contrast is increased. To enhance contrast in 
highlights, the Contrast Center is shifted toward the highlights. To enhance contrast 
in shadows, the Contrast Center is shifted toward the shadows.

Set the image contrast, by adjusting the Contrast slider.

Your change affects the gradation graph by moving the point where the curve 
changes from convex to concave.

Before/After view

View the Before and After views in portrait

Before/After view

View the Before and After views in landscape

This button: Enables you to:

Note:  Contrast Center only affects the image if Contrast has also been 
adjusted.
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Organizing Gradation Tables
The Gradation window provides a number of options for organizing gradation tables, 
including Reset, Save, Delete and Save As.

If you work only with the default gradation table, the Reset and Save As options are 
activated. This option enables you to use the default gradation table as a base on 
which to build and save new gradation tables. When you work on gradation tables 
other than the default table, Save and Delete are also active.

To reset all Gradation window settings, click Reset. 

The gradation curve is reset to a 45° line. 

To delete the selected gradation table, click Delete. 

To save the specified gradation settings, click Save.

To create new gradation tables by saving existing gradation tables with new 
names, click Save As.

Note:  You can not delete the DefaultGradTable.

Note:  You can only save the default gradation table under a new name.



152 Chapter 6 – Color Workflow



System Administration

Setting Up and Configuring the Spire CX260 .............................................. 154

System Messages.................................................................................................177



154 Chapter 7 – System Administration

Setting Up and Configuring the Spire CX260
Basic system configuration and settings are defined in the Spire CX260 Settings 
window.

To open the Settings window, from the Tools menu select Settings.

The settings are divided into two lists; Administration and Preferences. Both lists 
are explained in the following sections.

All items in the Settings window are view-only to Guest users. Items in the 
Administration list can only be changed by users of Administrator level. Items in the 
Preferences list can only be changed by users of Administrator and Operator levels. 

Server Setup
Set the server’s name and the current date and time in Server Setup.

Changing the Server Name
1. In the Settings window, select Server Setup.

2. In the Server Name area, click Change.

The System Properties dialog box appears.

Note:  The System Properties dialog box appears differently, according to 
server type.
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3. In the Computer Name tab, click Change.

The Computer Name Changes dialog box appears.

4. In the Computer Name box, type a new name for the computer. 

5. If you want to change the Workgroup or the Domain in which your computer 
appears, select the desired option and type a new name in the corresponding 
box.

6. Click OK.

7. Click OK in the System Properties window.

The system prompts you to reboot your computer for the new settings to take 
effect. 

8. Click No if you want to change other system parameters, or click Yes and 
reboot your computer.

Note:  Do not change the workgroup or domain unless you are instructed 
to do so.

Important:  If you want to change the domain, you will be required to type 
the password for the domain account. If the password is unavailable, the 
computer will be locked.
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Changing the Date and Time
1. In the Settings window, select Server Setup.

2. In the Date & Time area, click Change.

The Date/Time Properties dialog box appears.

3. In the Date & Time tab, select your local time settings.

4. Select the Time Zone tab and set the correct time zone.

5. Click OK.

Network Setup
The IPX Printing settings, TCP/IP settings and the Apple Talk settings are set in the 
Network Setup parameter.
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IPX Printing
IPX Printing enables the Spire CX260 to act as a job server for the Novell queue. A 
job server checks each assigned queue at a specified interval, taking care of jobs on 
a first-in, first-out basis. Once a job is processed, its associated file is deleted from 
the queue directory.

1. In the Settings window, select Network Setup.

2. In the IPX Printing area, click Change Settings next to the Tree parameter.

The Local Area Connection Properties dialog box appears, followed by the 
NWLink IPX/SPX Properties dialog box.

3. To change the frame type, select a frame type from the Frame type list, then 
click OK.

Note:  IPX Printing works in a Novell environment.



158 Chapter 7 – System Administration

4. Click OK also in the Local Area Connection Properties window.

You are prompted to restart your computer. 

5. Click No if you need to make more changes, or Yes to reboot.

TCP/IP Setup
The Spire CX260 is predefined with a default IP address. The TCP/IP option enables 
you to change this IP address and other TCP/IP settings.

To change the TCP/IP network settings:

1. In the Settings window, select Network Setup.

2. In the TCP/IP area, click Change Settings next to the IP Address parameter.

The Local Area Connection Properties dialog box appears, followed by the 
Internet Protocol (TCP/IP) Properties dialog box.

3. Change the IP Address by selecting Obtain an IP address automatically.
Or:
Select Use the following IP address and type the desired address—for 
example, IP address:192.168.62.1 and Subnet mask:255.255.255.0.

4. Click OK.

5. Click OK in the Local Area Connection Properties window.

You are prompted to restart your computer. 

6. Click No if you need to make more changes, or Yes to reboot.

Note:  Using this procedure requires further setup by the network 
administrator.

Note:  Before changing the network settings, consult your System 
Administrator.
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Apple Talk Setup
The AppleTalk Setup utility enables you to change the AppleTalk zone in which your 
Spire CX260 is located.

To change the Apple Talk network settings:

1. In the Settings window, select Network Setup.

2. In the Apple Talk Setup area, click Change Settings next to the The System will 
appear in zone parameter.

The Local Area Connection Properties dialog box appears, followed by the 
AppleTalk Protocol Properties dialog box.

3. From the zone list, select the desired AppleTalk zone for your computer, and 
click OK.

Remote Tools Setup

Web Connect Setup
The Web connect setup enables clients to connect to the Spire CX260 over the 
network by using the Spire Web Center. This option is disabled by default.
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For more information about viewing and monitoring your jobs from a client 
workstation, see Working Remotely on page 24.

To enable the Web Viewer:

1. In the Settings window, select Remote Tools Setup.

2. In the Web connect setup area, select the Enable WebViewer check box to 
connect to the Spire CX260 using the Spire Web Center.

Remote Workspace Setup
The Remote Workspace setup enables you to use the EZ Connect and Remote 
Workspace tools on client workstations. These tools enable you to view the status 
of the Xerox DocuColor 242/252/260 printer/copier and access the Spire CX260 
workspace.

For more information about the EZ Connect tool see Working Remotely on page 24. 
For more information about the Remote Workspace tool, see Remote Workspace on 
page 29.

To enable the remote connection:

1. In the Settings window, select Remote Tools Setup.

2. In the Remote Workspace Setup area, select the Enable remote connection 
check box.

The Connection status shows how many clients are currently connected to the 
Spire CX260.

3. Select the number of hours in the Logoff Automatically after list to 
automatically log off client workstations after the desired number of hours.

4. Click the Remote Connections Viewer to view which clients are currently 
connected to the Spire CX260.
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Security

User Passwords
For security, you can set passwords for users for when they log in to the Spire 
CX260.

To set Password settings:

1. In the Settings window, select Security.

2. Select Auto Log On to enable users to log on automatically.

3. Select Disable Guest Connection to prevent Guest users from accessing the 
Spire CX260.

To change Administrator/Operator passwords:

1. In the Settings window, select Security.

2. In the Administrator/Operator area, enter the old password.

3. Enter the new password.

4. Verify the new password.

Note:  These passwords do not apply to the Remote Desktop Application. For 
more information on the Remote Desktop Application, see Working from the 
Remote Desktop Application on page 86.

Note:  When you enable Auto Log On, all other options in the Passwords area 
are unavailable.
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5. Click Apply and Save in the Settings window.

The password is changed and the Settings window closes.

Disk Wipe
Usually when you delete a file, the file’s dictionary entry is removed but data still 
remains on the disk. The Disk Wipe utility enables you to clear previously deleted 
files. The utility eliminates the contents of your deleted files by scanning all of the 
empty sectors on the disk and replacing them with zeros. Nonempty sectors are left 
untouched. This feature enables you to work in a more secure environment. If there 
is a system shutdown, the disk wipe operation can begin immediately.

To operate the Spire Disk Wipe utility:

1. In the Settings window, select Security.

2. To enable the disk wipe feature, select Wipe disk on system shutdown.

3. Click Save.

4. Exit the Spire CX260 application.

Notes:

• The disk wipe operation does not function well when the Norton Utilities 
application is installed. Before you activate the Disk Wipe utility, make sure 
that Norton Utilities is not installed on the Spire CX260.

• In rare cases, the process of deleting files from the Storage window is not 
completed—for example, the system shuts down before the deletion process 
is completed. When this happens, parts of the deleted files still reside in the 
D\:Output folder. Therefore, it is recommended that before you start the 
disk wipe operation, check the D\:Output folder to ensure that all the 
relevant files were deleted.

• The Disk Wipe utility affects the user disk and printer disk.

• Do not operate the Disk Wipe utility while another application is running.

• The supported language is English.
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System Disks

When the Printer or User Disks reach a pre-defined threshold of minimum available 
space (the default is 250 MB), RIP is suspended and the system provides a warning 
message. The RIP will resume automatically only after disk space is available. 

1. In the Settings window, select System Disks.

2. To set the system disks threshold, in the System disks area, set the minimum 
free disk space desired for RIP.

Backing up the Configuration

You can back up the Spire CX260 configuration to a local hard disk, network drive, 
or external media—for example, an external zip drive—connected to the Spire 
CX260.
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Configuration Backup

To backup the configuration of your Spire CX260:

1. In the Settings window, select Configuration Backup.

2. In the Configuration Backup area, click Browse.

The Save window appears.

3. Browse to the desired directory path for the backup, and type a file name.

4. Click Save.

5. In the Settings window, click Start Backup.

6. When the backup procedure has been completed, the following dialog box 
appears:

7. Click OK.

Note:  You can also backup to an external media.

Note:  The last path will be saved and displayed to the path box. If the 
backup was made to an external media, the displayed path will be the 
default: C:/CX260/General/Configuration.
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Configuration Restore

To restore the configuration of your Spire CX260:

1. In the Settings window, select Configuration Backup.

2. In the Restore Configuration area, click Browse and locate a different directory 
path in which to restore the configuration. 

3. Click Start Restore.

The Restore Configuration window appears.

4. Select the categories you want to restore, and click OK.

5. Click Yes if you would like the restored files to replace the current ones. Click 
No if you do not want the restored files to replace the existing files.

If you selected Yes, the following message appears:

6. Click OK.

Your changes will take effect once you have restarted the Spire CX260.

Notes:

• The configuration file name will always be SpireConf (CNF file).

• You may also restore the configuration from an external media.

Note:  When restoring the configuration all the custom tables or sets are 
added to the system for example—new virtual printers, downloaded fonts 
and so on.

Note:  The Restore Configuration date is updated in the Configuration 
Backup window.
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Calibration Device

1. In the Settings window, select Calibration Device.

2. In the Calibration Device area, select the Use external calibration device check 
box if you want to calibrate using the Eye-One spectrophotometer.

Mail Service

Note:  This parameter is available only if you have one of the Pro 
configurations.
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Set Mail Service options to receive and send scanned jobs directly to one or more 
e-mail addresses.

To set Mail Service options:

1. In the Settings window, select Mail Service.

2. In the Outgoing mail server box, type your outgoing mail server. Usually, you 
can obtain this from your site administrator or IT department.

3. In the Attachment max size list, select the maximum size for scanned jobs that 
will be attached to an e-mail message.

4. In the Administrator E-mail address box, type the e-mail address that will 
receive any returned e-mail messages.

5. Under Authentication level, select either Anonymous or Basic. If you select 
Basic, you will need to enter a user ID and password.

Localization
Set the locally-used unit measurements and language in the Localization parameter.

Setting the Localization Measurement
1. In the Settings window, select Localization.

2. In the Units area, select Millimeters or Inches, as desired.

Important:  To make sure your outgoing mail service is enabled on the Spire 
CX260, verify that the anti-virus software rules allow for mailing. For example, 
in Mcafee VirusScan Console, under Access Protection Properties, on the 
Port Blocking tab, clear the Prevent mass mailing worms from sending 
mail check box and click OK.

Note:  The maximum size for an e-mail attachment is 10 MB.
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Setting the Language
1. In the Settings window, select Localization.

2. In the Language area, select the language, as desired.

Pre-RIP Preview

1. In the Settings window, select Pre-RIP Preview.

2. In the PS preview area, select one of the following options: 

• Save file as PDF: closes the Adobe Acrobat preview and saves the file as a 
PDF

• Return to the original PS file: closes the Adobe Acrobat preview but does 
not save the file

3. In the VI Job Preview area, select the desired number of booklets for pre-RIP 
preview.

Note:  If you switch to another language, you need to restart the Spire CX260 
application.
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General Defaults

1. In the Settings window, select General Defaults.

2. In the Default Trim Size area, select the Size.

3. Select the desired OPI setting to specify how an external high-resolution image 
is placed in a PostScript file as it goes to RIP.

If you select Enable OPI Spire Support, the Support Helios Server check box is 
automatically selected. If you do not want Helios server support, clear this 
check box.

4. Select the Default archive path.

For more information on the default archive path, see Archiving and Retrieving 
Jobs on page 64.

5. In the Test Page area, select Enable to set a test page to be printed every time 
the Spire CX260 is restarted or powered on.

6. In the Job Title Recognition area, select one of the following options:

• Use PostScript Internal name: select this option to use the internal file 
name as written inside the PostScript file by the print driver.

• Use files name (Use when Printing via LPR): select this option to use the 
job’s given file name. Selecting this option ensures that the job appears in 
the Spire CX260 with the name last given by the user.

Printing Modes
You can set the Spire CX260 to automatically select the best finishing option for 
your job when the finishing option you want is unavailable.
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1. In the Settings window, select Printing Modes.

2. In the Printing Policy area, select Print job to best finishing option available.

Print Queue Manager
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Job batching
The job batching utility enables you to print several jobs with the same settings in a 
batch without cycle down between jobs, which saves production time.

1. In the Settings window, select Print Queue Manager.

2. Select one of the following options:

• Enable job batching to print jobs with the same page parameters, one after 
the other without the cycle down.

• Disable job batching to disable the printing of jobs with the same page 
orientation, one after the other, and enable cycle down.

For more information about job batching, see Batching Jobs on page 55.

Held jobs
1. In the Settings window, select Print Queue Manager.

2. In the Held jobs policy area, select the Hold jobs with missing resources check 
box and specify one of the following options:

• Bypass held jobs to bypass frozen jobs in the Print queue.

• Don’t Bypass held jobs to stop the printing from the queue when a job is 
assigned a frozen status.

Color
Note:  This parameter is available only if you have one of the Pro 
configurations.
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Automatic Screening
The Spire CX260 supports Dot and Stochastic screening. When you print a job from 
the Spire CX260, select the automatic screening method. By default, automatic 
screening applies two types of screen:

• For text or line-art elements (line work), the system uses line type screen of 
200C.

• For continuous tone (CT), the system uses dot type screen of 200C.

To change the values of the automatic screening method:

1. In the Settings window, select Color.

2. Select the required setting for LW from the LW list.

3. Select the required setting for CT from the CT list.

You are prompted to restart the application for the new settings to take effect.

Calibration Reminder
Set the Calibration Reminder to remind you when to perform a calibration.

1. In the Settings window, select Color.

2. In the Calibration Reminder area, select the Set calibration reminder every 
(hours) check box and select the number of hours in the list.

The calibration reminder indicator appears when it is time to calibrate.

Messages

Accounting Log Setup
By default, all the jobs that were handled during the past 90 days are listed in the 
Spire CX260 Accounting window. This utility enables you to specify different values 
for how long information remains before being overwritten.
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To setup the accounting log:

1. In the Settings window, select Messages.

2. In the Accounting log setup area, select the desired value to Overwrite 
messages after. 

3. To remove all the existing information from the windows, whenever desired, 
click Clear Log Now.

For more information about the Accounting window, see Job Accounting on 
page 114.

Message Viewer Log Setup
By default, all the jobs that were handled during the past 56 days are listed in the 
Spire CX260 Message Viewer. This utility enables you to specify different values for 
how long information remains before being overwritten.

To setup the message viewer log:

1. In the Settings window, select Messages.

2. In the Message viewer log setup area, select the desired value to Overwrite 
messages after. 

3. To remove all the existing information from the windows, click Clear Log Now.

For more information about the Message Viewer, see The Message Viewer on 
page 179.

View Configuration
The View Configuration utility enables you to view the configuration of your Spire 
CX260 and to print it to any printer on the network connected to your Spire CX260. 
In addition you can save the configuration in the network or export it to an external 
media as a text file.
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To print your configuration:

1. In the Settings window, select View Configuration.

2. Click Print.

The Page Setup dialog box appears.

3. Set the printing options as desired and click OK.

The Print dialog box appears.

4. From the Printer list, select a printer and click OK.

To export your configuration:

1. Click Export.

The Save window appears.

2. Locate the desired folder, and click Save.

JDF Outputs
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The Spire CX260 receives the JDF job ticket via hot folders, returns JDF output with 
job accounting information, and submits JMF (Job Messaging Format) signals with 
the job's status. 

If the JDF job has a target path specified in the job, JDF output is always created. For 
JDF jobs that don’t have a specified target path, the JDF output is only created if this 
option is selected in the Settings window. 

1. In the Settings window, select JDF Outputs.

2. Select Create JDF Outputs to create JDF output.

3. In the Target Path box, enter the target path, or click Browse to browse to the 
desired directory path for the JDF output.

Scan

Automatic Job Deletion
1. In the Settings window, select Scan.

2. In the Automatic job deletion area, select the number of days in the Delete 
scan jobs after list.

To delete scanned jobs:

In the Automatic job deletion area, click Delete Now.

Remote Access
Using the remote scan application, you can enable remote scanning for all users or 
Administrators only.
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To enable remote access:

1. In the Settings window, select Scan.

2. In the Remote Access area, select the Enable Remote Scan Application 
connections check box.

3. Select your choice for ScanBox Manager access control:

• All users

• Administrator only

Storage Management

Automatic Job Deletion
Set the time interval (in days or hours) for automatically deleting stored jobs.

To set automatic job deletion:

1. In the Settings window, select Storage Management.

2. In the Automatic job deletion area, do one of the following:

• Select the number of days after which stored jobs are automatically deleted.

• Select the number of hours after which stored jobs are automatically 
deleted.

Frozen Jobs
Set the time interval (in hours) for automatically deleting frozen jobs.

1. In the Settings window, select Storage Management.

2. In the Frozen jobs area, select the number of hours after which frozen jobs are 
automatically deleted.
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System Messages
While jobs are being handled by the Spire CX260, various messages are emitted. 
You can view the messages of each job in the Job History window, of the entire 
session in the Message Viewer window, or just the error messages within the Alerts 
window.

The Alerts Window
By default, the Alerts window is open in the Spire CX260 workspace. In the Alerts 
window, you can choose to display: 

• Job alerts

• System alerts

• Both job and system alerts

When you select one or more jobs, any error messages that are generated during 
the workflow of those jobs are displayed in the Alerts window. 

If you choose to display system alerts, any time the system emits an error message, 
the message appears in the Alerts window.

To display the Alerts window:

From the View menu, select Alerts.

The Alerts window appears.

To display job alerts:

1. Select the desired job(s).

2. In the Alerts window, click the Show job alerts  button.

To display system alerts:

In the Alerts window, click the Show system alerts  button.

Job alerts are associated with the specific job. When a job is deleted, the associated 
job alerts are also deleted and removed from the Alerts queue.

Note:  By default, new messages are shown at the top of the list. For each 
message, the origin of the message is indicated, and a task that will solve 
the problem is suggested.
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System Disks Threshold Message
When the Printer or User Disks reach a pre-defined minimum available space 
threshold (usually of 250 MB), RIP is suspended and the system provides a warning 
message. The RIP resumes automatically only after disk space is available. In this 
case, you may increase the System Disk threshold.

For more information about setting the system disks threshold, see System Disks on 
page 163.

Job History

To view the job history:

Right-click a job in the Queues or Storage window, and from the menu select Job 
History.

The Job History window appears, listing all the messages that were generated 
during the workflow of the selected job.

For information on the messages display, see Managing Messages on page 179.
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The Message Viewer

To open the Message Viewer:

At any stage of work, from the Tools menu, select Message Viewer.

The Message Viewer window appears, listing all the messages that were 
generated during the workflow.

For more information about viewing messages related to a specific job, see Job 
History on page 178.

By default, all the jobs that were handled during the last 56 days are listed.

The default may be changed in the Settings window under Messages. For more 
information about changing the default setting, see Messages on page 172.

Managing Messages
You can filter the messages by type, or sort the list by one of the column headers. In 
addition, you can print the list of messages.

If desired, you may reorder and resize columns, filter the list or sort the list by one of 
its column headers.

Filtering the Messages by Type

Each message in the Message Viewer and Job History window is assigned an icon to 
denote the message type:

By default, all message types are listed in the Message Viewer. You can filter the list 
in order to view only messages of certain types. 

Notes:

• This section is relevant for the Message Viewer and Job History windows (but 
not for the Alerts window).

• These settings are retained after closing a window.

Information

Warning

Error

Note:  If the message type is not selected, messages of this type do not 
appear in the list.
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Click any message type icon—for example, Error— in order not to list such 
messages.

The list updates accordingly.

To print the message list:

1. Filter and sort the list as desired (the data is printed according to the current 
filtering and sorting).

2. Click Print List.

The Print window is displayed.

3. Set the printing options as desired, and then click OK.
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Setting Parameters in the Job Parameters Window
This section describes the Job Parameters window, and explains how to set the job 
parameters.

For more information about opening the Job Parameters window, see The Job 
Parameters Window on page 70.

The Print Settings Tab

Number of Copies
Type the number of copies to be printed.

Print Range 
Select the desired print range.

To select specific pages, booklets or page ranges, select Pages/Booklets and 
specify the pages or booklets to be printed as follows:

Type one or several numbers separated by commas and no spaces. For 
example—1,3,5.

Type a range of pages or booklets with a hyphen between the starting and 
ending numbers in the range. For example—1-5.

Note:  For imposed jobs, instead of typing the desired pages, you should 
type the desired imposed sheets.
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Print Method
Select one of the following options:

Simplex: for single-sided printing

Duplex Head to Toe: for calendar-style hard copies (usually used with 
landscape jobs)

Duplex Head to Head: for book-style hard copies (usually used with portrait 
jobs)

Print Mode

In the Print Mode area, select the desired print mode:

Composite (default setting): prints the job without separations. Each page of 
the job is printed once.

Separations: prints the job with color or grayscale separations. If you select 
color separations, each page in the job is printed separately in four colors: 
cyan, magenta, yellow, and black. If you select grayscale, each page in the job 
is printed separately four times in different shades of grayscale (K).

Progressive: prints each page of the job four times in progressive color 
separations:

Sheet 1 is printed only in C.

Sheet 2 is printed in C and M.

Sheet 3 is printed in C, M, and Y.

Sheet 4 is printed in C, M, Y, and K.

Note:  This feature is only available for the Pro Basic and Pro Control Station 
configurations.
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Custom: enables you to select the separations that you want to print for each 
sheet for each page of the job.

Print Order
Set the print order to From 1 to N (front to back) or From N to 1 (back to front).

Delivery
Select Face up or Face down as the delivery option.

Collation
Select the Collation option:

Yes: prints a complete copy of the job before the first page of the next copy 
prints

No: prints all copies of each page before going on to the next page

Image Position
This parameter enables you to change the location of the entire printed image on the 
sheet (simplex or duplex).

Image position uses the following terminology: 

• Rear: the edge of a sheet at which printing stops, near the rear of the printer

• Lead: the edge of a sheet at which printing begins

Note:  To collate a document and print the set in the correct order, select Face 
Down and From N to 1, or Face up and From 1 to N.
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The page’s lead and rear edges are determined just after the page is printed out, 
before making any change in page orientation.

Select one of the following:

To print your job in the center of the page, click Center

To set page offsets, click the directional arrows or type Rear and Lead values

To apply page offset values to both odd and even pages, select the Same on 
both sides check box.

Image Scale
Perform one of the following:

To print the image original size, select 100% (default)

To fit the image to the selected paper size, select Fit to Paper

To custom size the image, select Custom and type the percent by which you 
would like to proportionally increase or decrease the image size

Rotate 180
In the Rotate options area, select the desired options:

Select Rotate 180 to rotate your job by 180°.

Select Mirror to flip an image—for example, when printing on transfer paper 
for t-shirt production.

Gallop

Gallop enables the job to start printing before the entire job is RIPed. 

Select Yes and type the number of pages to RIP before printing starts.

Tip:  Use this option to move duplex page data away from the spine.

Note:  This feature is only available for the Pro Basic and Pro Control Station 
configurations.
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The Paper Stock Tab

 

Paper Size
From the Size list, select the desired stock size. If you select Custom:

a. Type the desired height and width. 

b. Select the desired feed direction:

• LEF (Long Edge Feed)

• SEF (Short Edge Feed)

Tray
In the Tray list, select the desired tray, and load the specific stock in this tray. If 
you select Auto, any tray with the specific paper stock is used. 

Mixed Paper Size
Select the Mixed paper size document check box if the job contains different 
paper sizes.

Media Type
1. In the Media Type list, select the desired media.

Note:  Make sure that the paper in the selected tray complies with all the other 
paper stock parameters. If the paper in the tray does not match all the paper 
stock parameters, the job is frozen.

Tip:  If you selected Transparency, select the Add interleave check box 
to insert a blank page between each transparency. To customize the 
interleave, select a different paper size, media type, or tray from the 
appropriate lists.



Setting Parameters in the Job Parameters Window 187

2. In the Image Quality list, select the attributes of the media. The options vary 
according to the media that you selected in the Media Type list.

3. To create a glossy finish on the job pages, select Gloss Enhanced.

4. To print the second side of each page in a manual duplex workflow, select Side-
2 printing.

Tray Alignment
Select the Use tray alignment settings check box to use the settings as defined 
in the Tray Alignment Wizard.

The Print Quality Tab

Text /Line Quality
The Text/Line quality parameter improves text quality. Text/line quality and text 
and line-art elements are processed separately to produce optimal rendering of all 
the elements on a page. This option improves the text quality of diagonal lines, 
borders, and blends; causes blends to appear smooth with no banding; and displays 
crisp diagonal lines without (or with minimal) jaggies (rough edges) which are the 
result of the limited resolution of the print engine.

1. Select High to improve the text quality.

2. In the Enhance area, select the elements you want to enhance:

• Overlapping elements improves the edge quality of overlapping vector and 
image elements—for example, text on top of a transparent image

Note:  Side-2 printing is not supported for all media types.

Note:  If you select Overlapping elements, the corresponding 
enhancement is automatically selected in the Image Quality 
parameter.
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• Text/Line in images improves the resolution of text and line-art in images—
for example, scanned images or screen captures

Image Quality
The Image quality parameter controls the ability to maintain the same detail and 
smoothness at different degrees of enlargement. This feature is especially useful 
when your PostScript file includes several images of different qualities—for 
example, images that were scanned at different resolutions, were rotated, or were 
downloaded from the Internet.

1. Select High to improve the quality of images in a job.

2. In the Enhance area, select the Graphics check box to improve the quality of 
overlapping vector and image elements.

Trapping
Trapping is a solution that solves misregistration between color separations in both 
offset and digital printing. Misregistration occurs regardless of the accuracy of the 
printing device and results in white lines around objects on top of a background (in 
a knock-out procedure) and also between adjacent colors. Trapping extracts the 
element or the background in order to create an overlap between them. 

1. To set trapping, select Yes.

2. In the Frame Thickness box, select the default (0.08mm) for the thickness of 
the trapping frame, or type the desired value. The thicker the frame, the less 
chance that white areas appear will between images.

3. Do one of the following actions:

• Select the Protect Small Text check box to prevent the trapping of any text 
that is 12 points or smaller.

• Clear the Protect Small Text check box to trap all text elements.

Black Overprint
Select Yes to ensure that black text prints cleanly within a tint or picture area.

The text appears in a richer, deeper black, with the underlying CMY values equal to 
those of the printed background. 

Note:  When you select High, the processing speed is decreased.

Notes:

• If you select Yes, the Frame Thickness and Protect Small Text 
options are activated. You cannot select these options in the PPD file.

• If you select No, trapping incorporated by DTP applications (for example, 
Photoshop®) are not affected. Creo Full Auto Frame trapping software 
(FAF) should not be used with application-based trapping. In a PostScript 
file that already contains trapping from the originating application, it is 
not necessary to use Spire CX260 trapping.

Tip:  Apply the Protect Small Text option to small or complex images to 
ensure their quality is not decreased.
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PS Overprint
Select Yes to use the overprint information in the Postscript file.

This parameter also determines whether the DTP application overprint settings are 
honored in the RIP. 

The Color Tab
The Color tab provides you with tone compression tools such as brightness, 
contrast, and gradation, as well as color tools, including rendering intent, ink saving, 
and RGB and CMYK workflows. In addition, you can select various screening 
methods for your job.

The Spire CX260 accepts the following color formats:

• RGB

• CMYK

• L* a* b*

• Spot color

• Grayscale

• Duotone

Note:  If you change any of the Destination, Rendering Intent, Emulation, 
RGB Workflow, or Spot Color Editor settings in your RTP job, the Spire 
CX260 re-RIPs your job. If you do not wish your job to be re-RIPed, apply the 
options prior to initial RIPing.

The Gradation, Brightness, Contrast, and Calibration settings do not require 
re-RIP.
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Color Mode
Select one of the following options:

Color: to print the job in color using CMYK.

Grayscale: to print the job as black and white using black (K) toner only. 
When a color job is printed using the Grayscale option, the cyan (C), 
magenta (M), and yellow (Y) separations are also printed in black (K) toner, 
giving a dense appearance similar to the CMYK grayscale image.

RGB Workflow
1. In the RGB Workflow list, select the required RGB source profile: 

• To use the embedded color space array (CSA) or source CSA, select Use 
SourceCSA.

• To use a Spire or Adobe CSA, select a CSA from the list. The default option 
is AdobeRGB1998.

2. In the Rendering intent list, select the required option.

3. To print RGB gray text and graphics with black toner only, select the Print grays 
using black toner check box.

4. Select Apply CMYK emulation to convert RGB elements according to the 
CMYK emulation method selected in the CMYK Profile list in the CMYK 
Workflow parameter. The RGB elements receive the same look as the CMYK 
elements, creating a consistent appearance.

CMYK Workflow
The CMYK workflow option is used to emulate various standards used in 
lithographic printing. These standards represent specific combinations of paper and 
ink, as well as popular proofing systems. The CMYK workflow is also used to 
emulate other digital printers or other printing devices such as offset presses. An 
example of a CMYK workflow job would be printing a test sample for a survey before 
moving to an offset press to print millions of survey forms. In such a case, it is best 
to emulate the offset before the job actually goes to offset printing. The Spire CX260 
supports the device link CMYK emulation methods.

Note:  If the job contains grayscale images that were created in RGB 
applications, such as Microsoft® PowerPoint®, specify as monochrome or 
submit to the system with Grayscale selected in the PPD file. This 
selection ensures that grayscale images are counted as black and white 
instead of color in both the Spire CX260 and the Xerox DocuColor 242/
252/260 printer/copier billing meters.

Note:  The Print grays using black toner check box not only affects 
R=G=B values but might also cause slightly different values 
(R+/-4=G+/-4=B+/-4) to produce gray.

Note:  RGB colors are not affected by the CMYK workflow.
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Use the CMYK workflow parameter to specify the required rendering intent for 
CMYK elements. All printers, monitors, and scanners have a range of colors 
(gamut) that they can output (or view, in the case of a scanner). If a color needs to 
be output and is outside the gamut of the output device, it must be mapped to 
another color that exists within the gamut.

Use rendering intent to compress out-of-gamut colors into the color capability of 
the press you are using. You can select any rendering intent value for CMYK 
elements from the Rendering intent list. The default value for CMYK is Relative 
Colorimetric.

In addition, you can emulate the paper tint and adjust the white point value of the 
used paper stock. For example, if you want to simulate pink paper while using white 
paper, use the corresponding emulation profile and select Emulate source paper 
tint.

The CMYK workflow parameter is also used to specify the desired rendering intent 
for CMYK elements.

To select CMYK workflow options:

1. In the CMYK Profile list, select the desired CMYK profile.

2. In the Rendering intent list, select the desired option.

3. To emulate the original paper tint, select the Emulate paper tint check box. 

4. Select the Preserve pure colors check box to preserve pure cyan, magenta, 
yellow, and black during transformation.

Spot Workflow
By default, the Spire CX260 searches the spot color dictionary for the correct value 
each time there is a spot color with a recognized name.

Note:  The system emulates the selected option during the RIP process. 
GCR and CMYK emulation do not affect the processed job.

Notes:

• If you selected Device Link as the emulation method, Rendering 
intent is unavailable because a rendering intent is already defined for 
each device link emulation.

• Custom CMYK Device Link emulations are available only if you have the 
Pro Basic or Pro Control Station configuration.

Notes:

• The Emulate paper tint check box is available only if you select Device 
Link as the CMYK profile.

• When you select the Emulate paper tint check box, the Spire CX260 
applies the absolute colorimetric rendering method.

• When you select the Emulate paper tint check box, the RGB 
Workflow > Apply CMYK emulation check box is selected by default.

• If the job is simplex, only the front side is printed using the tint 
emulation.

• Paper tint emulations are available only if you have the Pro Basic or Pro 
Control Station configuration.
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For more information about the Spire spot color dictionary, see Spot Color Editor and 
Workflow on page 140.

Select the relevant options:

Use Spire spot color dictionary: to use spot colors in the dictionary

Protect RGB colors: to retain RGB colors as defined

Protect Gray colors: to retain grays as defined

Protect CMYK colors: to retain CMYK colors as defined .

Destination Profile
Select the required profile. There is one predefined Spire CX260 profile, 
SpireDC260.

Screening
Screening converts Continuous-Tone (CT) and Line-Work (LW) images into 
information (halftone dots) that can be printed. The human eye “smooths out” this 
information, which seems visually consistent with the original picture. Thus, the 
more dots per inch, the more natural the image appears. 

The Spire CX260 supports line screening. Screening is achieved by printing lines in 
an evenly-spaced pattern. The distance between screen lines is fixed, and the line 
thickness varies, depending on the intensity of color required for the job. 

Using screening, printers can work with even amounts of toner and still produce a 
wide range of colors. The darker the color, the thicker the line. In this manner, 
screens give the appearance of different toner quantities printed in a certain area.

The Spire CX260 currently supports a line screen of 200 lpi (200C is the default 
setting). The screen of each separation is printed at a different angle.

Calibration
The purpose of color calibration is to achieve a consistent level of color quality. 
Calibration corrects printer colors by measuring a color density chart. 

The Spire CX260 calibration tool enables you to create calibration tables, either 
through an automatic process or by editing an existing calibration table. The 
available calibration options are Normal, Saturated, and None.

For more information about calibration tables, see Calibration on page 122.

The Calibration parameter enables you to select the required calibration table for 
the job.

Notes: 

• Protecting RGB, gray, CMYK colors is only available for the Pro Basic and Pro 
Control Station configurations.

• If you protect RGB, grayscale or CMYK colors, all colors with that specific 
combination found in the job will be protected. For example, a specific color 
combination used in a logo may align with a color used in an image in the 
job. The spot transformation affects the image color as well as that of the 
logo, sometimes to undesired results.
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To select a calibration table for a job:

In the Calibration list, select a calibration table. The default calibration table is 
Normal.

Ink Saving (GCR)
Gray component replacement (GCR) prevents the consequences of excessive toner 
buildup, such as flaking and cracking, and the "curling" effect that may occur when 
you print transparencies.

To set ink saving, select one of the following options:

None: no GCR is performed on the file, and the printer applies maximum dry 
ink coverage.

Low, Medium, or High: the selected amount of CMY dry inks replaces the 
black dry ink.

Color Adjustments

Gradation

The Gradation list contains gradation tables that were created by the Spire CX260’s 
Gradation tool. Each gradation table contains specific settings for brightness, 
contrast, and color balance.

When you select a predefined gradation table, your job is adjusted according to the 
specific table’s settings.

For more information about creating gradation tables, see Gradation Tool on 
page 145.

In the Gradation list, select one of the defined gradation tables. 

Brightness

Use this option to make last-minute adjustments to the print job after proofing.

To select a brightness level for a job, move the Brightness slider to the required 
brightness level (the range starts from Light, which applies 
-15%, to Dark, which applies +15%). 

Tip:  For optimal printing performance, use the Normal calibration setting 
with Ink Saving (GCR) set to Medium.

Note:  There is no change in the color quality of the printed image even though 
the gray component of each color is replaced by black

No GCR Low GCR Medium GCR High GCR

Tip:  Select High for minimum ink coverage and thus save on toner. High also 
prevents curling effects.

Note:  The default setting is None. No gradation table is applied to your job.
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Contrast

Adjust the Contrast option to control the difference between light and dark tones in 
your image.

To select a contrast level for the print job, move the Contrast slider to the 
required contrast level (the range starts from Less, which applies 
-10%, to More, which applies +10%).

The Imposition Tab
The Imposition tab enables you to set job options related to the positioning, folding, 
trimming, and binding of pages.
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Imposition Method
The Imposition Method parameter specifies the method with which printed sheets 
are imposed.

Select one of the following options:

None for no imposition (this is the default option). 

The imposition parameters are unavailable and the Preview window does not 
display an image.

Step & Repeat to print multiple copies of the same image on one sheet so 
that the sheet is filled to capacity. This method is used mainly for printing 
business cards.

Step & Continue to print different pages of a job on one sheet so that the 
sheet is filled to capacity.

Cut & Stack to print, cut, and stack jobs in the most efficient manner while 
preserving the original page order. A job’s pages, booklets, or books are 
sorted in a Z-shape. In other words, each stack of pages is sorted in 
consecutive order. When stacks are piled one on top of another, the entire 
job is already sorted up or down.

Saddle Stitch to print pages that are ready for the saddle-stitching book-
finishing technique. With this technique, the pages of a book are attached 
through stitching or stapling in the spine fold. The technique is usually used 
for printing brochures.

When using the saddle-stitch imposition method, you can select the sets per 
sheet. This option enables you to select how many sets of the job will print 
on one press sheet.

Perfect Bound to print pages that are ready for the saddle-stitching book-
finishing technique. With this technique, the pages of a book are attached by 
trimming the spine fold, roughening the edges of the gathered pages, and 
gluing them together. The technique is usually used for hardcover books.

Note: If you select Cut & Stack, you cannot change settings on the 
Exceptions tab or define any exceptions.
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Sizes
In the Trim Size list, select the desired trim size. Trim size is the size of the 
finished, trimmed document. You can adjust your page size by adjusting the trim 
size.

• If you select Custom, define a custom trim size and type the desired height 
in the H box, and the desired width in the W box. 

• Select Portrait or Landscape. If the wrong orientation is specified an 
unsuitable template might be selected and the job might be cropped as a 
result.

Template
There are two types of system layouts:

• The Custom option enables you to set up custom imposition parameters for this 
job. This layout is available for all imposition methods.

• When the Best Fit option is selected, the server determines how many columns 
and rows will best fit the sheet and whether the pages need to be rotated 90 
degrees according to the imposition method and paper size that you have 
chosen. The Best Fit layout is available for the Step & Repeat, Step & Continue, 
and Cut & Stack imposition methods.

To select Template options:

1. From the Layout list, select the desired layout.

2. Set the number of columns and rows. The columns and rows indicate how the 
pages will be placed on the sheet.

a. From the Columns list, select the number of pages to place horizontally. 

The template preview area displays your settings.

b. From the Rows list, select the number of pages to place vertically. 

The template preview area displays your settings.

3. From the Print Method list, select an option.

Note:  If you set the trim size to be smaller than the page size set in the DTP 
application, some of the data is cropped. Setting a larger trim size results in 
a larger border on the printed page.
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4. From the Binding method list, select an option.

5. Select the North South check box to place pages 180 degrees from each other, 
on the same side of the imposed sheet.

6. Select the Rotate 90 deg. check box to rotate all pages 90 degrees to the right. 
This rotation can help correct imposition conflicts.

Margins
Enter the desired margins sizes to adjust the spaces between the outside edges 
of pages and the edges of the sheet on which they are printed. 

Margin settings need to suit finishing equipment and requirements. Confirm binding 
parameters with your binder when planning your sheet.

Marks and Bleed
The Marks & bleed parameter enables you to mark where trimming and folding 
should occur. 

When you set bleed options, you extend part or all of the printed image beyond the 
trimming boundary. The bleed options ensure that an inaccurate trim setting will not 
leave an undesired white space at the edge of the page. The bleed options produce 
sharp page boundaries with color that extends all the way to the edge of the page.

To select marks and bleed options:

1. In the Marks area, select one of the following options:

a. To print the lines that indicate where the sheet should be cropped, select 
the Crop Marks check box.

• To print the crop marks on both sides of the page, select the Both sides 
of sheet check box.

b. To print the lines that indicate where the sheet should be folded, select the 
Fold Marks check box.

Note:  The Binding option is available only when Saddle Stitch or Perfect 
Bound is selected as the Imposition method.

Note:  This option is available only when the Step & Repeat method is 
selected and the number of columns and rows is 2×1 or 1×2.

Note:  

• Crop marks are placed according to the Trim Size option. A minimum 
of 6 mm is required for crop marks and 10 mm for fold marks.

• If your job already includes crop marks incorporated by the DTP 
application, you do not need to add crop marks here. If you do add crop 
marks, both sets of crop marks can be printed.

• If you want to use crop marks incorporated by the DTP application, 
make sure that enough space is left around your page in the PostScript 
file so that the page prints with crop marks.
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2. In the Bleed area, select one of the following options:

• Maximum bleed: Use this option to extend the bleed to the sheet fold lines.

• Custom bleed size: Type the desired bleed size in millimeters.

Creep

The Creep parameter uses the following terminology: 

• Creep in specifies the amount of movement towards the spine applied to the 
center two pages and their backs (in other words, the pages that require the 
most amount of compensation). 
An ever-decreasing amount of movement is automatically applied from the 
center quartet of pages back to the outside four pages of the job (in other words, 
every quartet of pages is moved by an amount less than the previous quartet). 

• Creep out is used when you find that the page images are too close to the spine. 
This problem can be resolved by selecting a value for Creep out. This will move 
all the pages of the job further out towards the outside margin (away from the 
spine) by the specified amount. This movement takes place before the Creep in 
value is applied. 

To set creep options:

1. In the Creep in area, select Auto to automatically set the creep based on paper 
stock weight, or type the desired amount for Creep in.

2. In the Creep out area, type the desired amount.

Scale
Under Scale, select one of the following options:

Scale by, to change the scale of all imposed sheets. This is the default option, 
set to 100%. In the % box, type a value from 25% to 400% for how you want 
to change the scaling of the imposed sheets.

Fit layout to sheet size, to fit the page layout to the sheet size.

Note:  

• You cannot extend the bleed size beyond the sheet fold lines. Bleed 
does not affect the position of crop marks.

• Bleeding must be defined in your DTP application in order for the Spire 
CX260 to be able to apply the bleed options.

Tip:  It is recommended that you use a border around all documents when you 
use creep.

Note:  The outside two pages and their backs are not moved (the value 0.0 
is used). 

Note:  Units of measurement (mm or inches) are set in the Settings 
window, see Localization on page 167.

Note:  Changing the scaling percentage affects the margins of the job. The 
margins are updated in proportion to the percentage that you choose.
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The Preview Window

The Preview window enables you to view your imposition layout and settings. 

You can open the Preview window at any time and keep it open to check your 
imposition settings as you select them. The Preview window dynamically reflects 
any changes that you make.

To open the Preview window:

Click preview .

In the Preview window, you can perform the following functions:

• Click Front  to view the front pages.

• Click Back  to view the back pages.

• Move between sheets by clicking the navigation arrows  

• Jump to a specific sheet by typing a number in the navigation box.

Gray arrows indicate the direction of the pages on the sheet. The sequence of pages 
is indicated by the page numbers.

If any parameters conflict, Imposition Conflict appears in red in the Preview 
window and also on the Imposition tab.

Note:  The Preview window is only available for the Pro Basic and Pro 
Control Station configurations.

Note:  The Preview window is not available if the Imposition method is set to 
None.
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A red border along the edge of the page indicates where the conflict exists. 

• If the red border appears along the upper and lower edges of the page, a conflict 
exists in the Height value.

• If the red border appears along the left and right edges of the page, a conflict 
exists in the Width value.

Problematic values appear in red.

The Services Tab

Note:  To preview the imposed job in the Job Editor window, Imposed 
sheets tab, see Viewing and Editing Job Parameters on page 60.
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Job Deletion
Select this parameter to delete each page on the fly once it has been successfully 
printed. In this way, the Spire CX260 maintains enough free disk space for the 
duration of the print run. Reusable elements are not deleted.

To set a deletion policy:

1. Suspend the Process Queue, and import your job.

2. On the Services tab, in the Automatic deletion options area, select one of the 
following options:

• To delete pages or jobs after printing is completed, select Delete after 
complete.

• To remove failed jobs while they are processing or printing, select Delete on 
job failure.

3. Click Submit. 

4. Select the Resume button to resume the Process Queue and start the 
processing of your job.

Substitute Fonts
Select one of the following options:

Yes: to substitute a missing font with the default font set in the Settings 
window

No: to stop the job processing if the desired font is missing

APR

1. In the APR options area, select one of the following options:

• Print with high res: replaces low-resolution images in your job with high-
resolution images that are located in a specified APR path.

• Print with low res: prints the job with the existing low-resolution images—
for example, for proofing purposes.

2. In the Use APR mask from area, select one of the following options:

• PS image: uses the masking data contained in the low-resolution image file.

• High res: uses the masking data contained in the high-resolution image file.

• Both: uses the masking data that is common to both high-resolution and 
low-resolution image files. For example, if the images defined by the two 
sets of masking data overlap, the overlapping area is RIPed.

Note:  This option sustains enough free disk space for the duration of the print 
run and only affects the job that is currently printing.

Note:  For more information on managing fonts, see Managing Fonts on 
page 93.

Note:  This parameter is available only if you have the Pro configuration.

Note:  If the masking data in the low-resolution image file defines a 
completely different part of an image than the masking data in the 
high-resolution file, no masking data is used.
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Job Flow
The Job Flow parameter enables you to specify a job flow for a job that is imported 
to the Spire CX260 from the network or from the Spire CX260 folders.

Select one of the job flow options:

Process & Print: to set the Spire CX260 to RIP the PDL files, print them, and 
store them in the Storage window (unless the Job Deletion parameter is set 
to Delete after Complete)

Process & Store: to RIP the PDL files and move them to the Storage window 
as RTP jobs

Spool & Store: places the PDL files directly into the Storage window without 
processing them. 

Preflight
Select Run preflight check to check the status of key job components before the 
job is sent for printing.

Your job is RIPed and the missing components are identified. 

You can set the preflight to detect the following problems:

High-resolution images

Incorrect links to the high-resolution images folder

Missing fonts

Spot colors that are not defined in the Spire CX260 spot color dictionary

The results of the preflight check are displayed in a Preflight Report. To generate this 
report, right-click the RTP job in the Storage window and select Preflight Report. For 
more information on the Preflight Report, see Preflight Report on page 110.

Job Slug

1. To print a slug in the margins of your job, select the desired options:

• Color bar to print a measurable color bar. Looking at this bar, you can tell the 
state of the printer and whether the quality is consistent. You might need to 
calibrate the printer or perform color proofing.

• Job name

• Sheet number and side (front/back)

• Date and Time

2. In the Comment box, type comments up to 30 characters.

Note:   This option can be defined only through the PPD parameters of the 
virtual printer.

Note:   If a job component is missing, the job fails before it is RIPed and an alert 
message appears. The job is transferred to the Storage window. Information 
about missing components will appear in the Job History window.

Note:  This feature is only available for the Pro Basic and Pro Control Station 
configurations.
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Job Info
This parameter provides the following information:

• Job Title: Original name of the file related to this job

• Sender: User name of the system from which this job originated

• Account: Account number of a specific customer or group

• Recipient: Name of customer

• Job Comments: Any special instructions that you want to include with your job

Split to booklets

The Split to booklets parameter enables you to split a PostScript, PDF, or large VI job 
that does not have a booklet structure into booklets. 

1. In the Split to booklets options area, select Yes.

2. In the Number of pages per booklet box, type the desired number.

PDF/PS Optimization
Select this check box if you have a PDF job with repeated elements and want to 
significantly decrease processing time by applying the PDF workflow. 

The PDF workflow caches the repeated elements in the PDF once, and reuses 
them as much as required without repeated processing.

Note:  This feature is only available for the Pro Basic and Pro Control Station 
configurations.

Note:  Unexpected results might occur when you use this option for VI jobs 
that already have a booklet structure.

Note:  If the specified number of pages per booklet is not sufficient to 
produce complete booklets and there are a few pages left over, the last 
pages form a booklet containing less pages than specified.

Note:  Verify that in your Acrobat Distiller settings, Optimize for Fast Web 
View is selected (in Acrobat 4.0 the corresponding option is Optimize PDF).
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The Finishing Tab

Admin. Page
The administration page contains job-related information such as the job title, the 
name of the sender, the date and time that the job was submitted, account 
information, and comments.

The administration page is printed in the same order as the job. For face-down 
printing, the page is printed before each set; for face-up printing, the page is printed 
after each set.

To print an administration page:

1. Select the Print Admin. page check box

2. From the Tray list, select the desired tray.

Slip Sheet
You can print slip sheets with your job and select a different paper set in which to 
print the slip sheet. If the job is collated, the slip sheet prints between sets. If the job 
is uncollated, the slip sheets prints between groups.

To print a slip sheet:

1. Select the Print slip sheet check box

2. From the Tray list, select the desired tray.

Note:  If you change the options in the Admin. page options, you need to 
re-RIP.
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Front Cover
By default, your job is printed without a front cover. However, you can choose to 
print a front cover, and you can also select a different paper set. 

Select the Print front cover check box, and set the specifications as desired:

a. Select the relevant tray from the list.

b. In the Cover printing area, select one of the following options:

• None to print a blank front cover

• Print on front side to print the first page of the job as the cover page

• Print on both sides to print the first two pages of the job as the cover 
page

Back Cover
By default, your job is printed without a back cover. However, you can choose to print 
a back cover, and you can also select a different paper set. 

Select the Print back cover check box, and set the specifications as desired.

a. Select the relevant tray from the list.

b. In the Cover printing area, select one of the following options

• None to print a blank back cover

• Print on back side to print the last page of the job as the back cover

• Print on both sides to print the last two pages of the job as the back 
cover

Finisher
The Finisher parameter enables you to select the destination of the printed output.

1. Select a Module:

• SCT (simple catch tray)

• OCT (offset catch tray)

• Advanced (C Finisher)

• Professional (C Finisher with Booklet Maker tray)

• Light Production (D2 Finisher)

Note:  A blank page is automatically inserted between the cover page 
and the first page of the job so that both sides of the cover page are 
defined, and the job starts on the next odd page.

Note:  A blank page is automatically inserted between the back cover 
and the last page of the job so that both sides of the back cover are 
defined.

Note:  The stapling position (Front, Rear, Center, and Dual) is relative to the 
printer. The Front option refers to the front side of the printer and the Rear 
option refers to the back side of the printer.
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2. Select an Output Tray:

• SCT (simple catch tray)

• OCT (offset catch tray)

• Top Tray

• Stacker

• Booklet Maker

• Tri-Fold

3. Select the desired Output Tray finishing options:

• Offset to use an offset between sets

• Stapler to use staples

• From the Position list, select the staple position.

• Puncher to punch holes

• From the Type list, select the number of holes.

• Z Fold Half Sheet to fold a sheet of paper in half, in a z-shape—for example, 
if you need to insert an A3-size sheet into an A4-size job.

• C Fold to fold a sheet into a c-shape

• Z fold to fold a sheet into a z-shape

The Exceptions Tab
The Exceptions tab enables you to add and delete page exceptions and inserts. 
Exceptions are special pages in a job for which you want to assign different paper 
stock. For example, you can assign a different paper stock for each chapter within a 
book. 

Note:  The Module option that you select determines which trays are 
available in the Output Tray list.

Note:  The Module option and Output Tray that you select determines 
which methods are available.
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Inserts are blank pages of a selected paper stock that are assigned to a job after a 
specified number of pages. For example, you can add blank pages between sections 
in a brochure.

Managing Exceptions
You can add and delete exceptions on the Exceptions tab.

To add exceptions to a job:

1. In the Exception area, click the Add button .

2. In the From and To boxes, type the desired page range for the exception.

3. In the Tray list, select the required tray.

4. Click Apply.

The exception is added to the Exception area.

To delete an exception:

In the Exception area, select the desired exception and click the Remove button 

.

Managing Inserts

To add an insert:

1. In the Insert area, click the Add button .

2. In the After page box, type the number of the page that will precede the insert. 

3. In the Quantity box, type the number of inserts that you want.

4. In the Paper size list, select the desired paper stock size. If you select Custom, 
type the height in the H box and width in the W box, and then select LEF or SEF.
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5. In the Media type list, select the desired paper stock type. The default setting is 
Use Printer Settings. When this option is selected, your job is printed on the 
media type that is defined on the Xerox DocuColor 242/252/260 printer/
copier.

6. In the Tray list, select the required tray.

7. Click Apply.

The insert is added to the Insert area.

To remove an insert:

In the Insert area, select the desired insert and click the Remove button .

Setting PPD File Parameters
You can set job parameters from a client workstation using the PPD file, or you can 
define a virtual printer with predefined PPD file settings.

To print a file from Windows, first set up a Spire CX260 network printer with the 
appropriate PPD file. The PPD file contains all the parameters and paper stock 
definitions for the printer and enables you to print your file properly. 

Table 14 lists the PPD file parameters available.

Notes:

• In the PPD file, the Printer’s Default option is selected for all PPD file 
parameters. The Printer’s Default option corresponds to the settings of the 
currently selected virtual printer.

• Print settings defined in the job file override the settings of the virtual printer.

• To ensure that grayscale images created in RGB applications (such as 
PowerPoint) are counted as black and white instead of color in both the Spire 
CX260 and the Xerox DocuColor 242/252/260 printer/copier billing meters, 
select Gray RGB > Print grays using black toner in the PPD file.
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Table 14: PPD parameters

PPD Parameter For more information

Media Type See Media Type on page 186.

Media Image Quality See Media Type on page 186.

Gloss Enhanced See Media Type on page 186.

Side-2 Printing See Media Type on page 186.

Print Mode See Print Mode on page 183.

Print Method See Print Method on page 183.

Print order See Print Mode on page 183.

Delivery See Delivery on page 184.

Collation See Collation on page 184.

Image Scale See Image Scale on page 185.

Color Mode See Color Mode on page 190.

Text and Line Quality See Text /Line Quality on page 187.

Image Quality See Image Quality on page 188.

Trapping See Trapping on page 188.

Black Overprint See Black Overprint on page 188.

PS Overprint See PS Overprint on page 189.

Brightness See Color Adjustments on page 193.

Contrast See Color Adjustments on page 193.

RGB Workflow See RGB Workflow on page 190.

Rendering Intent for RGB See RGB Workflow on page 190.

CMYK Workflow See CMYK Workflow on page 190.

Destination Profile See Destination Profile on page 192.

Emulate Source Paper Tint See CMYK Workflow on page 190.

Apply CMYK Emulation on 
RGB

See CMYK Workflow on page 190.

Preserve Pure Colors See CMYK Workflow on page 190.

Rendering Intent for CMYK See CMYK Workflow on page 190.

Ink Saving (GCR) See Ink Saving (GCR) on page 193.

Calibration See Calibration on page 192.
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Screening Method See Screening on page 192.

Automatic Deletion See Job Deletion on page 201.

APR See APR on page 201.

Job Flow See Job Flow on page 202.

Split to Booklets See Split to booklets on page 203.

Admin Page See Admin. Page on page 204.

Slip Sheet See Slip Sheet on page 204.

Transparency Interleave See Media Type on page 186.

Output Tray See Finisher on page 205.

Finisher Offset See Finisher on page 205.

Punch Options See Finisher on page 205.

Staple Options See Finisher on page 205.

Booklet Stapling See Finisher on page 205.

Fold Options See Finisher on page 205.

Rotate 180 See Rotate 180 on page 185.

Mirror See Rotate 180 on page 185.

Table 14: PPD parameters

PPD Parameter For more information
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Overview
This chapter describes when and how to:

• Back up and restore the entire operating system and Spire CX260 software 
(Last Image configuration), including the current job list database

• Reinstall the software configuration on your Spire CX260.

When to Back Up and Restore
Back up the Spire CX260 software:

• On a regular basis—for example, weekly—so that you always have a working 
copy of your software to be able to restore your system, if necessary.

• When you want to revert back to a specific configuration. 

Restore the system when:

• The operating system fails.

• The performance of the operating system is low.

• The system exhibits unpredictable behavior—for example, if error messages 
suddenly appear or if the GUI freezes occasionally.

The Spire CX260 provides two restore methods:

• Restore Last Image configuration (partition C)—Norton Ghost restores the Last 
Image configuration file from partition E.

• Restore Factory Default configuration—restores partitions C and D from the 
Factory Default file on partition E.

You can back up and restore the Spire CX260 system partition and the job list 
database at any time.

Tip:  Save a copy of the backup, either on the network or on an external device, 
to prevent loss of data in case your system disk becomes corrupted.

Note:  Restoring the Last Image configuration may not include the most 
recent job list database.

Note:  Restoring the Factory Default configuration does not include the job 
list database.
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Preloaded Software
The Spire CX260 is delivered to the customer site preloaded with the following 
items:

• Microsoft Windows XP Professional operating system with SP2

• Internet Explorer® 6.0 browser

• Nero Express DVD-burning software

• Spire CX260 software

• Adobe Acrobat 7.0 software

• Configured network parameters (host name, IP address, network services and 
protocols)

• Backup of Factory Default configuration for partitions C and D

Disk Configuration
The following table outlines the Spire CX260 disk configuration.

Table 15: Spire CX260 disk configuration:

Backing Up and Restoring the Spire CX260 

When you back up the Spire CX260 system partition (partition C), all the operating 
system files are copied to partition E (LI.GHO and LIxxx.GHO).

The backup and restore procedures do not require Windows XP Professional 
activation, and are not related to the system reinstallation. 

Disk 0 C: (10 GB)
Windows XP 
Professional software

Spire CX260 
software

 D: (~50 GB)
Spool files
Shared files
Output directory files
Job list backup folder

E: (16 GB)
Backup

• Factory Default—
read-only file 
(FD.GHO)
(FDxxx.GHS)

• Last Image 
(LI.GHO)
(LIxxx.GHS)

Boot partition: 
(31 MB)
Used during system 
backup

Disk 1 Image disk

Disk 2 Image disk

Attention:  

• To ensure a successful backup, there must be at least 1 GB of disk space 
available in partition C.

• Before performing the backup procedure, make sure that your computer’s 
configuration is the one that you want to use when restoring the system.
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To back up the Spire CX260:

1. Back up system partition C (Last Image configuration).

2. Back up the job list database.

3. Move the backups to an external device or to a network.

• Select Start > Run, type E: and click OK. Copy only the files located on 
E:LI.GHO and E:LIxxx.GHO (Last Image configurations) 

To restore the Spire CX260:

1. Restore system partition C (Last Image configuration). 

• Restore the Last Image configuration.

2. Restore the job list database.

Backing Up the Job List Database

When you back up the Spire CX260 Last Image configuration (see Backing Up the 
CX260 Last Image Configuration on page 216), your job list database is also backed 
up. 

If, at some later date, you restore the configuration, the original job list database will 
be restored, thus replacing your current job list database. Therefore, it’s important to 
always have a current backup of your job list database.

To back up the job list database:

1. Exit the Spire CX260 software and wait for the Spire icon to disappear from the 
desktop taskbar.

2. On the Windows desktop, double-click My Computer, and locate 
D:\Backup\Scripts.

3. In the D:\Backup\Scripts folder, double-click Backup_Joblist.bat.

Note:  To back up the job list database on the CX260 basic configuration, you 
must be connected to the Spire CX260 via the Remote Desktop Connection. 
See Working from the Remote Desktop Application on page 86.

Taskbar with Spire icon Taskbar without Spire icon
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When the backup is complete, the following message appears.

4. Press any key to continue.

5. Make sure that the folders created in D:\Backup have the latest modification 
date.

The backup comprises a group of folders that are created the first time that you 
back up the job list database.
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Backing Up the CX260 Last Image Configuration
The Spire CX260 includes two backup configurations:

• Last Image (system backup)—only partition C is backed up

• Factory Default—partitions C and D are backed up (this is performed in the 
factory)

After installing a new version of the Spire CX260 software, you must perform a back 
up. It is important that you have a backup of the current software version.

To back up the Last Image configuration:

1. Do one of the following depending on your configuration type:

• For the Basic configuration, turn on your Windows-based computer, 
Macintosh computer, or portable workstation and then connect to the Spire 
CX260 via the Remote Desktop Connection.

• For the Control Station and Pro Control Station configurations, turn on the 
Spire CX260.

2. After the Spire CX260 software opens, exit the software and wait for the Spire 
icon to disappear from the desktop taskbar.

3. On the desktop, select Start > CX260 > CX260 Tools > System Backup and 
Restore > Start system backup.

The system checks whether there is adequate disk space on partition C to 
perform the backup. At least 1 GB is required.

a. If there is adequate disk space, the following message appears.

Attention:  To ensure a successful backup, there must be at least 1 GB of disk 
space available on partition C.

Taskbar with Spire icon Taskbar without Spire iconTaskbar with Spire icon

Note:  This process may take several minutes to complete. On the Spire 
CX260, LED 5 illuminates steady green.
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Click Yes to continue.

b. If a message tells you there is not adequate disk space, click OK to continue. 
Free up disk space on partition C, and then continue the backup procedure 
from step 3.

4. The Spire CX260 restarts and the Norton Ghost™ window appears.

The files from partition C are copied to the Last Image file on partition E. This 
process takes about ten minutes to complete.

The Spire CX260 restarts and the Windows XP desktop appears.

Restoring the Spire CX260

Performing the restore procedure requires a previous backup. Before restoring the 
Spire CX260 system partition, it is recommended that you back up any current 
important jobs, using the procedure described in Backing Up the Job List Database on 
page 214.

Verifying the Current Recovery Type
The Spire CX260 includes two options for restoring the system:

• Restoring the Last Image configuration

• Restoring the Factory Default configuration

Note:  For the CX260 Control Station and Pro Control Station 
configurations, the appearance of the Windows XP desktop indicates that 
a successful backup has been performed.

For the CX260 Basic configuration, when the Spire CX260 restarts, your 
current RDC session terminates. To determine that a successful backup 
was completed, do one of the following:

• Wait ten minutes and reconnect to the Spire CX260 via the RDC 
utility. If you are able to connect to the server, the backup succeeded.

• Check LEDs 3 and 5. If both LEDs illuminate steady green, the backup 
succeeded.

Tip:  You can copy the backup files to an external device. Select Start > Run, 
type E: and click OK. Copy only the files located on E:LI.GHO and 
E:LIxxx.GHO (Last Image configurations) or E:FD.GHO and E:FDxxx.GHS 
(Factory Default configurations).

Note:  Before performing the restore procedure—if the job list database was 
not backed up or cannot be restored, you must format the image disk. See 
Formatting the Image Disk on page 236.
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Before performing the recovery procedure, the system must be in the configuration 
mode that you want to recover.

To verify the current recovery type:

1. Using the tip of a pen or similar object, push the RCVR button on the front of the 
Spire CX260.

2. From your Windows-based computer, Macintosh computer, or portable 
workstation, connect to the Spire CX260 via the RDC utility. See Working from 
the Remote Desktop Application on page 86.

3. On the desktop, select Start > CX260  > CX260 Tools > System Backup and 
Restore > Show current recovery type.

4. When the following window appears, click OK. 

5. To exit recovery mode without initiating the recovery process, push the RCVR 
button again.

LED 7 turns off.

Restoring the Last Image Configuration
When you restore the Last Image configuration, the job list database from that 
backup will also be restored. The current job list database will be replaced with the 
old job list that was saved while backing up Last Image configuration. 

To restore the Last Image configuration, the operating system must be in Last Image 
mode. See Verifying the Current Recovery Type on page 217.

Note:  The default Spire CX260 backup configuration is the Last Image 
configuration.

Note:  This step is required only on the CX260 Basic configuration.

Note:  If the current recovery type is Factory Default, the message 
Current Recovery type is Factory Default appears.
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1. Exit the Spire CX260 software and wait for the Spire icon to disappear from the 
desktop taskbar.

2. Using the tip of a pen or similar object, push the RCVR button on the front of 
the Spire CX260.

3. For the Basic configuration, from your Windows-based computer, Macintosh 
computer, or portable workstation, connect to the Spire CX260 via the RDC 
utility. See Working from the Remote Desktop Application on page 86.

4. When the RCVR LED (7) on the Spire CX260 illuminates steady orange, on the 
desktop, go to Start > CX260 > CX260 Tools > System Backup and Restore > 
Set Last Image recovery.

5. When the operating system confirmation message appears, click OK.

6. Push the green On/Off button to restart the Spire CX260.

Norton Ghost copies the files from partition E to partition C. This process takes 
approximately 5-10 minutes.

7. When Norton Ghost finishes copying the files and the Recovery LED (7) 
illuminates steady green, using the tip of a pen or similar object, push the RCVR 
button to exit recovery mode.

8. Restart the Spire CX260.

a. Push the green On/Off button. The Spire CX260 shuts down.

b. Push the On/Off button again. LED 1 illuminates steady green and the Spire 
CX260 restarts.

The backed-up file runs, and the Spire CX260 software opens.

Taskbar with Spire icon Taskbar without Spire icon

Important:  If you only want to verify the current recovery type, but do not 
want to initiate the recovery process, see Verifying the Current Recovery 
Type on page 217.
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9. A system message may appear requesting you to restart the computer.

a. Exit the Spire CX260 software.

b. Click Yes to restart your computer.

Restoring the Factory Default Configuration
To restore the Factory Default configuration, the operating system must be in 
Factory Default mode. See Verifying the Current Recovery Type on page 217.

1. Exit the Spire CX260 software and wait for the Spire icon to disappear from the 
desktop taskbar.

2. Using the tip of a pen or similar object, push the RCVR button on the Spire 
CX260.

3. From your Windows-based computer, Macintosh computer, or portable 
workstation, connect to the Spire CX260 via the RDC utility. See Working from 
the Remote Desktop Application on page 86.

4. When the RCVR LED (7) illuminates steady orange, go to Start > CX260 > 
CX260 Tools > System Backup and Restore > Set Factory Default recovery.

5. When the operating system confirmation message appears, click OK.

6. Push the green On/Off button to restart the Spire CX260.

Norton Ghost copies the files from partition E to partitions C and D. This 
process takes approximately 10-15 minutes.

Note:  The Spire CX260 default backup configuration is the Last Image 
configuration.

Taskbar with Spire icon Taskbar without Spire icon

Note:  If you only want to verify the current recovery type, but do not want 
to initiate the recovery process, push the RCVR button again to exit the 
recovery mode (LED 7 turns off).

Note:  This step is required only for the CX260 basic configuration.
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7. When Norton Ghost finishes copying the files and the Recovery LED (7) 
illuminates steady green, using the tip of a pen or similar object, push the RCVR 
button to exit recovery mode.

8. Restart the Spire CX260.

a. Push the green On/Off button. 

The Spire CX260 shuts down.

b. Push the On/Off button again.

LED 1 illuminates steady green and the Spire CX260 restarts.

The backed-up file runs, and the Spire CX260 software opens.

9. A system message may appear requesting you to restart the computer.

a. Exit the Spire CX260 software.

b. Click Yes to restart your computer.

Restoring the Job List Database

1. Exit the Spire CX260 software and wait for the Spire icon to disappear from the 
desktop taskbar.

2. On the Windows desktop, double-click My Computer, and locate 
D:\Backup\Scripts.

3. In the D:\Backup\Scripts folder, double-click Restore_Joblist.bat.

Note:  This procedure is valid only if the last restore made was the Last Image 
configuration. Restoring the Factory Default configuration erases the job list 
database.

Taskbar with Spire icon Taskbar without Spire icon

Note:  To restore the job list database on the CX260 basic configuration, 
you must be connected to the Spire CX260 via the Remote Desktop 
Connection. See Working from the Remote Desktop Application on 
page 86.
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The following message appears.

4. Press Y to continue.

The following window appears.

5. Press any key to continue.

Adding the Spire CX260 Color Server to a Domain
This procedure should be performed by a System Administrator. It contains the 
following major tasks:

1. Uninstalling the Spire CX260 software.

2. Adding the Spire CX260 to the Microsoft Active Directory® domain, and 
assigning a user name and password.

3. Ensuring that the user is included in the Spire CX260’s Administrator’s group 
(local group).

4. Logging on to the domain, reinstalling the Spire CX260 software, and then 
assigning printing permissions on the shared virtual printers, as required by 
your site policy.

For more information about adding the Spire CX260 to the Active Directory, 
go to www.microsoft.com.

http//www.microsoft.com 
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Reinstalling the Spire CX260

Before you can reinstall the Spire CX260 software, you must uninstall the current 
version.

Uninstalling the Spire Application Software

1. Exit the Spire CX260 software and wait for the Spire icon to disappear from the 
desktop taskbar.

2. On the Desktop, select Start > Settings > Control Panel > Add or Remove 
Programs.

3. In the Add or Remove Programs window, select CX260 and click the Change/
Remove button.

The message Do you want to uninstall it now? appears.

4. Click OK.

The following window appears.

Note:  To install and uninstall the Spire CX260 software for the CX260 Basic 
configuration, you must be connected to the Spire CX260 via the Remote 
Desktop Connection. See Working from the Remote Desktop Application on 
page 86

Note:  The uninstalling process terminates your current RDC session. To open 
a new session, you must reconnect your Windows-based computer, Macintosh 
computer, or portable workstation to the Spire CX260.

Taskbar with Spire icon Taskbar without Spire icon
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5. Click Yes.

The following window appears.

6. Click OK.

7. When the InstallShield Wizard finishes uninstalling the Spire CX260 software 
and Spire GUI, the following window appears. Select the Yes, I want to restart 
my computer now option and click Finish.

The Spire CX260 restarts and your current RDC session terminates.
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Installing the Spire Application Software

1. On the Spire CX260 desktop, double-click My Computer.

2. Insert CD #2 (Spire CX260 software) into the CD/DVD-ROM drive on your 
local Windows-based computer, Macintosh computer, or portable workstation.

3. Under Devices with Removable Storage, select the CD/DVD-ROM drive. This 
is your local CD/DVD-ROM drive that is published on the Spire CX260.

4. Double-click the <Drive>\CX260\Setup.exe file and follow all the installation 
steps in the InstallShield Wizard.

5. When the InstallShield Wizard finishes installing the Spire CX260 software, the 
following window appears. Select the Yes, I want to restart my computer now 
option and click Finish.

Note:  To install the Spire CX260 software on the CX260 basic configuration, 
you must be connected to the Spire CX260 via the Remote Desktop 
Connection. See Working from the Remote Desktop Application on page 86.

Note:  Installing the Spire CX260 software via the RDC utility may take up 
to 15 minutes.



226 Chapter 9 – Reinstalling the Spire CX260

 

The Spire CX260 restarts and your current RDC session terminates.

Configuring the McAfee VirusScan (Optional)

The current Creo recommended virus protection software is McAfee VirusScan 
Enterprise version 8.0.0. After installing McAfee VirusScan, perform the following 
configuration procedures. 

Creo will continue to update their virus protection software recommendations 
according to software performance and market availability.

It is the responsibility of the site manager to obtain, once a year, the latest version of 
the anti-virus software and installation procedure. The site manager must also 
regularly download the latest anti-virus definitions from the relevant Internet site. 

To configure the McAfee VirusScan, perform the following procedure.

Note:  To open a new session, you must reconnect your Windows-based 
computer, Macintosh computer, or portable workstation to the Spire 
CX260.

Note:  McAfee VirusScan Enterprise version 8.0.0 is supported on Windows 
2000 and Windows XP only. Use version 7.1 for earlier software versions.

Important:  Running McAfee VirusScan could slow down the process time 
and affect the overall performance of the server.

Note:  The following McAfee VirusScan software configuration procedure is 
subject to change without notice and the relevant documentation will not be 
updated.
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Configuring the Scan All Fixed Disks Settings
1. From the taskbar, right-click the VShield icon and select VirusScan Console:

2. In the Task column, right-click Scan All Fixed Disks and select Properties.

3. Click the Detection tab.

4. In the What not to scan area, click Exclusions.

5. Click Add.

The following dialog box appears.
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6. Click Browse.

7. In the Browse for Folder window, locate the D:\Output folder and click OK.

The D:\Output folder path appears.

8. In the Browse for Folder window, locate the D:\JobsData folder and click OK.

The D:\JobsData folder path appears.
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9. Select the Also exclude subfolders check box and click OK.

10. In the Set Exclusions dialog box, click OK, and again click OK.

Configuring the On-Access Scan Settings
1. Return to the VirusScan Console window.

2. In the Task area, right-click On-Access Scanner and select Properties.
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3. On the left of the window, click the All Processes icon.

4. Click the Detection tab.

5. In the What not to scan area, click Exclusions.

The following dialog box appears:
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6. Click Add.

7. Click Browse.

8. In the Browse for Folder window, locate the D:\Output folder and click OK.

The D:\Output folder path appears.

9. In the Browse for Folder window, locate the D:\JobsData folder and click OK.

The D:\JobsData folder path appears.
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10. Select the Also exclude subfolders check box and click OK.

11. In the Set Exclusions dialog box, click OK.

12. In the VirusScan On-Access Scan Properties window, click OK.

You have completed configuring the On-Access Scan settings.

Installing and Configuring Novell Client 
The following procedures are relevant only for customers who have a Novell® 
network running IPX protocol.

Installing Novell Client for Spire CX260
1. Close the Spire CX260 workspace and the Spire CX260 software.

2. Close all other software programs.

3. On the Windows desktop, select Start > CX260 > CX260 Tools > Novell Client 
Installation.

The following window appears.
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4. Click Install.

5. Click Reboot.

6. You have completed installing Novell Client. Proceed to the next section, 
Configuring Novell Client for Spire CX260.

Configuring Novell Client for Spire CX260
1. After the system restarts, the Novell Setup dialog box appears.

2. Type the Tree Name. 
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3. If you do not know the name, click Browse.

4. Double-click the appropriate Tree Name.
The Tree Name appears in the Novell Setup window.

5. Type the Context Name. 

6. If you do not know the name, click Browse.

7. Double-click the appropriate Context Name.
The Context Name appears in the Novell Setup window.

8. Click OK.
The Spire CX260 workspace appears. 

You have completed Installing and Configuring Novell Client.

Uninstalling Novell Client for Spire CX260
Uninstall Novell Client if you no longer operate a Novell network running IPX 
protocol.

1. Close the Spire CX260 workspace and the Spire CX260 software.

2. Close all other software programs.

3. Right-click My Network Places and select Properties.

4. Right-click Local Area Connection and select Properties.
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5. Make sure the Novell Client for Windows check box is selected, and then click 
the Uninstall button.

6. Click Yes twice.

The Spire CX260 restarts.

Backing Up the CX260 Last Image Configuration
See Backing Up the CX260 Last Image Configuration on page 216.

Performing a Test Print

1. From the File menu select Import Job.

2. Locate the ATF_A3.ps file at:
D:\Sample_Files\Color Files\ATF Europe (A4_A3)\ATF_A3.ps,

or locate the ATF_tab.ps file at:
D:\Sample_Files\Color Files\ATF US (Letter_Tabloid)\ATF_Tab.ps.

3. Double-click the file to add it to the list for importing. 

4. In the Published Printer list, select ProcessPrint.

5. Click Import.
The file is processed, printed, and sent to the Storage window.

Note:  To import a file and perform a test print on the CX260, you must be 
connected to the remote server via the Remote Desktop Connection. See 
Working Remotely on page 24. 

Note:  If the job is not printed or is waiting in the Print queue, check that 
the finishing device is set properly in the Job Parameters window, Finisher 
tab.
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Formatting the Image Disk

Perform the following procedure when suggested as a recovery action.

1. Close all software programs and wait for them to shut down completely.

2. Select Start > CX260 > CX260 Tools > Format Image Disks.

The following message appears.

3. Close all open windows, if required, and click OK.

 

4. Click OK.

The following message appears.

5. Click Yes.

 

Note:  To format an image disk on the CX260 configuration, you must be 
connected to a Windows-based computer, Mac client, or portable workstation 
via the Remote Desktop Connection. See Working Remotely on page 24.

Important:  Formatting erases all data stored in the Storage folder. It is 
recommended that either an ONSA or your system administrator back up the 
customer’s data, if possible, to an external device or network.
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6. Click OK.

7. To enable the changes to take effect, restart your computer.
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24 bit/3 byte image An image can be either RGB or CMY and each of the three colors uses 
1 byte or 8 bits of data. Since 3 bytes equals 24 bits, these images are 
also known as 24 bit images. This system is used for high quality video 
imaging and scanning. For process color printing, a fourth color (black) 
is added for optimum effect. 

32 bit/4 byte image An image that uses 8 bits each for CMYK pixels, or 8 bits for each RGB 
pixel and 8 pixels for a mask layer or other future use. Since 4 byte 
equal 32 bits, these images are also known as 32 bit images. An 8 bit 
CMYK image is the minimum required for high quality print 
reproduction. 

4 color printing Color reproduction method used to create full color output by 
overlaying cyan, magenta, yellow and black inks.

8 bit/1 byte image An image limited to 256 tones of one color or 256 different colors. 
Since 1 byte contains 8 bits and each bit has two choices, 1 byte equals 
28 choices or 256 possibilities.

Absolute Colorimetric A rendering intent method similar to Relative Colorimetric except that 
it does not make adjustments according to the white point. In this 
method, colors that do not fit within the output color space are 
rendered at the extremes of the output color space. Colors that fall 
inside the output color space are matched very accurately. 
This method is valuable for representing “signature colors“. Colors 
that are highly identified with a commercial product such as the cyan 
in the Creo logo.

Additive color model Color system in which the picture is composed of the combination of 
Red (R), Green (G) and Blue (B) light transmitted by the original 
subject. Effective for monitors and TV's but not for print. Scanners 
normally first scan in RGB and it is converted into CMYK for printing. 
See also RGB, CMYK, Process colors, Subtractive color model.

Amplitude Modulation Halftone screening, as opposed to FM screening, has dots of variable 
size with equal spacing between dot centers.

Anti-Aliasing A step effect in which angled lines or curved edges of elements in an 
electronic image look broken or jagged, as a result of producing it in a 
grid format. Increasing resolution can reduce this effect or using a 
technique called anti-aliasing where the edges are softened.

APR Creo's Automatic Picture Replacement workflow. In this workflow, two 
versions of a file are created - a high-resolution file and a low-
resolution file called PSImage. The latter is used for positioning and 
manipulation within a DTP application. The low-resolution file is 
replaced automatically by the high-resolution version during the RIP 
process. See also PSImage.

Glossary
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Binding The process by which pages of a book or other publication are 
attached to one another.

Bit Abbreviation of binary digits. The smallest unit of information used to 
store information in a computer. Bits are expressed as a binary 
notation, that is, in ones and zeros.

Bitmap graphics An image composed of individual pixels. The color value and position 
of each pixel are individually described in bits and bytes of computer 
memory. It is called a bitmap because it is effectively a map of bits. See 
also Raster file.

Bleed An extra amount of printed image, which extends beyond the trim 
edge of the sheet or page.

Booklet VI jobs are composed of booklets, which are personalized copies of a 
document. A booklet can consist of several pages, but the entire 
document is targeted at a specific individual or address. VI jobs 
include elements that may differ from booklet to booklet, including 
text, graphics, pictures and page backgrounds. 

Butt To join without overlapping or space between.

Byte A grouping of 8 bits of stored information, giving 256 levels of data. 
Each byte represents a value or character such as a letter or a number. 
In a color system, a byte can describe one out of 256 distinct shades. 

CIE Abbreviation for Commission Internationale d'Eclairage. This body 
was created for the study of illumination problems. CIE color 
coordinates specify proportions of the three additive colors required to 
produce any hue and are used for comparative color measurement.

CMYK The process colors - Cyan, Magenta, Yellow and Black. See also Color 
separations, Process colors, and Subtractive color model.

Color gamut The range of colors possible with any color system. 

Color separations Separate films are prepared for each of the process printing inks - cyan, 
magenta, yellow and black. These films are used to prepare the 
printing plates for printing on press. See also CMYK.

CSA (Color Space Array) Color Space Array is the spectrum of specific variants of a color model 
with a specific gamut or color range. For example, within the color 
model RGB, there are numerous color spaces, such as Apple RGB, 
sRGB, and Adobe RGB. While each of these define color by the same 
three axes (R, G, and B), they differ in gamut and other specifications. 
CSA is comprised of a three-dimensional geometric representation of 
colors that can be seen or generated using a certain color model and 
are quantitatively measured. Source CSA is to be used only under the 
assumption that the upstream color workflow was managed and 
monitored. Otherwise it should be replaced with a Creo profile, which 
is the default.
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CSA Profiles There are three CSA profiles with gammas of 1.8, 2.1 and 2.4. The 
higher the gamma, the darker the RGB appears. This workflow should 
be used when you have images from different sources, such as digital 
cameras, Internet, and scanners and you want the images to have the 
common RGB color spaces. 
Other possible CSA profiles are sRGB and Adobe RGB

Composite mode In composite mode, the data required to separate a page into its 
CMYK components is all contained within one single (composite) file. 
Brisque or PS/M then separates the file into CMYK as part of the 
conversion process. This processing mode is the fastest and most 
efficient in the majority of cases.

Creep The effect of middle pages of a folded signature extending slightly 
beyond outside pages, compensated by shingling. See also Shingling.

Crop To eliminate portions of an illustration or photography so the 
remainder is more clear, interesting or able to fit the layout.

CT Abbreviation for continuous tone. Color or black and white 
photographic images with tones that change gradually from dark to 
light (unlike the abrupt changes in linework). 

DCS Abbreviation for Desktop Color Separation, an EPS format containing 5 
files. Four of the files contain the color information for each of the 
CMYK colors and the fifth is a low-resolution composite file for use in 
electronic page layout. See also OPI.

Degradé A gradual blend or transition between colors. Also known as vignette 
or graduated blend (Vector drawing).

Digital front end system In electronic publishing, this is the workstation or group of 
workstations containing the applications software for preparing pages 
of type and graphics. In prepress, this is the workstation that gives 
access to the user for the operation of hardware. For example, proofer, 
platesetter, imagesetter.

Digital proof A black and white or color image reproduction made from digital 
information without producing intermediate films. It can be output as 
a digital hard proof using a peripheral output device or displayed as a 
digital soft proof on a video monitor.

Dot  The individual element of a halftone.

Dot area The percentage of an area covered by halftone dots ranging from no 
dots at 0% to a solid ink density at 100%. The size of a single dot is 
stated in a percentage of the area it occupies.

DTP Abbreviation for Desktop Publishing. The process of page production 
using personal computers, off-the-shelf software and an output device 
such as a printer or imagesetter. Usually, these components form a 
system that is driven by a device-independent page description 
language such as PostScript.
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EPS Abbreviation for Encapsulated PostScript, a graphic file format used to 
transfer PostScript, graphic files from one program to another. It 
includes both a low-resolution preview and the high resolution 
PostScript image description. On the Macintosh, the preview is in PICT 
format, on the PC it is in TIFF format. Also known as EPSF.

Finishing stage Stage following the press process, which may include procedures such 
as laminating, perforating and varnishing.

Font A complete assortment of letters, numbers, punctuation marks, 
characters etc. of a given design and size.

Frame A color overlap created intentionally at a color border so as to 
minimize the effects of misregistration. Also known as trap or grip. See 
also Trapping.

Frequency modulated screens A method of creating halftones where the spots are all the same size, 
but the frequency or number of dot changes in a given area. There are 
more dots in a dark area and fewer in a light area.

Frozen job A job for which the appropriate paper stock is not available, for 
example, the correct paper type, paper size or paper weight.

GCR Abbreviation for Gray Component Replacement. Method for reducing 
the CMY amounts that produce the gray component in a color, without 
changing the color hue. 

Graduated blend See Degradé.

Gravure printing  A printing method in which the image is engraved through a screen 
below the surface of a cylinder. The ink is transferred to paper when 
pressed to the cylinder. Gravure is used for very long print runs and on 
many substrates.

Gray component The amounts of CMY in a color, which result in neutral gray, based on 
the lowest separation value of the color. See also GCR.

Grayscale A scale of gray tones from white to black. Digitally, grayscale images 
have up to 256 different levels of gray. See also 8 bit/1 byte image.

Halftone A negative or positive image whereby detail of the image is 
reproduced with dots varying area but of uniform density. Creates the 
illusion of continuous tone when viewed with the naked eye.

Highlights The whitest portions of the original or reproduction that have no color 
cast. The highlight dot is ranged in the reproduction from the smallest 
printable dot to approximately 25%. See also Midtones and Shadows.

HSL Abbreviation of Hue, Saturation and Lightness. This is a color model, 
which specifies a color by its wavelength (Hue), chroma or purity of 
the color (Saturation) and value of its brightness (Lightness).

Image area Portion of a negative or plate corresponding to inking on paper. The 
portion of paper on which ink appears.

Imposition The arranging of pages in a press form to ensure the correct order after 
the printed sheet is folded, bound and trimmed.
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Ink jet proof A proof of a digital image printed by using jets that squirt minuscule 
drops of ink. Ink jet proofers can print onto a variety of surfaces.

Job Flow Job flow refers to the job parameter settings of selected virtual printers 
that are automatically applied to all jobs printed using that virtual 
printer. These settings determine how a sent or imported file is 
processed. For example, a file sent to a virtual printer with a Process & 
Print job flow will be RIPped, printed and stored in the Storage Folder. 
A file sent to a Process & Store job flow virtual printer will be RIPped 
and stored, without printing.

LEF A printer page orientation, where pages are delivered long edge first.

Laserwriter driver A part of the Macintosh system software which generates PostScript 
instructions from an application file when the Print command is 
activated.

Look-up table (LUT) A two or three-dimensional array of values stored for specified input-
output relationships. When one input value is known, the system can 
automatically determine the correct output value. For example, the 
system can find the needed dot size for a given set of printing 
conditions based on the stored gray level; color setups can be saved in 
color tables (color transformation tables) which are one of the many 
kinds of LUTs.

Linework Linework graphics are characterized by sharply defined lines and very 
clear transitions from one color to another. Linework is stored in the 
computer as a series of geometric (vector) drawing instructions.

Metamerism Metamerism occurs when two colors match under one light source, 
but appear different under another light source. Those two colors are 
called a metameric match. A metameric match might cause problems 
when trying to match proofs to press-sheets under different lighting 
conditions.

Midtones Density values of an image (original or reproduction) between the 
highlights and the shadows. In the reproduction, midtones are printed 
with dot areas between approximately 40% or 60%. See also 
Highlights and Shadows.

Misregistration A situation common during printing where one or more of the color 
separations is slightly misaligned with regard to the others on press. 
Misregistration shows up as white gaps or tinted overlaps at the 
borders of color pairs. Colors containing such files are trapped to 
compensate for this possibility. On Continuous Tone images, 
misregistration can lead to blurring. See also Overprint and Trapping.

Moiré An interference pattern caused by differences in halftone screen 
angles or rulings. In process color printing, screen angles are selected 
to minimize this pattern. If the angles are not correct, a pattern that 
distracts the eye from the picture may be produced.

Newton's rings Small concentric circles that can appear on film when two surfaces are 
closed together but not in perfect contact.
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OPI Abbreviation of Open Prepress Interface. A prepress convention 
established by Aldus Corps. OPI refers to tags or place holders in 
source PostScript that point to TIFF or EPS images that have not been 
embedded in the PostScript. These images reside in other locations 
and are merged with the PostScript file when processed. Normally 
used for performing high res/low res image substitution (alternative 
to Creo APR).

Output resolution The number of laser dots per unit of linear measurement (millimeter, 
inch etc.) on film or paper. 

Output tone curve A graph showing the relationship of original input densities and the 
corresponding dot percentages on film. 

Overprint A technique, which overlaps colored elements to eliminate the 
appearance of gaps between elements caused by misregistration of 
the various separations during printing. For example, black text is 
normally set to overprint. See also Trapping and Misregistration.

PDL Printer Description Language files (for example, PostScript, PDF, EPS, 
VPS, VIPP). The Spire CX260 processes image files in PDL formats, 
converting them into a suitable Ready-To-Print format for direct, high-
quality printing.

Perceptual (Photographic) (Default for RGB) A rendering intent method which preserves the 
visual relationship among the colors as they are perceived by the 
human eye. In other words, all colors are proportionally scaled to fit 
the output gamut. All or most colors in the original are changed but the 
relationship between them does not change.
This method is recommended when working with realistic images 
such as photographs, including scans and images from stock 
photography CDs. 

PICT A Macintosh file format for bitmaps and vector graphics.

Pixels Contraction of Picture Element. The smallest element of a digital 
image.

PostScript A programming and page description language that has become 
industry standard for electronic publishing. It is used to describe the 
entire page, including both text graphics and images. PostScript is 
completely independent of the printing device. Developed by Adobe 
Systems, Inc.™

Prepress Generic term used to describe the processes involved in preparing 
images for printing. Includes the input, edit and output stages.

Printer description files PPDs (PostScript Printer Definition), and PDFs (Printer Definition 
Files). These files are used by the Macintosh applications to prepare 
page and documents for specific output devices.

Process colors The four ink colors used to reproduce full color images - cyan, 
magenta, yellow and black.
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PSImage A low-resolution EPS file used in the Creo APR workflow. This file is 
used for positioning in page layout. Changes made to this file will be 
applied to the high-resolution file, which automatically replaces it 
shortly before exposure. See also APR.

Quartertone The tone area of an image influencing highlight detail and with density 
values between the white point and midtone. Typically, printed with a 
dot area near 25%. See also Highlights, Midtones, Shadows.

Raster file A file of data that was scanned, processed or output sequentially, bit 
by bit and line by line. Also known as a bitmap.

Rasterization The translation of vector information into bitmap information. Bitmaps 
may also require a new rasterization to comply with the screening 
parameters (dot shape, dot size) of the imagesetter that will expose 
them on film. See also RIP and RIPing.

Register Fitting of two or more printing images or plates in exact alignment with 
each other.

Register marks Crosses or other targets applied to original copy prior to printing. Used 
for positioning films in register or for register of two or more colors in 
process printing.

Relative Colorimetric A rendering intent method in which colors that fall within the output 
color space remain the same. Only colors that fall outside are changed 
to the closest possible color within the output color space. 
When using this method, some closely related colors in the input color 
space can be mapped to a single color in the output color space. This 
reduces the number of colors in the image.

Rendering Intent All printers, monitors and scanners have a gamut or range of colors 
that they can output (or view in the case of a scanner). If a color needs 
to be output and is outside the gamut of the output device, it must be 
mapped or approximated to some other color, which exists within the 
gamut. Rendering Intent enables you to compress out-of-gamut colors 
into the color capability of the press you are using. You can set any 
rendering intent value for RGB elements by selecting the required from 
the Rendering intent options list. The default value for RGB is 
Perceptual (photographic). The default value for CMYK is Relative 
Colorimetric. 
There are several methods that can be used when translating colors 
from one color space to another. These methods are called Rendering 
Intents because they are optimized for various uses. When working 
with ICC profiles, it is important that you select the Rendering Intent 
that best preserves the important aspects of the image. Each 
rendering method specifies a CRD for color conversions. You can 
modify the rendering method to control the appearance of images, 
such as prints from office applications or RGB photographs from 
Photoshop.
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Resolution The number of pixels, points or dots per unit of linear measurement. 
For example, pixels per millimeter on a video display, number of dots 
per inch or millimeter on film or paper.

The resolution of an image is usually set the same vertically and 
horizontally. For example, a square millimeter with a resolution of 12 
contains 144 pixels. The higher the resolution, the more image detail is 
recorded and the larger the digital file size.

RGB Abbreviation for the additive primaries Red, Green and Blue. They are 
used in video monitors, scanning, and other uses where the light is 
direct and not reflected. The component colors are the three 
predominant colors in the visible light spectrum detected by the 
human eye. Combining these 3 colors together creates white light.

RIP Abbreviation for Raster Image Processor. This is a software program or 
hardware device that converts vector information into pixel 
information to be imaged on an output file. This output file is imaged 
based on commands from the page description language.

RIPing The process of rastering or converting bitmaps and vector graphics 
into raster images suitable to the screening parameters of the output 
device. Files are RIPed prior to exposure or plotting.

Saturated color A color where the high and medium values approach 100%. In a 
saturated clean color, the values of the wanted colors are near 100% 
and the value of the unwanted color is near 0%. For example, when the 
color is red, 5% cyan, 90% magenta, 80% yellow is more saturated 
than 30% cyan, 90% magenta, 80% yellow.

Saturated (presentation) A rendering intent method which scales all colors to the strongest 
saturation possible. The relative saturation is maintained from one 
color space to another.
This rendering style option is optimal for artwork and graphs in 
presentations. In many cases, this style option can be used for mixed 
pages that contain both presentation graphics and photographs.

Saturation  The strength of a color.

Screen angle The angle of rows of halftone dots represented in degrees. During 
output of films for reproduction, the dot arrangement of each 
separation film is placed at a distinct and different angle to the other 
separations. See also Moiré.

Screen rulings The number of rows of printing dots per inch on a halftone film. A 
150lpi-screen ruling provides much better quality than 65lpi.

SEF A printer page orientation, where pages are delivered short end first.

Shadows The darkest part of an image (original and reproduction) having 
densities near to maximum density. In the reproduction, shadows are 
printed with dot areas between 80% and 100% See also Highlights 
and Midtones.
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Shingling A procedure that moves the image area of a page toward the direction 
specified, usually towards the binding, in order to compensate for 
creep.

Signature Sheet of printed pages which when folded becomes part of the 
publication.

Solid The point in the picture printed with a dot area of 100%. See also 
Highlights, Midtones and Shadows.

Spectrophotometer Spectrophotometer (X-Rite DTP41), which is a 24 band color 
measurement instrument that reports densitometric, colorimetric and 
spectral data.

Spot color An additional separation (fifth, or more) that is used with special inks 
to achieve difficult color combinations, such as gold or chocolate 
brown. Spot color is sometimes used by graphic artists to define 
special corporate colors, for example, for company logos. On the Spire 
CX260, spot colors are translated into CMYK values using a dictionary 
that can be edited to adjust CMYK values.

Step and repeat The procedure of copying the same image by stepping it in position 
both horizontally and vertically according to a predetermined layout.

Stochastic screening A method of creating frequency-modulated halftones that depends on 
the number of laser dots in a given area rather than the size of the laser 
dots in a given area. The dots are randomly placed and very small. 
Areas with a higher dot percent have more spots exposed in that area 
and those with a low dot percent have fewer spots. Stochastic 
screening is used to eliminate moiré and improve picture detail and 
sharpness in high-end color printing.

Subtractive color model A color process in which the red, green and blue components of the 
original subject are reproduced as three super-imposed images in the 
complementary (subtractive) colors of cyan, magenta and yellow 
respectively. See also CMYK, Process colors, Additive color model.

Three quartertone Tone area of an image influencing the shadow detail and with density 
values between the Midtone and the Dark Point. Typically printed with 
a dot area near 75%.

Tone compression The reduction of the density range of an original to the density range 
achievable in the reproduction.

Tone reproduction curve A graph showing the density of each point of the original and its 
corresponding density on the reproduction.

Trapping Creating and overlap (spread) or an underlap (choke) between colors 
that adjoin each other to hide misregistration during printing. Trapping 
is sometimes referred to as spreads and chokes, or fatties and skinnies.

UCR Abbreviation of Undercolor Removal. This is a method for reducing the 
CMY content in neutral gray shadow areas of a reproduction and 
replacing them with black. As a result, the reproduction appears 
normal but less process color inks are used. See also GCR.
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Unsaturated color A color whose highest value is less than approximately 80%. In an 
unsaturated, dirty color, the difference in the values of the wanted 
colors and the unwanted color is relatively low. 

For example, when the color is red, 30% cyan, 80% magenta, 70% 
yellow is more unsaturated than 0% cyan, 90% magenta, 80% yellow.

Variable Information (VI) Variable information (VI) jobs are jobs in which the printed materials 
are individualized for specific recipients or purposes. These materials 
can include bills, targeted advertising and direct mailings.

Vector drawing The geometric system used to define lines and curves in many 
computer graphics most often used for line drawings.

Vignette See Degradé.

Virtual Printer For Macintosh and PC networks, the Spire CX260 provides three 
default network printers, known as virtual printers. Virtual printers 
contain preset workflows that are automatically applied to all print 
jobs processed with that virtual printer. 

White point The whitest neutral area of an original or reproduction that contains 
detail and is reproduced with the smallest printable dot (typically 3% 
to 5%).
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